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Getting started
This manual describes how to use LDMS for Web and is intended for users at
laboratories.

About Frontier Science
Frontier Science develops and maintains LDMS, and provides data hosting for
laboratories.

Frontier Science and Technology Research Foundation, Inc. is a not-for profit
that provides data management services to research organizations. LDMS is
one of those data management services.

Many organizations that utilize LDMS also utilize Frontier Science’s data
management center (often referred to as the DMC) in Amherst, New York for
long term data storage. These organizations use LDMS as a mechanism for
sending specimen data for studies to Frontier Science.

Frontier Science is involved in many other statistical research efforts beyond
LDMS. To learn more about the work that Frontier Science does, visit https://
www.frontierscience.org.

About LDMS
LDMS is a data management solution for laboratories managing biological
medical specimens.

General information
LDMS is specifically designed for the needs of small and medium-sized
research laboratories. It is available for Windows or as a web application.
Laboratories generally use LDMS on one platform only. The Windows version
must be installed on individual machines, but can utilize a centralized LDMS
server installed at the laboratory. The web version does not require additional
software to be installed and can be used in most web browsers. Users of the
web version do not need to maintain a local database or create backups of
data.

LDMS can perform many tasks, including the following:

• cataloging specimen information, such as its volume, additive, and current
condition

• managing the transfer of specimen information between laboratories
• generating labels for specimens
• reading and entering assay result information
• keeping track of where specimens are located in storage units

Frontier Science Foundation 11
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Frontier Science manages data for laboratories using LDMS in a secure
environment that meets the standards of 21 CFR Part 11 and NIST/FISMA
guidelines.

History
LDMS was initially released for Windows in 1998 to collect data for HIV-
related clinical trials.

The first projects to use LDMS were the Adult and Pediatric AIDS Clinical
Trials Groups (AACTG and PACTG, now known as ACTG and IMPAACT).
While LDMS continues to be used heavily by projects that focus on HIV
and related cohorts, it is also used for many other specialized research
purposes, including hepatitis C (HCV) and influenza studies, proficiency
testing programs, and specimen repositories.

In 2014, Frontier Science released the web version LDMS.

Windows and web versions
Since the release of the web version of LDMS, Frontier Science has focused on
the development of the web version.

The Windows version of LDMS continues to be maintained, and several
updates to the Windows version have been released since the introduction
of the web version. LDMS for Windows releases generally focus on improving
existing features and project-specific changes. When possible, new
laboratories should generally use the web version. When a new laboratory
is set up, Frontier Science will guide the laboratory through the process of
selecting and installing the appropriate version for their needs.

Laboratories are able to ship specimens to and receive specimens from other
laboratories, regardless of which version of LDMS the laboratories are using.
There may be other concerns when laboratories using the Windows and web
versions need to work together. Frontier Science can work with laboratories to
determine how to best handle different scenarios.

Migrating from Windows to web versions
Laboratories currently using LDMS for Windows may be able to migrate to the
web version.

Migration from the Windows to web version must be approved and
coordinated by Frontier Science. Frontier Science will typically invite
laboratories to migrate when it is appropriate to do so. Issues that need to be
considered when migrating a laboratory include the following:

• Are all projects that the laboratory participates in supported in the web
version?

• Are the features the laboratory is currently using supported in the web
version?

• Does the laboratory routinely work with laboratories using the Windows
version?

Frontier Science Foundation 12
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It is possible to migrate a laboratory's existing LDMS for Windows data to the
web version. To do this, the laboratory's Windows database must be obtained
by LDMS User Support. Frontier Science will then convert the data to the
appropriate format and test it internally for issues. If the database can be
converted successfully, LDMS User Support will help get the laboratory setup
with appropriate user accounts and training.

System requirements
These are the system requirements, along with recommended specifications,
for using LDMS.

Required

Table 1: System requirements

Component Requirement

Web Browser • Firefox 54 or higher
• Chrome 58 or higher
• Edge 40 or higher

JavaScript must be enabled for all browsers. Although most browsers
will be able to use LDMS without issues, Frontier Science does not
provide user support for web browsers that are not listed.

Screen Resolution 1024 × 768

Networking High-speed Internet connection

Input Keyboard and 2-button mouse

Video Monitor and video card capable of at least 1024 × 768 resolution and
16-bit color depth

Label Printing Adobe Acrobat

Recommended

Table 2: System recommendations

Component Recommendation

Printer Printers and barcode readers may have additional requirements.
Consult your hardware's documentation for more information.

Barcode Reader Compatible barcode scanner

Other software

LDMS can generate reports and other types of files in several different
formats. Most of these files can be opened by commonly used programs that
are already on our computer.

PDF viewer Needed to view and print reports. You can download
many PDF viewers for free, such as Adobe Reader and

Frontier Science Foundation 13
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Evince. Many web browsers also have a built-in PDF
viewer.

Important:  An Adobe PDF viewer is required
when printing labels.

Spreadsheet
viewer

Needed to view exportable reports. Microsoft Excel or
LibreOffice Calc can open these files.

Signing in to LDMS
Sign in to LDMS by using your user name and password, and selecting a
laboratory database.

Prerequisites
You must have a user account before you can sign in to LDMS.

Steps

1. In a web browser, go to LDMS login.
2. In the upper-right corner of the page, click LDMS Login.
3. Enter your user name and password, and then click the Login button.

The Select Laboratory page will open.
4. Select the laboratory from which you want to work from the Select

Lab[oratory] box.
You will be working out of the selected laboratory’s database for your
session. You will only be able to select a laboratory to which you have
access.

After you are finished
If you want to change to a different laboratory’s database after signing in,
click the Change link next to the laboratory name in the upper-right corner.
To assign a default laboratory, hover over the Administration button and
click User Settings. Click the drop-down box next to Default Lab ID and
select the laboratory that you would like to make the default.

Acknowledgement of training
If it is your first time logging into LDMS, you will be prompted to sign an
acknowledgement of training after entering your username and password.

Frontier Science Foundation 14
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Figure 1: Acknowledgment Form

If you have not been trained, you will not be allowed into the system. By
selecting the option Yes, I have been trained, you are indicating that you
have received training in the use of LDMS.

Frontier Science Foundation 15
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Changing users
To switch users from the same web browser, you must log out and log in as a
different user.

Background

Although multiple users can sign in and access data from one laboratory’s
database at the same time, you cannot sign in with multiple users from the
same web browser on the same computer. For example, you can sign in as
two different users on two different computers using Firefox, but you cannot
open a new tab on the same computer and sign in as a different user. Doing
so would cause problems with the tab in which you were originally signed in.

Steps

1. In the upper-left corner of any page in LDMS, click the Logout button.
2. Sign in as a different user.

Saving changes when automatically signed out
It is possible to save changes, even when automatically signed out of an idle
session.

Background

You will automatically be signed out of LDMS if you leave a page idle for
15 minutes. When this happens, you will receive a notification that you
have been signed out. If you attempt to leave the current page, you will be
directed back to the sign in page. If you had unsaved changes when you were
automatically signed out, those changes will be lost when you are redirected
to the sign in page. This is to prevent unauthorized users from saving changes
from a session that is signed out.

It is possible to save unsaved changes on a page after being logged out by
signing in using another tab in the same web browser.

Steps

1. Without leaving the page with unsaved changes, open a new tab in
your web browser.

2. In the new tab, go to the LDMS sign in page.
3. Sign in as the user with the unsaved changes.
4. Close the new tab.

Result
The original tab with the unsaved changes will now be considered signed
in. You will now be permitted to continue working and to save any changes
made.

Frontier Science Foundation 16
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Downloading files
Different web browsers have different way of handling file downloads.

Many modern web browsers are configured by default to try to open certain
types of files automatically or download them to a default location. For
example, by default Firefox will attempt to open PDF files using a built-in PDF
viewer. Likewise, Chrome is configured by default to save file downloads to a
default location without asking you where to save them.

There are many times that LDMS will provide a file for you to download, such
as a shipping file. Since you need to know where the file is on your computer
in order to provide it to another laboratory, it is helpful to understand how
your web browser handles file downloads.

How to view and modify your browser’s behavior for downloading files or
opening files automatically will vary by browser and version. For instructions,
consult the help documentation for your web browser.

The LDMS user interface
When you first log in, you will be brought to the LDMS Welcome Page unless
you have set another page as your default login page.

Figure 2: The LDMS Welcome page

(1) The LDMS menu bar, (2) The action menu, (3) LDMS Module Section, (4) Module task quick-link, (5) Default

login page setting

LDMS menu bar The menu bar is used to navigate between different tasks
in LDMS. Hover the mouse pointer over a page to see its
sub-pages.

action menu The action menu is used in various areas of LDMS to
perform a major task. For example, on the Specimen

Frontier Science Foundation 17
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Management page, the action menu is used to create a
new participant.

signing out To sign out of LDMS as the current user, click the Logout
button in the upper-right corner. This button is available
on every page.

change
databases

To change to a different laboratory database, click
the Change link in the upper-right corner next to the
laboratory name.

The LDMS user interface has many common elements across different pages.

Figure 3: The main LDMS user interface

(1) Barcode scanning available (2) An applied filter, (3) Currently viewed participant, (4) Specimens

filters Filters are available on most pages and will limit the
information that is displayed in the working area on
the page. For example, if you are on the Specimen
Management page and apply a filter with the value
FRONTIER to the Project field, only participants enrolled
in the FRONTIER project will be displayed. The filters that
are available will vary, depending on the current page. To
remove a filter after it has been applied, click on it.

Applying filters to a page
Filters are available on several pages and are used to narrow down the
information that is displayed so that you can find something.

Background

On many pages in LDMS, all information for a particular task will be displayed
together. For example, if you are on the Specimen Management page, all

Frontier Science Foundation 18
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participants in your laboratory’s database will be displayed. If your laboratory
has information for 200 participants, all 200 will be displayed by default and
you would need to page through each one to find what you are looking for.

Filters can be used to temporarily limit the amount of participants shown so
that only records of interest are displayed. This is the primary way to search
for items in LDMS.

Steps

1. Open a page with filters, such as the Storage or Specimen
Management pages.
Filters are displayed in the filters panel on the left side of the page,
below the action menu.

2. Locate the desired filter.
Filters are grouped into categories, such as visit filters and specimen
filters. Some categories will be specific to the current page. For
example, the storage container filters will only be available on the
Storage page.

Figure 4: The filters panel

In this example, the FRONTIER filter has already been applied to Project. This means that only information

for that project will be displayed.

3. Select or enter the information to be shown from the filter box.

You can either select the information to filter from this list or enter it
into the box. Filters will automatically show available options as you
type.

Frontier Science Foundation 19
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Note:  Filters do not affect other filters. For example, if you
select the FRONTIER project, then try to apply a filter for ID1,
all ID1 values in the laboratory’s database will be available for
selection, even if they don’t below to the FRONTIER project.

Result
The filter will be applied immediately once it is selected and the page will
automatically refresh to remove any records that do not meet the filter’s
criteria. If two filters were selected, they will both be applied using “and”
logic. For example, if you selected FRONTIER from the Project filter and BLD
from the Primary type filter, only blood specimens for the FRONTIER project
will be displayed..

After you are finished
To remove a filter that has been applied, find it in the filter panel on the left
side of the page and click on it. It will be removed immediately and the page
will automatically be refreshed to reflect the change.

Specimen Filters Code Searching

If using Specimen Filters options, contextual suggestions will appear when
typing in the following fields:

• Primary Type
• Additive
• Derivative Type
• Sub Add/Der Type
• Condition

While other filter fields will display results as you type, these specific fields
provide additional aid if uncertain of the code abbreviation. If unsure of the
code abbreviation for DSE - Spray Dried Sodium EDTA, for example, then
typing EDTA in the Additive field yields a list of possible codes containing the
EDTA.

Frontier Science Foundation 20
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Figure 5: Contextual results

Deleting Items
When a user deletes an item such as a specimen, storage item, shipment, or
test run, the user will be required to specify why the item is being deleted.
This reason is then displayed on the Transaction Log report to properly track
the reason for deleting.

Figure 6: Reason for Delete Window

Using a List of Identifiers to Select Specimens
You can use a list of identifiers to select a set of specimens

Frontier Science Foundation 21
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This feature is available in most places where specimens need to be selected
including Custom Report Builder, Pending Shipments, Stored Samples, Test
Results, and Print Labels using the Upload Global Specimen Ids File
button. The file of identifiers must be a text file and must include one global
specimen ID per line.

Figure 7: Global ID List File Example

Challenge codes
A challenge code is password that you must give to LDMS User Support to
perform certain actions in LDMS.

Access to certain features in LDMS may be restricted for a number of
reasons. For example, unimporting a received shipment can have very serious
consequences. LDMS does not provide “undo” functionality to reverse such an
action. A challenge code is a fail-safe mechanism that can prevent accidental
changes to specimen data.

If you attempt to access a feature locked with a challenge code, LDMS will
prompt you for the response code.

You must contact LDMS User Support and give them the Challenge Code.
If appropriate, they will provide you with the response code which will then
unlock the feature for your use. The code will change each time the feature is
accessed, and will be needed even if the feature was previously unlocked.
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Figure 8: Prompt for challenge password

In this example, you would provide LDMS User Support with the code NOQEAS and they will provide you with the

Response Code to access this feature.

! Warning:  Do not close the challenge password window before you
obtain the Response Code. Doing so will cause a new Challenge
Code to be generated, which will require a different Response Code.

Specimen management
The Specimen Management page is where you can manage the details of
specimen records and related information for participant enrollments.

In LDMS, a participant, an enrollment, and specimens drawn from a
participant (including the specimens derived from them) form a specimen
record. Specimen records are added and displayed on the Specimen
Management page.
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Terms used in LDMS
Specimen records are stored as a hierarchy of related participant, enrollment,
and information. All of this information for a participant-project combination
comprise a record in LDMS.

A specimen record in LDMS is the collection of specimen, study, and visit
information for a specific participant.

Figure 9: Contents of a specimen record

12345B

Arm A

01-Jan-2021  Vst 2

The top of a specimen record represents the largest part, such as a clinical trials network; the right side of this image is

an example of each item

project The organization that sponsors or conducts the study in
which the participant is enrolled.

participant The person (or specimen source if the project doesn’t
work with human samples) that is participating in a given
project. If a person is participating in more than one
project, they will be considered two different participants
in each project. Participants cannot be linked across
projects.

enrollment The protocol or study in which the participant is enrolled.

visit A specific event at which a primary specimen was
collected from a participant.

primary
specimen

The specimen that was collected from the participant,
such as an unprocessed tube of blood

aliquot A specimen that was created by processing a primary
specimen into a smaller specimen.
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Each part of a specimen record is selected in sequence. For example, you
must specify a project before enter participant information. Likewise, you
must create the information for a visit event before you can add specimens
that were drawn at that visit.

Using the Specimen Management page
The Specimen Management page shows all of the visits for a specific
participant and protocol combination.

Important:  The labels for certain buttons and menus in LDMS vary
based on the project. For one participant, for example, the unique
participant identifier (ID) may be called “PID”; for another project it
may be “PanelID”.

The main work area of the Specimen Management page will display the all the
visits and associated specimens for a participant. Use the navigation buttons
to change between different participants.

Figure 10: The Specimen Management page

(1) Navigate between participants, (2) The current participant enrollment information, (3) Visits for the current

participant, (4) Primary specimens for the currently selected visit, (5) Aliquot specimens derived from the currently

selected primary specimen, (6) Specimen status indicators, (7) Actions for a primary (8) Indicator that you can scan a

barcode to search for a record, (9) Jump directly to a participant

Status Icon Meaning

Specimen is available

Specimen is assigned a storage location
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Status Icon Meaning

Specimen has been marked to ship to another
laboratory

Specimen is on a pending shipment to another
laboratory

Specimen has been shipped to another
laboratory

Specimen has an additional enrollment

Specimen has an additional enrollment

Objective Action

Change participants Click the navigation buttons at the top of the
screen.

View the visits for a different study that the
participant is enrolled in

Select the study from the Study drop-down
box. If the Study box is disabled, then the
participant is only enrolled in one study.

See the primary specimens associated with a
visit

Click a visit from the Visits section of the
page.

See the aliquots associated with a primary
specimen

Click a primary in the Primary Specimens
section.

Search for a specific participant Use the filters on the left-side of the page.

Entering specimen information (Overview)
Records are added to LDMS from the top-down, starting with the creation of a
new participant.

Background

Because records in LDMS are hierarchical, you need to enter information
starting with a participant, and then work your way down to aliquot
specimens.

There are two ways to enter participant, enrollment, and specimen in LDMS:

• Using the Quick Add feature (recommended)
• Adding new participant, enrollment, and specimen information one-by-one

For most data entry in LDMS, the Quick Add feature is strongly recommended
since it allows you to enter all of the information at once. Adding individual
items on the Specimen Management page is recommended for minor
changes, such as adding a single aliquot specimen to a primary specimen.

Each of the steps below can be completed independently, provided that
the previous steps were completed. For example, you can create a new
participant in LDMS without enrolling that participant in any protocols
or creating any associated visits, however you cannot create a generic
enrollment that is not associated with a specific participant visit. Likewise, it
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is also not possible to create a primary specimen without associating it with a
specimen participant’s visit.

Steps

1. Create a new participant.
Participants are specific to a project. If a person is participating in
more than one project, then they would be considered two different
participants in LDMS and would be entered separately.

2. Add an enrollment to the participant.
This means that you are associating the participant with a specific
protocol. Participants can be associated with multiple protocols.

3. Add a visit to the participant.
4. Add a primary specimen to the visit.
5. Add aliquots that were processed from the primary specimen.

Participants
A participant is the source for a specimen entered into LDMS.

The participant is typically a person enrolled in a study. Similar terms
that you may be familiar with include “patient” and “source”. In LDMS, a
participant refers to all of these concepts. This means that a participant does
not necessarily need to be a person. For example, a “participant” may be a
control sample from which a specimen was created.

In LDMS, a participant will be the first thing that you create when adding a
new specimen record. Newly created participants must be associated with a
project and an ID1 (or participant identifier).

If a person is taking part in more than one project, that person will be
considered two different participants in LDMS.

Participant identifiers
A participant identifier is a series of numbers and letters that uniquely
identifies a participant within a specific project.

A participant identifier is called “ID1” in LDMS until you select a project for
the participant. Each project will have a different name for ID1. For one
project, it may be called “PID”; for another project, it may be called “PANEL”.

Adding participants using the Specimen Management page
A new participant can be created on the Specimen Management page or
the Quick Add page. This section explains how to add them on the Specimen
Management page.

Background

A new participant can be created two ways:
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• If you want to create a new participant without any enrollments or visits,
use the Specimen Management page.

• If you want to create a new participant allow with an associated visit and
specimens, use the Quick Add feature.

The Quick Add feature requires you to enter at least one visit date with
the participant. If the participant has not yet had a visit, you must use the
Specimen Management page.

Steps

1. From the LDMS menu bar, click Specimen Management.
2. From the action menu in the top-left of the page, click Add

Participant.
Figure 11: The action menu with Add Participant selected

3. From the Project box, select a project.

Example
Figure 12: The Create Participant page

The ID1 box will change to appropriate name for the selected project.
4. In the ID1 box, enter the participant’s identifier.

The label for the ID1 box will vary by project. In the example above,
ID1 is “PID”.

5. Optional: In the OPIDs box, enter an other participant identifier, and
then click Add OPID.
More than one OPID can be added for the same participant. To remove
an OPD that was added, click the Delete button to the right of it.

6. Click Save.

If the project has validation checks for ID1, they will be run at this
time. If the ID1 that you entered is not valid for the project, you will
be prompted to correct it before you can save the new participant.
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If the project and participant identifier combination already exists, you
will be asked if you want to view that participant instead.

Result
The new participant will be created and added to the end of your laboratory’s
database. For example, if your laboratory previously had 250 participants, the
new participant will be 251. LDMS will automatically open the record for the
newly created participant so that you can add enrollment information.

Adding participants using Quick Add
The Quick Add feature can be used to add a new participant, along with other
information, on a single page.

Background

If adding a participant in this way, at least one visit must have occurred as
the date of the visit (the Collection Date) is required.

Steps

1. From the LDMS menu bar, click Specimen Management > Quick
Add.

2. Optional: Select a template for the participant visit.
3. Complete the information in the Participant Information section.
4. In the Visit Information section, enter the Collection Date.
5. At the bottom of the page, click Add.
6. Optional: Complete any additional enrollment, visit, or specimen

information for this participant.

Result
When the participant is successfully created, a note will appear at the top
of the page. The participant will be available for select on the Specimen
Management and Quick Add pages, where new enrollments, visits, and
specimens can be added.

Modifying a participant
Modify participants on the Specimen Management page.

Background
A participant may need to be modified to correct an error in the ID1 that was
entered, or to add and remove OPIDs as needed.

Steps

1. Click Specimen Management from the LDMS menu.
2. Find the participant to be modified. This can be done by following one

of the two sets of steps below:

Frontier Science Foundation 29



LS.0006 | LDMS for the Web - User Manual

• Use filters from the left side of the screen to narrow down the
participants that are displayed.

• Alternatively, click Jump to Participant and enter the appropriate
project and participant ID, then click Jump To.

3. With the participant open in the work area, click the Edit Participant
button.
The Edit Participant window will open.

4. Modify any participant information as needed.

Note:  Edits made here will change all specimens associated
with the participant.

The Enrollments section of this window was not present when the
participant was first created. It lists protocols in which the participant
is enrolled, and provides a link to view and modify that enrollment, if
needed.

5. Click the Save button.
If you modified the participant identifier, LDMS will check to ensure
that it does not already exist for another participant.

Enrollments
An enrollment associates a participant with a protocol.

For example, a participant in the Frontier project may be participating in
a study called F1526. The combination of that participant identifier on that
study is called the enrollment.

A protocol is called ID2 in LDMS. Like ID1 for participant identifiers, the name
for ID2 will vary, depending on the project. For example, a vaccine project
may call the protocol box in LDMS “STUDY”, whereas a pharmacology project
may call it “TEST PANEL”.

Also like ID1, a project may have rules for how its ID2 is formatted. For
example, a vaccine project may require that protocols are in the format
“STUDY 201”, “STUDY 202”, and so on; a pharmacology project may use
“TEST PANEL A0003”, “TEST PANEL A0004”, etc. If the project has specified
these rules, they will be enforced by LDMS.

A participant can be enrolled in more than one ID2 for a project, however
because participants are specific to a project, they cannot be enrolled in
protocols across multiple projects.

Adding enrollments using the Specimen Management page
Enrollments are added to an existing participant, and associate that
participant with a specific protocol.

Prerequisites
The participant must already exist in LDMS before an enrollment can be
added.
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Steps

1. From the LDMS menu bar, click Specimen Management.
2. Find the participant.

Use filters from the left side of the page to narrow down the
participants that are displayed.

3. From the Edit Participant menu, click Add Enrollment.
Figure 13: Adding a new enrollment to a participant

In this image, ID2 is called “Study”

The Create Enrollment window will open.
4. Select or enter an ID2 in the box.

The label for this box will vary, depending on the project. It is most
commonly called Study or Protocol.

5. Click Save.

Result
The participant is now enrolled in the protocol. You will see the protocol listed
in the ID2 box.

After you are finished
If the participant is enrolled in more than one protocol for a project, you can
create additional enrollments in the same way.

Modifying enrollments
Participant enrollments can be modified or removed after they are created on
the Specimen Management page.

Prerequisites

• If removing an enrollment from a participant, the enrollment must not
have any associated visits.

• If you accidentally added a visit and specimens to the enrollment in error
and you want to preserve them, co-enroll the specimen(s) in another
enrollment first so that the erroneous enrollment can be removed.
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Background
The only property of an enrollment is the associated ID2. If the incorrect ID2
was selected when the enrollment was created, you can change it. Doing
so will add the participant to a new enrollment, not change the existing.
For example, if a participant is currently assigned an ID2 of STUDY3, and
you change it to STUDY4, this change will only affect this participant, not all
participants in STUDY3. If the enrollment was added in error, it can be deleted
instead.

Note:  Enrollments can also be modified using Quick Add.

Steps

1. In the LDMS menu bar, click Specimen Management.
2. Find the participant with the enrollment to be modified.

Use filters from the left side of the screen to narrow down the
participants that are displayed.

3. Select the ID2 from the [ID2] box.
The label for the [ID2] box will depend on the project. Common
labels are “study” and “protocol”.

4. To modify the enrollment:
4.1. Click Edit [ID2], where “[Protocol]” is the appropriate label for

the project.
4.2. Modify the enrollment as needed.
4.3. Click Save.

5. To remove the enrollment:
5.1. From the Edit [ID2] menu, click Delete [ID2].

Figure 14: The Edit Study menu

In this image, ID2 is “Study”

5.2. Click Delete.

Visits
A visit is a specimen collection event associated with an enrollment.

A visit typically involves the collection of specimens defined by the protocol.
For example, a visit may specify that you collect 3 tubes of blood from the
participant. In LDMS, you would add the visit to the participant, and then add
the specimens to the visit.
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Visit identifiers
A visit identifier defines the type of visit.

A visit is identified by two pieces of information: the visit value and visit unit.
The visit value is a sequential identifier, such as a number. The visit unit is the
type of visit.

For example, a visit of “3 WK” indicates that it is the third visit of the week
type. The 3 is the visit value, and WK is the visit unit. The protocol in which the
participant is enrolled likely has defined specimen collections for this visit.

The available visit units are defined by various projects that use LDMS. Users
cannot create their own visit units.

Adding a visit to an enrollment
Visits are added to an enrollment on the Specimen Management page.

Background

A visit must be created before you can enter specimen information in LDMS.

Tip:  If you want to create a new visit for a specimen that already
exists, you should co-enroll the primary specimen instead of adding a
new visit to the enrollment. During the co-enrollment process, you will
have the opportunity to create a new visit.

Steps

1. Click Specimen Management from the LDMS menu bar.
2. Find the participant to which a visit will be added.

Use filters from the left side of the page to find the participant.
3. Select the [ID2] from the list.

The label for the [ID2] box will depend on the project. Common
labels are “study” and “protocol”.

4. Click the down arrow next to the Edit [ID2] button, and then click
Add Visit.
Figure 15: The Edit Study menu

In this image, the label for ID2 is “Study”
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The Add Visit window will open.

Figure 16: The Add Visit window

5. Select the clinical site where the visit occurred from the Clinic list.

If you want to know the name of the site, hover over it with the
mouse pointer.

Note:  The list of clinics and clinic ID numbers are maintained
by Frontier Science and cannot be modified by users. For more
information, contact LDMS User Support.

6. (If required by the project) Select the ID3 from the ID3 list.
ID3 is typically used for a sub-study or sub-protocol.

7. Select the date that the visit occurred or will occur from the
Collection Date list.
If the visit occurred or will occur over more than one day, you must
add a new visit for each date.

Note:  Future dates are allowed in the Collection Date field.

8. Enter the visit value and visit unit for the visit into the Visit Value
boxes.
If you want to see what a particular visit unit means, hover over it
with the mouse pointer.

9. Click the Save button.

Modifying visits
Visit information is modified or removed on the Specimen Management
page.

Background

You may need to modify a visit after it is created to correct an entry error (for
example, using the incorrect clinic). If the visit was added in error, you can
also remove it.
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Steps

1. Click Specimen Management > Available Specimens from the
LDMS menu bar.

2. Find the participant with the visit to be modified.
Use filters from the left side of the screen to narrow down the
participants that are displayed.

3. Select the protocol/ID2 associated with the visit from the [Protocol]
box.
The label for the [Protocol] box will depend on the project. Common
labels are “study” and “protocol”.

4. To modify the visit:
4.1. Click the Edit button to the right of the visit.

The Edit Visit window will open.
4.2. Modify the visit information as needed.

If a primary specimen has already been entered for the visit, it
will be listed along with the visit information.

4.3. Click the Save button.
5. To remove the visit, select Delete from the Edit menu to the right of

the visit.
In order to remove the visit, there must be no primary specimens
added to it. If you want to remove a visit without deleting the primary
specimens, you can co-enroll the primary specimen. This will allow
you to associate the specimen with another visit.

Primary specimens
A primary specimen is a specimen that was collected from a participant during
a visit.

Primary specimens are generally larger specimens that are later processed
into smaller specimens called aliquots. New primary specimen are added to
LDMS on the Specimen Management page. They are always associated with
at least one participant visit.

Specimen identifiers
All specimens in LDMS are assigned a unique specimen identifier.

There are three types of specimen identifiers that can appear in LDMS:

global specimen
ID

This is a unique identifier assigned to all specimens.

specimen ID This identifier may or may not be unique. It is only
used by LDMS; LDMS will not assign a specimen ID to
specimens added using LDMS.

other specimen
ID

This identifier is intended for laboratories to use to assign
their own, internal-use identifiers as needed.
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Important:  LDMS for Windows and LDMS use different formats for the
global specimen ID. The format used by LDMS is longer, and contains
the originating laboratory’s ID. For example, the global specimen ID
“0500-0005JE00-000” indicates that the specimen originated from
LDMS laboratory 500.

The global specimen ID assigned by LDMS links a primary specimen to any
aliquot specimens created from it. Primaries and aliquots derived from them
will have the same global specimen ID up to the dash character. The last
three numbers are the sequence number. A sequence number of “-000”
indicates that the global specimen ID belongs to a primary specimen; any
other number indicates that it belongs to an aliquot specimen.

Figure 17: The global specimen ID of primary and aliquot specimens

This image shows the relationship between a parent primary and aliquots derived from it.

Specimen identifiers in LDMS for Windows
LDMS for Windows handles specimen identifiers in a few ways that differ from
LDMS.

Understanding the differences between the way LDMS and LDMS for Windows
assign specimen identifiers is important if your laboratory does work with
other laboratories.

LDMS will not assign a specimen ID to a specimen and will only assign a
global specimen ID. LDMS for Windows will assign both. The format of the
global specimen ID differs as well, depending on which system assigned it.

Figure 18: Specimen ID and global specimen IDs interoperability

This image shows how specimen IDs and global specimen IDs are affected as specimens are shipped between LDMS

and LDMS for Windows.

The global specimen ID of a primary specimen can be different. LDMS for
Windows does not permit the shipping or storage of primary specimens;
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these are features that are exclusive to LDMS. In LDMS for Windows, users
would generally create aliquots (commonly called “ghost aliquots”) that were
identical to the primary specimen; the aliquot (which was really just the
primary) could then be shipped and stored.

When a primary specimen is shipped to LDMS for Windows, an aliquot will
automatically be created. This aliquot will have the global specimen ID of the
primary specimen, and the primary specimen ID will have no global specimen
ID.

Figure 19: Primary specimens shipped to LDMS for Windows

This image shows how a primary specimen without aliquots created in LDMS is converted to an aliquot if shipped to an

LDMS for Windows laboratory.

In this situation, if the new aliquot is shipped to a laboratory that users LDMS,
it will recognize that the global specimen ID belongs to a primary specimen
(and not an aliquot), and will turn it back into a primary specimen.

Adding a primary specimen to a visit
A new primary specimen is added to a visit on the Specimen Management
page.

Background

A primary specimen is added to an existing visit. The primary specimen can
be added in LDMS even if it has not yet been processed into any aliquots.

Steps

Locate and select the visit
1. Click Specimen Management from the LDMS menu.
2. Find the participant to which the primary specimen will be added.

Use filters from the left side of the screen to narrow down the
participants that are displayed.

3. Select the ID2 associated with the visit from the [ID2] box.
The label for the [ID2] box will depend on the project. Common
labels are “study” and “protocol”.

Add the new primary specimen
4. Click the down arrow next to the Edit button to the right of the visit to

which the primary will be added, and then click Add New Primary.
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Figure 20: Adding a new primary to a visit

The Create Specimen window will open.
5. Fill in the information for the new primary specimen.

Items marked with a red * are required.
6. Optional: Enter additional information about the primary specimens

into the Comments box.
Information that is typically included here includes details for
specimens that were not collected, an explanation of a condition, or an
explanation of why a specimen is not available.

7. Optional: Enter additional information about the primary specimens
into the Internal-only comments box. These comments will be
include if the specimen’s information is shipped to another laboratory.
Comments entered here is for your laboratory’s use only. These
comments will not be included if the specimen’s information is shipped
to another laboratory.

8. At the bottom of the window, click Save.
The information you entered will be checked for completeness
and validity. If there is an issue with one of your entries, it will be
highlighted with a brief explanation of how to correct it.

Result

A new primary specimen is now available. It will automatically be assigned a
global specimen ID ending in “-00” by LDMS.

Note:  The new primary will not have a specimen ID assigned to it.
Specimen ID is only used by LDMS; LDMS uses the global specimen ID,
not specimen ID, to identify specimens

After you are finished
If the primary was collected for more than one protocol or project, you must
also co-enroll the specimen so it is associated with each applicable visit.

Co-enrolling a primary specimen
Co-enrolling is the process of associating a primary specimen with more than
one visit or protocol.
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Background

A participant may be participating in two different protocols at the same time,
and a single primary specimen might be collected to meet the needs of a visit
from each protocol.

You can also co-enroll a primary specimen to move it between visits. This
might happen, for example, if you selected the wrong visit for the primary
specimen, and you want to move it to the correct visit rather than deleting it.

Note:  If a specimen is co-enrolled in a local project and a government
project, when shipping specimens for the government project,
information about the co-enrollment will not be included in the
shipment.

Steps

1. In the menu bar, click Specimen Management.
2. Local the specimen to be co-enrolled.

Use filters from the left side of the screen to narrow down the
participants that are displayed.

3. Click the down arrow next to the Edit button to the right of the
primary to be co-enrolled, and then click Manage enrollments.

Figure 21: The Edit button for a primary

The Manage Enrollments window will open.
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Figure 22: The Manage Enrollments window

(1) Add a blank enrollment row, (2) Enrollments for this primary specimen, (3) Details for currently

selected enrollments, (4) Save changes to currently selected enrollment, (5) All aliquots derived from this

primary, including all enrollments

4. Click the Add Enrollment button.
5. Select the blank row created in the previous step by clicking on it.
6. Fill in the information in the Selected Enrollment section for the new

enrollment.
7. Click Update.

The information for the enrollment will be updated in the list of
enrollments.

8. At the bottom of the window, click Save.

Modifying a primary specimen
A primary specimen can be modified on the Specimen Management page.
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Background

After a primary has been created, it may need to be modified for a variety
of reasons, such as correcting a data entry error or updating its current
condition.

Steps

1. Click Specimen Management from the LDMS menu.
2. Find the participant with the primary specimen to be modified.

Use filters from the left side of the screen to narrow down the
participants that are displayed.

3. Select the protocol/ID2 associated with the visit from the [Protocol]
box.
The label for the [Protocol] box will depend on the project. Common
labels are “study” and “protocol”.

4. Click the Edit button to the right of the primary specimen to be
modified.
The Edit Specimen window will open.

5. Modify the primary specimen as needed.
If any aliquot specimens were added for this primary, it will appear at
the bottom of the window.

6. Click the Save button.
If there are any issues with the changes that you made, such as an
invalid entry, you will be prompted to correct it. An explanation will
appear next to the information that needs to be corrected.

Aliquot specimens
An aliquot is a specimen that is derived from a primary specimen

An aliquot is created by processing the specimen collected at a participant’s
visit into smaller specimens. For example, if 10 mL of blood was collected
during a visit, that 10 mL tube is the primary specimen. It may be processed
then into smaller, 1 mL tubes of double-spun plasma. These 1 mL specimens
are the aliquots in LDMS.

Adding aliquots to a primary specimen
An aliquot specimen is added to a primary specimen on the Specimen
Management page.

Background

An aliquot is added to an existing primary.

Steps

1. In the menu bar, click Specimen Management.
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2. Find the participant by using filters on the left side of the screen.
3. Click the arrow next to the Edit button to the right of the primary to

which the aliquots will be added, and then click Add New Specimen.

Figure 23: Adding a new aliquot to a primary specimen

The Create Specimen window will open.
4. Enter the number of aliquots that were created into the Number of

Aliquots box.
When entering more than one aliquot together, all aliquots should
have the same basic properties (such as the same volume). If you
want to add multiple aliquots with different information, you can
still do so, but you must edit the aliquots later. For example, if you
have 3 aliquots that are identical, but one has a different specimen
condition, you can add all three together, and then change the
condition of the one aliquot when you are finished.

5. (If the primary is co-enrolled) Select the enrollment for the new
aliquot from the Enrollment box.
An aliquot cannot be enrolled in more than one study.

6. Fill in the information for the new aliquot specimens.
Items marked with a red * are required.

7. Optional: Enter additional information about the aliquot into the
Comments box.
Information that is typically included here includes details for
specimens that were not collected, an explanation of a condition, or an
explanation of why a specimen is not available.

8. Optional: Enter additional information about the aliquot into the
Internal-only comments box.
Comments entered here are for your laboratory’s use only. These
comments will not be included if the specimen’s information is shipped
to another laboratory.

9. At the bottom of the window, click Save.
The information you entered will be checked for completeness
and validity. If there is an issue, it will be highlighted with a brief
explanation of how to correct it.

Result
The number of aliquots that you specified will be added to the participant
visit. The primary specimen will automatically change to unavailable to
indicate that the specimen was consumed during processing.
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After you are finished
If you added multiple aliquots and any of those aliquots differed from the
others (such as one aliquot having a different condition), be sure to make
those changes to the aliquot.

Entering cryopreservation information
Cryopreservation information can be entered for aliquot specimens with the
CEL derivative type (PBMC Cells, Viable).

Steps

1. On the Specimen Management page, location the specimen for
which you are entering Cryopreservation information.

2. From the Edit button to the right of the specimen, click the down
arrow, and then click Cryopreservation.
This option will only be available for specimens with the derivative
type CEL.

3. Do one of the following:

• If results were obtained, select Results Obtained.
• If results were not obtained, select the reason there are no results

from the Reason list.
4. If results were obtained, complete the information in the HIV Status,

Primary Specimen Details, Aliquot Details, and Technician
Details sections

5. In the Processing Tech Initials box, enter the processing
technician's initials.

6. In the Data Entered By box, enter your initials.
7. Click Save.

Modifying aliquot specimens
You can modify individual aliquots specimens or modify multiple aliquot
specimens together.

Prerequisites

• All specimens to be modified must be from the same primary specimen.

Background

Steps

1. From the LDMS menu, click Specimen Management.
2. Locate the specimens you want to modify.
3. Select the aliquot specimens to modify.

To select multiple aliquot specimens, press and hold the Ctrl key. To
select multiple, contiguous specimens, press and hold the Shift key
instead.
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4. To the right of one of the selected specimens, click Edit.
5. (When editing multiple specimens only) In the Edit Aliquots window,

select the check box next to any boxes you want to change.
6. Modify the specimen information as needed.
7. Optional: Making changes to Frozen Date, Frozen Time,

Processing Tech Initials, Comments or Internal Only Comments
for any single aliquot will give the user the option to cascade these
changes to other aliquots. Changes can be cascaded to No other
aliquots, All aliquots, Only aliquots having the same derivative type.
Select an option and click OK.

Figure 24: The Aliquot Cascade Type Window

8. At the bottom of the Edit Aliquots window, click Save.

Creating Subaliquots
Creating subaliquots is the process of making an aliquot from a pre-existing
aliquot.

Background

Steps

1. Scan the source aliquot barcode to find its record in Specimen
Management.

2. In the Visit grid, click the Edit drop down menu, select Add New
Primary.

3. In the Create Primary Specimen menu, add the following:
3.1. Other Specimen ID - enter the Global Spec ID of the source

aliquot into the field
3.2. Additive
3.3. Volume and Volume unit
3.4. Collection Time
3.5. Receive Time
3.6. Adjust thaw counter

4. In the Primary grid, find the new Primary and use the Edit drop-
down menu. Select Add New Aliquot and add the following in the
Create Aliquot menu:
4.1. Enter Derivative and Sub Add/Der Enter
4.2. Volume and Volume unit
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4.3. Set Harvest Date to current date
4.4. Adjust thaw counter

5. Click Save
6. Find the Source aliquot and click the Edit button.

6.1. Adjust Available volume (subtract the volume removed)
6.2. Click Save

7. Find the Subaliquot, click the Edit drop down menu:
7.1. Print Label

Delete a specimen
If a specimen was added in error, it can be deleted completely.

Prerequisites

Before deleting a specimen, ensure that it is appropriate to do so. Some
projects require laboratories to assign specific condition codes or adjust
specimen volume rather than deleting.

Background

In most cases a specimen should not be deleted unless it was created in error.
It is typically more appropriate to assign a specific condition code, such as
DSR to the specimen.

Specimens that have been shipped to another laboratory cannot be deleted.

Steps

1. On the navigation bar, click Specimen Management.
2. Locate the specimen to be deleted.
3. On the specimen's Edit button menu, click Delete.
4. ! Warning:  This operation cannot be undone.

At the bottom of the Delete window, click Delete.

Removing specimens from storage
Specimens can be removed from their storage locations directly on the
Specimen Management page, without the need to switch to the Storage
page.

Steps

1. On the navigation bar, click Specimen Management.
2. Locate the specimen to be removed from storage.
3. On the specimen's Edit button menu, click Remove From Storage.
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This option is only available if the specimen is assigned a storage
location.

4. Optional: To change the specimen to unavailable, select Set as
Unavailable to be Stored Again.

5. Click Remove.

Quick add
The quick add feature allow you to create all of the specimens from a
participant visit at once, and is the preferred method for entering new visits in
LDMS.

If you add specimens to a participant on the Specimen Management page,
you would need to add each primary and set of aliquots individually. The quick
add feature allows you to select or create a participant and enrollment, create
a new visit, and enter all of the specimens collected at that visit from one
screen. For new visits, this significantly reduces the amount of time it takes to
enter a new visit in LDMS. You can even create templates for common visits
to save more time.

Once a template has been used, any visits or specimens that were created
are not associated with the template. This means that if the template is later
changed or removed, visits that were entered using the template won’t be
changed.
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Figure 25: Quick Add

(1) Select and apply template for Quick Add entry, (2) Filter list of templates, (3) Instructions applicable to selected

template appear here, (4) Select project and ID1, (5) Add ID1 button used to add multiple ID1s simultaneously, (6)

Upload list of ID1s, (7) Add new primary specimen row, (8) Primary specimens, numbers for convenience

Adding specimens using Quick Add
Quick Add is used to enter information for a participant, enrollments, and
multiple specimens all on one page.

Background

This is useful when you want to enter a lot of information for a participant at
once. Templates (if available) can be used to fill in predefined information for
you.

Steps

1. From the LDMS menu bar, select Specimen Management > Quick
Add.

2. Optional: From the Template list, select a template to apply.
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Use the Template Filters to narrow down the list of templates. When
you apply a template, a message with further instructions will appear.

! Warning:  Applying a template will clear any information you
already entered on the Quick Add screen. In addition, once
the template is applied, you cannot change projects unless you
apply a different template or click Clear Template.

3. Optional: Complete the Participant Information.
3.1. Select the project from the Project box.
3.2. Select the ID1 for the participant or enter a new ID1 if you are

adding a new participant.
3.3. To add multiple PIDs, click Add ID1 or Upload ID1 File for

each selected ID1
4. Complete the Enrollment Information by selecting an ID2 or by

entering a new ID2.
5. Complete the Visit Information section.
6. Optional: Add a primary specimen.

6.1. In the Primary Information section, click Add New.
6.2. In the row that appeared, enter the information for the primary

specimen to be created.
6.3. Optional: To view and modify all of the information for the

primary, click Edit in the right column.
7. Optional: Add an aliquot specimen.

7.1. Highlight the primary specimen for the aliquot.
7.2. In the Aliquot Information section, click Add New.
7.3. In the row that appeared, enter the information for the aliquot

specimen to be created.
8. At the bottom of the page, click Add.

Adding participants using Quick Add
The Quick Add feature can be used to add a new participant, along with other
information, on a single page.

Background

If adding a participant in this way, at least one visit must have occurred as
the date of the visit (the Collection Date) is required.

Steps

1. From the LDMS menu bar, click Specimen Management > Quick
Add.

2. Optional: Select a template for the participant visit.
3. Complete the information in the Participant Information section.
4. In the Visit Information section, enter the Collection Date.
5. At the bottom of the page, click Add.
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6. Optional: Complete any additional enrollment, visit, or specimen
information for this participant.

Result
When the participant is successfully created, a note will appear at the top
of the page. The participant will be available for select on the Specimen
Management and Quick Add pages, where new enrollments, visits, and
specimens can be added.

Adding enrollments using Quick Add
The Quick Add feature can be used to add an enrollment to an existing
participant, along with other information.

Prerequisites
The participant must already be added to LDMS before an enrollment can be
added; enrollments cannot exist without being associated with at least one
participant.

Background

Using Quick Add to add an enrollment to a participant is especially useful
if you want to enter other information at the same time, such as a visit or
specimens.

Steps

1. In the LDMS menu bar, click Specimen Management > Quick Add.
2. In the Participation Information section, select the Project and

ID1 for the participant.
3. In the Enrollment Information section, select or enter the

enrollment.

Note:  If you enter an ID2 that does not yet exist, it will be
created.

4. Optional: Complete any additional visit or specimen information for
this participant.

5. At the bottom of the page, click Save.

TBD in quick add templates
The TBD code can be used in quick add templates for certain sections that
might need to be completed when the template is used.

For example, you may need create a template for a visit where the additive
time used for a primary specimen varies based on certain factors. In these
situations, using the TBD code will require the user to select the correct code
when the template is used.

Places where TBD can be used in quick add templates

• Primary type
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• Additive type
• Derivative type
• Sub A/D type

Quick add templates
Quick add templates are predefined specimen entry scenarios (typically for
specific study visits) that can be used to automatically create some default
specimens.

Templates are best used for specific study visits to create the expected
specimen collections for the visit. They can also be used to complete other
information, such as the ID2 and project that would be the same whenever
the template is applied.

There are two types of templates: templates created by Frontier Science and
templates that are created by your laboratory. Templates created by Frontier
Science are designed in collaboration with leadership for projects and cannot
be modified by users. Templates created by users at your laboratory can be
modified. User-created templates are only available at the laboratory where
they were created; they are not shipped or sharable with other laboratories.

Regardless of the type, once a template is applied, you will be prevented
from changing the participant’s project (meaning you can’t apply a template
intended for one project, and then change the project, effectively using the
template for a project for which it wasn’t intended). In addition, when you
apply a template, any information that you already entered on the Quick Add
screen will be cleared. This means that the template must be applied first,
before you enter any other information.

Creating quick add templates
Create quick add templates by defining the information for the visit.

Steps

1. From the LDMS menu bar, click Specimen Management > Quick
Add Templates.

2. Complete the Template Information section.
The Name is the name of your template as it will appear when
selecting it when using the quick add feature. The Comments is a
brief description of the template that will appear when the template
is selected, and can be used to provide the person entering data if
additional information or instructions, such as a reminder to remove
an optional specimen if it was not collected.

3. In the Participant Information section, select a Project.
4. Optional: In the Enrollment Information section, select an ID2 to

be applied.
5. Optional: In the Visit Information section, select an ID3 to be

applied.

Important:  Either an ID2 or ID3 must be applied in order for
the template to be created. Alternatively, both an ID2 and ID3
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can be applied. These cannot be edited once the template has
been triggered.

6. Optional: Add a primary specimen.
6.1. In the Primary Information section, click Add New.
6.2. In the row that appeared, enter the information for the primary

specimen to be created.
6.3. Optional: To view and modify all of the information for the

primary, click Edit in the right column.
7. Optional: Add an aliquot specimen.

7.1. Highlight the primary specimen for the aliquot.
7.2. In the Aliquot Information section, click Add New.
7.3. In the row that appeared, enter the information for the aliquot

specimen to be created.
8. At the bottom of the page, click Save Template.

Modifying or deleting a quick add template
Quick add templates can be changed or deleted without affecting specimens
added using the template.

Background

When a template is modified, the changes will be reflected when new visits
are created using the template; existing entries will not be changed. If a
template is deleted, it will be permanently removed, however any entries
made using the template will remain.

Steps

1. From the LDMS menu bar, click Specimen Management > Quick
Add Templates.

2. In the Saved Templates box, select the template to be modified or
deleted.

3. Do one of the following:

• Make any changes to the template, and then click Save Template
at the bottom of the page.

• At the bottom of the page, click Delete Template.
• Click “Make Copy” to make edits to a copy of the selected

template while preserving the original template.

Differences between primaries and aliquots
This section describes the differences between how LDMS treats primaries and
aliquots.
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Table 3: Primary and aliquot comparison

Primary Aliquot

Global Specimen ID Ends in -00 Ends in -01, -02, etc.

Processing date Entered by user Uses value from primary

Enrollment Can be associated with more
than one visit or protocol

Must select exactly one
associated enrollment

Certain information can be cascaded from primaries to derived aliquots
specimens, so that if the primary is updated users will be asked if they want
to update the aliquots as well.

• Frozen date
• Frozen time
• Comments
• Internal comments
• Tech initials

If a comment is cascaded from a primary to an aliquot, it will be added to any
existing comment the aliquot already has.

Specimen availability
Availability refers to whether or not a specimen exists at a laboratory.

A specimen’s physical availability may change for a variety of reasons. For
example, if a primary specimen was processed into aliquots, the primary
specimen no longer exists and is thus not available. Likewise, if an aliquot’s
tube was damaged and its contents could not be recovered, it is also not
available.

If a specimen is available, it can be added to a shipment and it can be
assigned a storage location. If it is not available, LDMS will prevent you from
shipping or storing the specimen.

Note:  In LDMS for Windows, availability is called “never store”.

Availability is a property of both primary specimens and aliquot specimens. By
default, new specimens are available until you change them to unavailable or
a specific condition automatically changes them.

There are several times where LDMS will automatically modify a specimen’s
availability. There are other places where you can manually change
availability.

• You can manually change the availability of both primary and aliquot
specimens, unless the specimen has been shipped.

• Specimens will automatically become unavailable if they are shipped.
• If a specimen’s volume changes to zero, it is automatically made

unavailable.
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• A primary specimen will automatically become unavailable after aliquots
have been derived from it, and you cannot change it back to available
unless the aliquots are deleted.

• Certain condition codes, such as DSR (destroyed) will automatically change
a specimen to unavailable.

Table 4: Specimen conditions that modify availability

Code Description

ANM Sample Anonymized

ANP Aliquot Not Prepared

CDT Consumed During Testing

DSR Destroyed

LSH Lost Shipment

QNS Quantity Not Sufficient

SNC Sample Not Collected

SNP Sample Not Processed

SNR Sample Not Received

Specimen record details
This section describes each specimen record entry box that appears on the
Specimen Management page.

Field Usage Example Notes

Additional Time A value and a
unit

4 Hrs Used to indicate information such
as the amount of time a participant
was fasting. Typically used for
Pharmacology specimens to indicate
the amount of time after the last
dosage was taken.

Additive Type The additive
in the primary
collection tube

EDT Selected from a pre-defined list
of codified values. If there was no
additive in the tube, use NON. Hover
the mouse pointer over an additive
for a more detailed description.

Additive Reagent

Aliquots List of any
aliquots for the
selected Primary
Specimen

- Displays the same specimen
overview grid as seen on the
Specimen Management page,
specific to the primary's aliquots
only. Aliquots can be edited from this
window by clicking the Edit button.

Assigned Tests
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Field Usage Example Notes

Available Volume A value and a
unit

1.00 ML Used to indicate the volume of the
sample available for use. Hover the
mouse pointer over the units for a
more detailed description.

Clinic The clinical site
where a visit
occurred

102 Select from a pre-defined list. For
a description of a clinic, such as its
name, hover the mouse pointer over
it.

Collection Date The date that a
visit occurred

02/Apr/2014 This will typically be one day. If a
visit occurred over multiple days,
each event will considered a separate
visit and listed as separately in
LDMS. They will still, however, have
the same visit value and visit unit.

Collection Time The time that the
specimen was
collected

13:30 This time should be the local time
for the clinical site, and be in 24-
hour format. In LDMS for Windows,
collection time is known as specimen
time

Comments Additional
details about the
specimen

Used to provide additional
information, such as an explanation
of a specimen’s current condition.
This comment will be included if the
specimen data is shipped to another
laboratory.

Derivative Type The type of
aliquot specimen
created

PL2 Selected from a pre-defined list of
codified values. Hover the mouse
pointer over a type for a more
detailed description.

Enrollment The project-
ID2 combination
associated with
an aliquot

project/ID2 The enrollment is in the format
[project]/[ID2].

Frozen Date The date the
specimen was
frozen

04/Jun/2014 This is generally used to indicate the
date the freezing process began.

Frozen Time The time the
specimen was
frozen

15:00 This is generally used to indicate the
time the freezing process began.

Global Specimen
ID

A unique
identifier for the
specimen

500-
AEQ0052R-01

This will be unique for the specimen.
LDMS will never generate the
same global specimen ID, even at
two different laboratories. Global
specimen IDs for primaries always
end in “-00”; global specimen IDs
for aliquots will have the same
ID as their parent primary, but
end in “-01”, “-02”, and so forth.
Specimens added in LDMS for
the web will have the originating
laboratory’s ID number as the
first 3 digits. Global specimen IDs
generated by LDMS for Windows will
lack this feature.
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Field Usage Example Notes

Harvest Date Indicates the
date that a
culture derivative
sample was
harvested.

04/Jun/2014 -

ID3 A sub-protocol or
study

A50250562I Used by some projects to further
identify the protocol. This is typically
selected from a pre-defined list. For
some protocols, a temporary value
such as “NOSID” may be used until
the exact value is assigned to the
participant. For other protocols, this
field may not be used or may be
optional.

Imported Indicates if the
sample was
received and if
so, on what date.

Shipment 12 on
11/Aug/2005 or
No

Link to Received Shipment Review
page, if applicable.

Import Date Date the
shipment with
the specimen was
received

11/May/2016 If the specimen was not received in a
shipment, this will be blank.

Internal-Only
Comments

Additional
details about the
specimen

These comments will not be included
if the specimen data is shipped to
another laboratory.

Is Available Indicates if the
specimen is
available

Availability means that the specimen
exists and can be shipped, stored,
and so forth. Reasons that a
specimen might not exist include
being destroyed or being shipped to
another laboratory.

Owner
Enrollment

The enrollment
that “owns” a
primary specimen

project/ID2 For primary specimens that have not
been processed into aliquots, this
is the enrollment that “owns” the
specimen

Original Volume Indicates the
volume of the
sample before
any aliquots were
created or tests
were run

1.0 ML -

Other Specimen
ID

A laboratory-
defined identifier

There are no rules or validation for
this field; it can be used to assign a
special identifier if needed by your
laboratory.

Primary Type The type of
primary specimen

BLD Selected from a pre-defined list of
codified values. Hover the mouse
pointer over a type for a more
detailed description.

Processing Date Date a primary
specimen was
processed into
aliquot specimens

15/Oct/2012 Use local time. If present, the value
entered for the parent primary
specimen will be used for aliquots
derived from the primary.
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Field Usage Example Notes

Processing Tech
Initials

The initials of
the person who
processed a
primary specimen
into aliquot
specimens

JD If the processing tech initials are set
for a primary, aliquots derived from
the primary will receive those initials
as well. You can change the initials
for individual aliquots, if needed.

Processing Time Time a primary
specimen was
processed into
aliquot specimens

16:15 Use local 24-hour time. If present,
the value entered for the parent
primary specimen will be used for
aliquots derived from the primary.

Reason Specimen
Not Collected

Explanation of
why an expected
specimen was not
collected during a
visit

Specimen
potentially
compromised

Typically used in conjunction
with a specimen condition code
that indicates an issue with the
specimen, such as “QNS” (quantity
not sufficient). If necessary, use the
Comments box for the specimen
provide more details.

Received Date The date the
specimen was
received by
the processing
laboratory where
the primary was
processed into
aliquots

12/Mar/2014 -

Received Time The time the
specimen was
received by
the processing
laboratory

14:45 Times should be entered in 24-hour
local time.

Shipped Whether the
specimen has
been shipped
to another
laboratory

Yes, no, or
pending

Provides link to shipment, if
applicable

Specimen
Condition

The current
condition of the
specimen

SAT Selected from a pre-defined list of
codified values. Hover the mouse
pointer over a condition for a more
detailed description.

Specimen ID A legacy
specimen ID used
only by LDMS

500V10000110 The specimen ID is an identifier for
the specimen that was used by older
laboratory management software. It
will only be present for specimens
that were entered or migrated
from LDMS. Specimens created
using LDMS will not be assigned a
specimen ID.
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Field Usage Example Notes

Status Icons indicating
various
properties about
a specimen

 Specimen is available

 Specimen is assigned a
storage location

 Specimen has been shipped to
another laboratory

 Specimen has an additional
enrollment

Stored Whether the
specimen
currently has a
storage location
assigned

Yes or no Provides link to storage location

Sub-Additive/
Derivative

If the specimen does not have a sub-
additive/derivative, select NON.

Thaw Count The number
of times the
specimen has
been frozen and
thawed.

3 -

Total Cell Count Total number of
cells (in millions)

10 When entered, it will be multiplied
by 1 million. For example, to indicate
10 million cells, enter 10; to indicate
500,000 cells, enter 0.5.

Tube Count The number of
primary tubes
collected for the
pooled sample

5 This field is used to record the
number of primary tubes collected
for the sample in scenarios where
the tubes are pooled into a single
sample when recording in LDMS.

Unavailable Date The date the
specimen is no
longer available

12/Mar/2014 -

Visit Value The protocol-
defined identifier
for a visit

1 Wk This comprises of two boxes, a
visit number and visit type. A visit
value is typically a number or letter.
The visit unit is selected from a
pre-defined list. Hover the mouse
pointer over a visit unit for a brief
description.

Specimen conditions
A specimen condition is a 3-letter code that indicates the status of a
specimen.

Every primary specimen and aliquot specimen in LDMS has a condition
assigned to it. The default condition for new specimens is SAT (satisfactory),
but there are many others.

The majority of conditions indicate a deviation from the expected handling for
a specimen. For example, if a specimen was supposed to be collected in one
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type of tube but another was used, the INT (incorrect tube type) condition
code could be used to indicate this.

There are several places where the condition of specimens can be changed:

• on the Specimen Management page, by editing an individual specimen
• when receiving specimen data from a shipping file
• on the storage page all specimens in a storage location can be modified

A common use for specimen conditions is indicating when an expected
primary specimen was not collected. By setting the specimen’s condition to an
applicable code (such as QNS if not enough sample could be collected) and by
entering descriptive comments, you can explain the omission of the expected
specimens.

Destroying a specimen
Specimen destruction is noted in LDMS by applying the DSR specimen
condition.

Background

When a specimen is destroyed, it is important to document that destruction in
LDMS.

Steps

1. From the menu bar, click Specimen Management.
2. Using filters on the left, locate the specimen to be destroyed.
3. To the right of the specimen, click Edit.
4. Change Specimen Condition to DSR.
5. (If the specimen has been assigned a storage location) Write down the

storage location of the specimen, if it has not already been physically
removed.

! Warning:  The specimen will automatically be un-assigned from
its storage location in LDMS. This is your last chance to get the
specimen’s storage location.

6. In the Comments box, enter an explanation of why the specimen was
destroyed.

After you are finished
If you have not already done so, use the storage location that was noted
by LDMS to find the specimen and physically remove it from storage. The
specimen was automatically removed from storage in LDMS.

Procedural conditions
These specimen condition codes describe issues that can occur in the
collection and processing environment.
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Table 5: Procedural conditions

Code Description Usage

ANP Aliquot Not Prepared Indicate that an expected aliquot was not processed,
but no other more specific condition code applies. The
reason specimen not collected box should be used in
conjunction with ANP.

EQF Equipment Failure There was an issue with the processing equipment, such
as a power failure during processing.

INV Invalid The specimen is not valid for testing purposes. Generally
another condition code, such as LBE or PST, would be
more appropriate.

LBE Laboratory Error The laboratory made a general error during processing,
such as setting equipment up incorrectly or mislabeling
specimens.

OPR Outside Protocol
Requirements

The specimen was drawn during the protocol-defined
window, but not in a manner consistent with the protocol.
For example, if a participant was supposed to be fasting
but was not, this code would apply.

OSW Outside Visit Window The specimen was collected correctly, but outside the
window for the visit as specified by the protocol.

PST Processed After Specified
Time

The specimen was collected and processed into aliquots,
but the processing was done after the time frame
specified by the protocol. This is commonly applicable for
PBMC and pharmacology specimens.

Specimen container conditions
These condition codes describe physical problems with the specimen’s
container. If there is a qualitative issue with the specimen as a result of the
container issue, a qualitative code may be more appropriate.

Table 6: Specimen container conditions

Code Description Usage

BKV Broken Vial The container was broken beyond recovery, such as being
dropped and shattered on the ground.

DMG Damaged The container is not leaking, but is damaged in another
way, such as a tear in a label or a dent in a plastic
container.

EXP Expired The additive in a container, or some other component
used during specimen collection, was expired.

INT Incorrect Tube A tube type other than the one specified by the protocol
was used, and the tube used was determined to be an
acceptable alternative by the study team.

LKD Leaked The specimen leaked from the container, and it was placed
inside another container and recovered.
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Temperature conditions
Temperature condition codes are typically applicable if there was an issue
during shipping (such as sublimed dry ice) or if a piece of storage equipment
failed. Other codes are applied as part of routine and expected handling of
specimens. For example the FRO condition code can be used to indicate that a
specimen intended to be stored ambient or refrigerated was frozen.

Table 7: Temperature conditions

Code Description Usage

DIM Dry Ice Melted The specimen was kept on dry ice, but the dry ice
sublimed. This does not necessary imply that the
specimen was damaged or TNO.

FRO Frozen The temperature of the specimen has been lowered
below its freezing point. This applies only to
specimens that were not intended to be frozen,
such as specimens that were shipped at ambient
temperature during the winter.

REF Refrigerated The specimen is cooler than room temperature but
not below its freezing point. This applies only to
specimens that were not intended to be refrigerated.

TNO Temperature Not Optimal The specimen was stored or shipped at any
temperature other than the temperature specified by
the protocol.

TWD Thawed The specimen was frozen, and has been warmed so
that it is no longer frozen. LDMS has a field to track
a thaw count, which can be used to keep track of
how many times the specimen has been thawed. This
information can be found on the Details Window for
the aliquot in Specimen Management.

Shipping conditions
These condition codes apply to issues with a specimen shipment where the
specimens are unaccounted for or were received late. If the shipping issue
damaged the specimens, a temperature-related code such as DIM (dry ice
melted) may be more appropriate.

Table 8: Shipping conditions

Code Description Usage

DSH Delayed Shipment A shipment did not occur on schedule, but there is no
obvious damage to the specimens. If there was obvious
damage, a more descriptive, temperature-related code
(such as DIM or TNO) may be more appropriate.

LSH Lost Shipment A shipment was created and sent, but did not arrive at
the receiving laboratory. Neither the shipping nor the
receiving laboratory can locate it.

SNR Sample Not Received A data collection form, such as a CRF, was received, but a
specimen listed on the form was not received. This differs
from LSH in that only some specimens were not received,
compared to an entire shipment.
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Qualitative conditions
These codes refer to the quality of a specimen. For example, if a blood
specimen clotted, this is a qualitative issue that could prevent processing.
If there was a qualitative or participant abnormality that would prevent
processing but no other code is applicable, the SNP condition code can be
used.

Table 9: Qualitative conditions

Code Description Usage

BLD Bloody The specimen, such as a throat swab, contained blood.

CLT Clotted The specimen has clotted, often because the additive did
not mix correctly with the specimen.

CTM Contaminated The specimen is visibly contaminated.

DCG Discharge present A specimen, such as a vagina swab, that contains
discharge material

HEM Hemolyzed A blood specimen that has hemolyzed.

HUM Humidity The specimen has been exposed to high humidity.

ICT Icteric There are excessive amounts of bilirubin in the specimen.

LIP Lipemic There is excessive fat content in the specimen.

LYS Lysed There has been a breakdown of cells in the specimen
other than hemolyzation.

NQA Real-time QA for viability
and viable recovery not
performed due to low
volume of sample collected

Used by a Leukopak processing laboratory to indicate that
the full specimen volume needed for PBMC viability and
viable recovery QA could not be obtained.

SNP Sample Not Processed A generic code for when there is a qualitative issue that
prevents an otherwise correctly collected primary from
being processed into aliquots, but no other code applies.
The Reason sample not collected field should be used in
conjunction with SNP.

VPL Viability percentage may
be less than the expected
parameter

Used by a processing laboratory to indicate that the PBMC
viable percentage of the PBMC specimen may be lower
than what's expected.

VRU Viable recovery may
be outside expected
parameters (higher or
lower)

Used by a processing laboratory to indicate that the PBMC
viable recovery of the PBMC specimen may be outside
what is expected.

Quantitative conditions
These condition codes refer to the volume of specimen collected.

Frontier Science Foundation 61



LS.0006 | LDMS for the Web - User Manual

Table 10: Quantitative conditions

Code Description Usage

DFB Difficult bleed There was problems trying to obtain a blood specimen
from the participant, typically resulting in a lower volume
than was expected. This code is more specific than SHV,
which does not indicate why the volume was low.

QNS Quantity Not Sufficient There was not enough specimen available to create the
aliquot. For example, if specimen collected from the
participant was supposed to be 10 mL but only 5 mL was
collected, the aliquots that could not be created due to the
low volume would be considered QNS. QNS means there
is no volume at all for the aliquot, even though there was
some volume for the primary.

SHV Short Volume The primary or aliquot specimen has at least some
volume, but not the full expected volume.

SNC Sample Not Collected The primary specimen was not collected from the
participant at all. This might happen if the participant
declined to provide a specific sample.

Other conditions
These condition codes are either automatically assigned to specimens or
indicate some combination of issues. The default condition code that is
assigned to all new specimens is SAT (satisfactory).

Table 11: Other conditions

Code Description Usage

ANM Anonymized The specimen was created using the anonymization tool in
LDMS. This code is automatically assigned by LDMS and
cannot be assigned manually.

COC Combination of Codes More than one condition code applies; the comments field
in LDMS can be used to list the applicable codes.

DSR Destroyed The specimen has been destroyed.

OTH Other There is something noteworthy or unusual about the
specimen, but no other available condition code applies.

SAT Satisfactory The default condition code for new specimens, indicating
that the specimen was collected, processed, and handled
as expected.

UNK Unknown Indicates that there is a significant gap in knowledge in
the specimen’s history. For example, if the specimen was
collected by another laboratory that was not using LDMS
and is several years old, and it may have been stored or
treated improperly, this code may be appropriate.

YST Did consent to storage The participant has provided consent to storage of the
specimen.

NST Did not consent to storage The participant did not provide consent to storage of the
specimen.
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Test assignment
Specimens can be assigned tests to indicate a specific test that is expected.

While specimens cannot be tested in LDMS for the web, specimens may be
shipped to a laboratory using a LDMS for Windows. The laboratory using
LDMS for Windows may then enter results for the expected test.

Assigning tests to a specimen
Expected tests can be assigned to a specimen, which will make it easier to
locate the specimen when setting up assay test runs.

Steps

1. On the navigation menu, click Specimen Management.
2. Locate the specimen to have a test assigned. From that specimen's

Edit menu, click Assign Tests.
3. In the Test list, select the test to assign.

If Other was selected, enter the name of the test in the Other Test
Name box.

4. Click Assign Test.

Indicating that a test will not be performed
If an assay is expected but will not be performed, the test can be assigned
and then indicated that it will not be tested.

Steps

1. On the navigation menu, click Specimen Management.
2. Locate the specimen to have a test assigned. From that specimen's

Edit menu, click Assign Tests.
3. For the test, do the following:

3.1. In the Test Not Performed column, select the check box.
3.2. In the Reason For No Result column, select the appropriate

code.
Hover over a code to see a brief description.

3.3. Optional: In the Comment column, enter more information
about why the test was not performed.

4. Click Save.

Deleting a test assignment

Background

A test assignment will typically only be deleted if it was added in error. If the
test was expected but will not be run, the appropriate code could be assigned
to the test instead.
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Steps

1. On the navigation menu, click Specimen Management.
2. Locate the specimen to have a test assigned. From that specimen's

Edit menu, click Assign Tests.
3. In the Action column, click Delete.
4. Click Save.

Storage
The Storage page is used to define how your real-world storage is set up and
where individual specimens are stored.

The Storage page is organized into four sections:

Stored
specimens

This is where you will actually perform storage work,
such as creating a new storage unit or assigning a
storage location to specimens.

Storage unit
templates

This is where you can define templates for commonly
used storage units.

Level templates This is where you can define templates for commonly
used storage levels.

Container
templates

This is where you can define templates for commonly
used storage containers.

Navigation on the Storage page
The Storage page shows a representation of your real-life storage as a
collapsible tree.

This tree is called the storage tree view, and shows all of the items in storage
as you have defined them in LDMS.
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Figure 26: The Storage page

(1) Navigate between pages (if your storage page does not fit on one). (2) The location of the specimen in “Auto-

generated box #74-1”. (3) Edit menu for storage item named “Auto-generated box #74-1”. (4) The storage tree view.

(5) Indicator that you can scan a barcode to add samples into a storage location. (6) The ability to automatically assign

storage locations. (7) Close all units, levels, and containers.

The storage units in the storage tree are sorted alphabetically by name. The
contents within storage units are sorted by position. Before expanding any
storage items however, you can scan a barcode to search for a stored item
automatically when the following icon is shown at the top of the page:

Click on the + button to the left of a storage item to open it. The contents in
the square brackets next to the item’s name (such as [ 1, 2 ]) indicates that
items position in its parent storage item. To the right of each storage menu is
the Edit menu for that item. The options available from this menu will vary,
depending on the type of storage item.

The storage tree
The storage system in LDMS is a hierarchy of storage items.

There are several types of storage items in LDMS. From biggest to smallest,
these are:

storage unit This is the main cooling unit used to store specimens,
such as a freezer or a refrigerator.

level This is an intermediate part of a storage system, such as
a shelf within a freezer. You can add an additional level to
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another level. For example, you might have a shelf that
contains racks of boxes, where the rack is a level on the
shelf, which is a level in a freezer.

container This is the storage item that holds specimens, such as a
box.

Figure 27: The LDMS storage hierarchy

The storage hierarchy is visualized on the Storage page in LDMS as a tree.

Figure 28: The storage tree on the Storage page

(1) A storage unit. (2) A level. (3) A container. (4) Specimens in the container. (5) The name for this specific storage

unit. (6) The position of the item in its parent. (7) The global specimen ID for each specimen.

Storage items
Storage items in LDMS are represented as nested grids.

Each storage item contains rows and columns that represent individual
locations within that storage item. For example, a shelf that can hold
10 boxes might have the dimensions of 2 x 5 (2 rows with 5 columns to
represent each box). This is true of all storage items, from big storage units
to small containers.
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Figure 29: Storage items as grids

This visual illustrates the nested grid of storage items. Below each item is a grid showing where the highlighted item is

positioned.

Rows and columns can be represented as either numbers or letters. Individual
sections of a storage item can also be represented as a position number
instead of coordinates. For example, if you have a 1 x 3 shelf, each position
could be represented as 1, 2, and 3, rather than (1,1), (1,2), and (1,3).

Storage items can optionally have an excluded position. An excluded position
is useful for determining which side of the storage item is the front and
which is the back. For example, if you know that the upper-right corner of a
container will be empty, you know where to start inserting specimens.
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Figure 30: Configuring a storage item layout

The preview shows how these settings will be interpreted by LDMS. A,A (black) is an excluded position. A,B to C,A

(gray) contain another storage item or specimen. C,B to E,B (tan) are empty positions.

All of these properties of storage items can be configured when adding new
items to the storage tree. They can also be defined in advance by using a
storage template.

Icons and their meaning
The icons next to the items in the storage tree indicate the type of storage
item, and special properties such as its additive or whether the item is part of
a pending shipment.

Table 12: Storage item icons

Icon Meaning

Storage unit

Storage unit
that has been
flagged 'mark
to ship'

Storage unit
that is part
of a pending
shipment

Level

Level that has
been flagged
'mark to ship'

Level that
is part of
a pending
shipment
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Icon Meaning

Sub-level

Sub-level
that has been
flagged 'mark
to ship'

Sub-level
that is part
of a pending
shipment

Container

Container
that has been
flagged 'mark
to ship'

Container
batched

Specimen

Specimen
that has been
flagged 'mark
to ship'

Specimen
that is part
of a pending
shipment

Table 13: Additives with colored tubes on the storage page

Any additive not listed in this table uses a black icon.

Additive Icon

ACD

AHP

DPE

DSE

EDT

HEP

LHG

LHP

LPE

LSE
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Additive Icon

NON

PED

SCI

SED

SFL

SST

THM

Assigning storage locations

Adding a new storage unit
A storage unit is the largest type of storage item, and is used to hold levels.

Background

A new storage unit is created by defining various properties for it, such as
its size and temperature. You can manually define these properties for the
storage unit as you create it, or you can use a template that applies default
settings for you.

Steps

1. Click Storage > Stored Specimens from the LDMS menu bar.
2. From the action menu, select Add storage unit.

Figure 31: The LDMS action menu

The Create storage unit window will open.
3. Optional: Select a template to use for the new storage unit from the

From template box.
All settings from the template will be set for you. You can override
any settings from the template if needed. Any changes made will only
affect the new storage unit; the template will not be modified.

4. Optional: Click the Empty Structure button to remove any levels that
were automatically added by a template.
This is only necessary if you do not want to use the default levels (if
present) from a template.
All levels added by a template will be removed.
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5. Enter a descriptive name for the new storage unit in to Name box.
This is the name for the new storage unit as it will appear in the
storage tree in LDMS.

6. Select the type of storage unit from the Type box.
7. Select the temperature of the new storage unit from the

Temperature box.
8. Enter the number of rows and columns for the new storage unit into

the Number of rows and Number of columns boxes.
This represents the size and capacity of the new storage unit in terms
of the number of levels that it can hold. For example, if you are
creating a freezer that can hold 5 shelves vertically, you might have 1
column and 5 rows.

9. Select or deselect the Positions only option as desired.
If the positions only option is selected, each item in the level in the
new storage unit will be identified by a number. If it is not selected,
each level will be identified by its coordinates.

10. (If Positions only is not selected) Define how levels in the new unit
should be identified.
10.1.Select either Row/Column or Column/Row from the Coordinate

order box.
If Row/Column is selected, each level’s position will be identified
in the format (row,column)

10.2.Select how columns and rows are to be labeled from the
Column labeling and Row labeling boxes.
To use letters to identify rows or columns, select Alphabetic; to
use numbers, select numeric.

10.3.Select the fill order for the new unit from the Fill order box.
Fill order can be used when adding a new level to the unit. While
you must specify a fill order, you can override it when adding
levels to the storage unit.

10.4.Optional: Select a position(s) in the unit to be excluded from the
Excluded positions box.
Excluded positions are used to help identify the orientation of
the container (meaning which side is the front and which is the
back).

11. Review the Preview of the new unit.
If any empty levels will automatically be added the new unit, they will
be listed in the Default Levels section.

12. Optional: To save the current configuration as a new template, do the
following.
12.1.Select Save As New Template.
12.2.In the New Template Name box, enter a name for the

template.
13. Click the Save button.
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Result
The new unit will have been added to the storage tree. The storage tree is in
alphabetical order, so you may need to change pages in the storage tree to
find your new storage unit.

Adding a new level in a storage unit
A new level is added to an existing storage unit or storage level.

Prerequisites
You must have created the storage unit before you can add levels to storage
in LDMS. In other words, you cannot create a level that is not associated with
a storage unit.

Steps

1. Click Storage > Stored Specimens from the LDMS menu bar.
2. Find the storage unit to which you are adding a level.

If you want to add a sub-level to an existing level, find that level
instead. You can used the filters on the left side of the page to help
find the storage item.

3. Click the down arrow next to the Edit button to the right of the
intended parent storage unit or level, and then click Add new level.
Figure 32: The Edit Storage Unit button

The Select position for new level window will open.
4. Optional: Select a template to use for the new level from the From

template box.
All settings from the template will be set for you. You can override
any settings from the template if needed. Any changes made will only
affect the new level; the template will not be modified.

5. Enter a descriptive name for the new level in to Name box.
This is the name for the new level as it will appear in the storage tree
in LDMS.

6. Enter the number of rows and columns for the new level into the
Number of rows and Number of columns boxes.
This represents the size and capacity of the new level in terms of the
number of levels or containers that it can hold. For example, if you are
creating a shelf that can hold 5 boxes side-by-side, you might have 5
columns and 1 rows.

7. Select or deselect the Positions only option as desired.

Frontier Science Foundation 72



LS.0006 | LDMS for the Web - User Manual

If the positions only option is selected, each item in the new level
will be identified by a number. If it is not selected, each level will be
identified by its coordinates.

8. (If Positions only is not selected) Define how levels or containers in
the new level should be identified.
8.1. Select either Row/Column or Column/Row from the Coordinate

order box.
If Row/Column is selected, each level or container position will be
identified in the format (row,column)

8.2. Select how columns and rows are to be labeled from the
Column labeling and Row labeling boxes.
To use letters to identify rows or columns, select Alphabetic; to
use numbers, select numeric.

9. Select the fill order for the new level from the Fill order box.
Fill order can be used when adding a new level or container to the
level. While you must specify a fill order, you can override it when
adding items to the level.

10. Optional: Select a position(s) in the level to be excluded from the
Excluded positions box.
Excluded positions are used to help identify the orientation of the
container (meaning which side is the front and which is the back).

11. Review the Preview of the new storage item.
12. Click the Continue button.

The Select position window will open.
13. Specify the position within the storage unit for the new level by doing

one of the following:

• Select a position for the new level from the Position box.
• Click on a position in the Preview section.

Positions that cannot be selected are either already occupied by
another level or empty by exclusion rules for the storage unit. Gray
positions are occupied; black positions are excluded.

14. Optional: To save the current configuration as a new template, do the
following.
14.1.Select Save As New Template.
14.2.In the New Template Name box, enter a name for the

template.
15. Click the Save button.

Adding a container to a level
A new storage container is added to an existing level or sub-level.

Prerequisites
You must have created the storage units and levels for the container before
adding the container. In other words, you cannot add a container to a freezer
without a level, nor can you create a container that is not within a freezer.
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Steps

1. Click Storage > Stored Specimens from the LDMS menu bar.
2. Find the storage unit to which you are adding a level.

If you want to add a sub-level to an existing level, find that level
instead.

3. Click the down arrow next to the Edit button to the right of the level
that will hold the container, and then click Add New Container.
Figure 33: The Edit level button

If the level has had sub-levels added, the Add new container option
will not be available. A container cannot be added side-by-side with a
sub-level.

The Create container window will open.
4. Enter the number of new containers to add in the Number to add

box.
5. Optional: Select a template to use from the From template box.

The information from the template will be populated into the
remaining boxes. You can still modify this information, if needed. Any
changes made will only affect the containers that you are creating.

6. Enter the number of rows and columns for the new container into the
Number of rows and Number of columns boxes.
This represents the size and capacity of the new container in terms of
the number of specimens that the container can hold. For example, if
you are creating a box that can hold 25 specimens, you might have 5
columns and 5 rows.

Note:  The system will warn the user when a box is outside the
max 26x26 dimensions.

7. Select or deselect the Positions only option as desired.
If the positions only option is selected, each specimen in the container
will be identified by a number. If it is not selected, each specimen will
be identified by its coordinates.

8. (If Positions only is not selected) Define how specimens in the new
container should be identified.
8.1. Select either Row/Column or Column/Row from the Coordinate

order box.
If Row/Column is selected, each specimen’s position will be
identified in the format (row,column)
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8.2. Select how columns and rows are to be labeled from the
Column labeling and Row labeling boxes.
To use letters to identify rows or columns, select Alphabetic; to
use numbers, select numeric.

8.3. Select the fill order for the new level from the Fill order box.
Fill order will be used when adding new specimens to the
container, and you chose to use automatic positioning. While you
must specify a fill order, using the automatic positioning feature
is optional.

8.4. Optional: Select a position(s) in the container to be excluded
from the Excluded positions box.
Excluded positions are used to help identify the orientation of
the container (meaning which side is the front and which is the
back).

9. Optional: To save the current configuration as a new template, do the
following.
9.1. Select Save As New Template.
9.2. In the New Template Name box, enter a name for the

template.
10. Click the Continue button.

The Select position window will open.
11. Enter a descriptive name for the first container into the Name box.

This is the label for the new container as it will appear in the storage
tree.

12. Specify the position for the new container on its parent level by doing
one of the following:

• Select a position for the new container from the Position box.
• Click on a position in the Preview section.

Positions that cannot be selected are either already occupied by
another container or empty by exclusion rules for the parent level.
Gray positions are occupied; black positions are excluded.

13. Click the Continue button.
You will need to specify the Name and position for each new container
that you are creating.

Result
The new containers will be created in the positions specified.

Assigning a storage location to specimens
Individual specimens are added to containers on the Storage page.

Prerequisites
You must create the specimens on the Specimen Management page prior
to adding them to a container. You must also have created the container to
which the specimens will be added.
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Background

Individual specimens are stored in containers. You cannot add specimens to a
level or storage unit without a container.

Steps

1. Click Storage > Stored Samples from the LDMS menu bar.
2. Find the storage container to which you want to add specimens in the

storage tree.
Use the filters on the left side of the screen to assist in finding the
container.

3. From the Edit menu to the right of the container, select Store
specimens.

Figure 34: The Edit container menu

The Select Specimens window will open.
4. Do one of the following:

• Use filters to find specimens to limit the specimens displayed at the
bottom of the page

• Click Upload File: Unique specimen IDs (file must be a text file
with one specimen ID per line)

Note:  Supported ID formats include Specimen IDs, Other
Spec IDs, Global Spec IDs, and Database IDs.

• Scan a specimen barcode
5. For each specimen to be stored, select the check box in the Selected

column.

You can also click Select All to store all currently displayed
specimens.

If you change filters at this point, any specimens selected will remain
selected.

6. At the bottom of the Select Specimens window, click Continue.
The Select position for specimen window will open.

7. Select the position where the first specimen will be stored from either
the Position box or the Preview image.
The global specimen ID for the specimen will be displayed in the
window. Positions that are gray are not available because a specimen
already occupies that location. A position that is black is an excluded
position in the container’s configuration.

Frontier Science Foundation 76



LS.0006 | LDMS for the Web - User Manual

8. Optional: To place the remaining specimens to be stored automatically
based on the container’s fill order setting, select the Auto-fill from
selected position option.

9. Click Continue.
If there are more specimens to be stored and you did not select the
Auto-fill from selected position option, you will be prompted to
select a position for those specimens, otherwise, the window will
close.

Result
The specimens are now stored. If you look at the storage tree, you will see
that they are now listed under the specified container.

After you are finished
Generate the Storage Details and Container reports. These will help you know
where the specimens need to physically be stored.

Generating a printable list of what is in storage
The Storage Details and Container reports can be used to print a list of all the
storage items or specimens in a specific location.

Background

In addition to assigned specimens to a storage location in LDMS, you will
need to actually put the real-life specimens in storage. The Storage Details
and Container reports can assist you in putting storage items in the correct
location. It is good practice to print them after making changes to storage in
LDMS.

Steps

1. Click Storage > Stored Samples from the LDMS menu bar.
2. In the storage tree, locate the storage item for which you need to

generate a report.
3. To the right of the storage item, click Edit.
4. Click the down arrow next to the Reports button, and then click

either Storage detail or Container.
5. In the File Type box, select PDF (*.pdf) and then click Generate

Report.

Container report
The Container report is a printable, graphic representation of the specimens
within a storage container.

This report is useful for reconciling the storage locations assigned to
specimens in LDMS and the actual real-life contents of a storage item. For
example, if you initially assign specimens to a storage location in LDMS, you
can print the container report and use it as a guide when inserting the actual
specimens in the container.
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Figure 35: Container report

(1) Storage location of container, (2) Dimensions of container, (3) Legend showing how to interpret the information for

a specimen, (4) An excluded position, (5) An empty location

The top-right corner of the container report contains a key that shows how to
interpret the details of a specimen listed on the report.

Storage templates
Templates allow you to add commonly used storage items quickly by defining
them in advance.

Template allow you to setup commonly used storage items, such as a box that
your laboratory uses, and re-use the template as often as needed.

If you need to add a storage item that is a slight variation of an existing
template, you can modify the template while creating the new storage item.
For example, if you need to create a storage container that has an excluded
corner that is not in the template, you can add it manually without needing to
modify the template.

Creating storage item templates
Storage item templates can be created for storage units, levels, and
containers.

Background

These templates can be selected when adding storage items to LDMS to save
time.

Steps

1. Hover the mouse pointer over Storage from the LDMS menu bar,
and then click either Storage unit templates, Level templates, or
Container templates, depending on the type of template you want
to create.

2. Enter a name for the template into the Name box.
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This is the name for the template as it will appear when creating new
storage items.

3. (For storage units only) Select the type of storage unit from the Type
box and the temperature from the Temperature box.

4. Enter the number of rows and columns for storage items based on this
template into the Number of rows and Number of columns boxes.
This represents the size and capacity of new storage items based on
this template in terms of the number of levels or containers that it can
hold. For example, if you are creating a shelf that can hold 5 boxes
side-by-side, you might have 5 columns and 1 rows.

5. Select or deselect the Positions only option as desired.
If the positions only option is selected, each item in storage items
based on this template will be identified by a number. If it is not
selected, each storage item will be identified by its coordinates.

6. (If Positions only is not selected) Define how levels or containers in
storage items based on this template should be identified.
6.1. Select either Row/Column or Column/Row from the Coordinate

order box.
If Row/Column is selected, each level or container position will be
identified in the format (row,column)

6.2. Select how columns and rows are to be labeled from the
Column labeling and Row labeling boxes.
To use letters to identify rows or columns, select Alphabetic; to
use numbers, select numeric.

7. Select the fill order for storage items based on this template from the
Fill order box.
Fill order can be used when adding a new level or container to storage
items based on this template. While you must specify a fill order, you
can override it when add storage items.

8. Optional: Select a position(s) in storage items based on this template
to be excluded from the Excluded positions box.
Excluded positions are used to help identify the orientation of the
container (meaning which side is the front and which is the back).

9. Review the Preview for storage items based on this template.
10. Optional: (For storage units only) Add default levels for new storage

units based on this template.
10.1.Click the Add level button.

The Add Level window will open.
10.2.Select a template from the Saved Templates box.

The information for the template will be displayed, however you
will not be able to modify it.

10.3.Specify how many levels to add in the Number to add box.
10.4.Click the Continue button.

The Select Position for Level page will open.
10.5.Select a position for the first storage item you are adding from

either the Position box or on the Preview.
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If you are adding more than one item, you can select the Auto-
fill all from selected position. This option will place the
remaining storage items based on the fill order of the storage
item containing it. If you do not select this option, you will be
prompted to manually position each storage item.

10.6.Click the Continue button.
The storage item(s) will now appear in the Default Levels list.

You can add sub-levels and containers to the default levels that you’ve
added as needed.

11. Click the Save template button.

Modifying and removing storage templates
Storage templates can be modified or removed after they have been created.

Background

Changes to templates will only affect new storage items based on the
template. Existing storage items that were based on the template will not be
updated.

Steps

1. Hover the mouse pointer over Storage from the LDMS menu bar,
and then click either Storage unit templates, Level templates, or
Container templates, depending on the type of template you want
to modify.

2. Select the template to modify from the Saved Templates box.

Note:  If you want to clear the screen so that you can create a
new template instead of modifying the selected template, click
the Add new button.

The settings for that template will be displayed.
3. Modify the template as needed.

If you want to remove the template, click the Delete template
button. Deleting a template makes it unavailable to be used for new
storage items. Existing storage items that were based on the template
will not be affected.

4. Click the Save template button.

Result
The template will modified and any new storage items based on it will reflect
the changes. Existing storage items that were based on the template will not
be modified.

Moving items in storage
Storage items can be moved to a different location or rearranged in their
current location.
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Background

Any storage item can be moved to another location in LDMS. Moving a
storage item will require you to specify its position in its new location. If you
move a storage item from its current location to its current location, you will
be given the opportunity to rearrange its contents.

Steps

1. Click Storage > Stored Samples from the LDMS menu bar.
Alternatively, you may use a barcode scanner to select the samples to
be moved.

2. Click Move this item from the action menu.
The Move Selected to Storage Container window will open.

3. From the list of storage containers, click the Select button to the right
of the location where the selected item(s) should be moved to. The
amount of free space is listed next to each container.
The storage items selected must be moved to the same destination.
You cannot move two storage items at once that cannot occupy the
same location. For example, you cannot select to move a specimen
and a level at the same time.
The Select Positions window will open.

4. For each item being moved, select a position in the destination.
If you want to automatically place the items being moved into the
destination, select a position and then select the Auto-fill all from
selected position option. This will cause all remaining storage items
to be placed into the destination based on the destination’s fill order.

Note:  If samples are moved to a container that will not hold all
selected samples, the remaining samples will remain selected to
be moved to a different container.

5. Click the Continue button.

Moving Items in Storage - Filter Search

Background
Stored items can also be selected to be moved using various filters.
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Figure 36: Specimen Filter Screen

(1) Various filters that can be applied to the list of specimens, (2) remove all specimens filters, (3) upload a unique

specimen IDs file, (4) manually select specimens from filtered list to be moved, (5) select all specimens in filtered list

to be moved, (6) clear selected specimens in filtered list, (7) filter list of specimens by selected only, (8) continue to

Move Specimens screen

Steps

1. Navigate to the Stored Samples page under the Storage module.
2. In the Actions dropdown, select Move Stored Specimens - Filter

Search. The Select Specimens screen will open.
3. Use the various filters to locate the specimens that need to be moved.

The list of filtered specimens will appear below.
4. If not all specimens in the filtered list are intended to be moved, select

the specimens that are to be moved and click the Selected radio
button.

5. A global specimen IDs file can also be added to the list of filtered
specimens by clicking Upload File: Unique specimen IDs.

6. Click Continue.
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7. Use the dropdown menus on the following screen to find the location
the specimens will be moved to and click Select.

8. Click Continue to confirm the move.

Consolidating storage containers
Consolidating a storage container automatically moves specimens within a
container based on its fill order to eliminate empty spaces.

Background
Figure 37: Container consolidation

The effect of container consolidation before (left) and after (right).

Steps

1. On the navigation menu, click Storage.
2. Locate the storage container to consolidate, and then click Edit.
3. Below the Preview section, click Consolidate Container.
4. At the bottom of the Edit Storage Container window, click Save.

Listing specimens that moved in storage
After moving specimens in LDMS’s storage, you can print a list of these
changes so that you can move the actual specimens.

Background

When specimens are moved in LDMS they also need to be moved in your
actual specimen storage area so that the storage location assignments in
LDMS remain accurate. To help you keep LDMS and your storage in sync, you
can print a list of specimens that have been assigned new storage locations in
LDMS.

Steps

1. In the menu bar, click Storage > Stored Samples
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2. From the action menu in the upper-left corner, click Print Move
Report.

3. Next to Generate for, select one of the following:

• Select This Login Session if you want to see all specimens that
you have moved while signed in.

• Select Date Rage if you want to see all specimens that have been
moved during a given date range.

4. If using a date range, specify the Start Date and End Date
5. Leave the File Type as PDF (*.pdf).

This report is not intended to be generated in a format other than PDF.
6. Click Generate Move Report.

After you are finished
Each row in the Storage Move Report will represent one specimen that has
changed locations, with its original location and its now location. Use the
report to find the specimen in its original location so that it can be related to
the new position.

Removing items from storage
Storage items and specimens can be removed from storage

Background

Removing a storage item removes all of the items that it contains. If the
location being removed contains specimens, you will be given the opportunity
to change their condition and apply comments to them, which can be
accessed when viewing the specimens.

Removing a storage item that contains specimens does not delete the
specimens. They will still be visible on the Specimen Management page,
and (unless you chose to make them unavailable) they can be added to a
different storage container.

! Warning:  Removing a storage item cannot be undone.

Steps

1. Click Storage from the LDMS menu bar.
2. Find the storage item or specimen that you want to remove.

Use the filters on the left side of the Storage page to help locate the
items to be removed.

3. From the Edit combo button to the right of the item, select Delete.

Note:  For specimens, this option will be called Remove
instead of Delete.

The Delete [Item] window will open.
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4. Optional: If you want to change the specimens that are stored at the
location being removed to unavailable, select the Unavailable check
box and add a date to the Unavailable Date field.

This means that the specimens will not be available to add to storage
again. They will also not appear as available to ship when shipping
specimen data to another laboratory. You will still be able to find the
specimens, however, on the Specimen Management page.

If you do select this option, you will also be prompted to select a
condition for the specimens and enter a comment. This comment will
be applied to each specimen.

5. Click the Delete or Remove button.

Modifying the condition of stored specimens
The condition of all specimens in a specific storage location can be modified at
once.

Prerequisites
The storage location must not contain any specimens that are part of a
pending shipment.

Background

There will be occasions when you need to update the condition of all the
specimens in a storage location at once. This might happen, for example,
if there was an equipment failure and all of the specimens in a storage unit
were thawed.

Steps

1. Click Storage > Stored Specimens from the LDMS menu bar.
2. Locate the storage item that contains the specimens you want to

modify.
If you select a higher-level storage item, such as a storage unit or
storage level, the specimens in all sub-levels and containers will be
modified as well.

3. From the edit menu to the right of the storage item, click Set
condition code.

Figure 38: The Edit container menu

The Set Condition Code window will open.
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4. Select the condition code to apply from the Specimen condition box.
5. Enter additional information about the specimens into the Comments

box.
Information that is typically included here includes details for
specimens that were not collected, an explanation of a condition, or an
explanation of why a specimen is not available.

6. Enter additional information about the specimens into the Internal-
only comments box.
Comments entered here are for your laboratory’s use only. These
comments will not be included if the specimen’s information is shipped
to another laboratory.

7. Click the Save button.

Result
The condition code, comments, and internal-only comments for all of the
specimens in the storage location will be updated as you specified.

Storage Action Report
The Storage Action Report shows you changes that have been made to your
storage structure, such as adding specimens or containers.

Steps

1. Click Storage > Stored Samples from the LDMS menu bar.
2. From the Action Menu, click Print Storage Action Report
3. Select the appropriate radio button for the Generate for field:

• This Login Session: the report will display all changes made in
Storage during the current login session.

• Events Since Your Last Printing of Report: the report will
display all changes made in Storage since the last time the Storage
Action Report was run.

• Date Range: the report will display all changes made in Storage
during a selected date range. Select the date range using the Start
Date and End Date fields.

4. Select the criteria for actions that will appear on the report.
5. Click Generate Storage Action Report.

Shipping
The Shipping page in LDMS is where you create shipping data files and
receive shipping data files from other laboratories.

The shipping page is organized into three sections:
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Pending
shipments

This page is where you create new data shipments, view
and modify shipments that have been created but not yet
sent, and generate shipping files.

Receive
shipments

This page is where you will import shipping data files.

Shipment
history

This page shows a record of all shipping files, created
and received, for your laboratory. Shipments that are still
pending will not be shown.

LDMS shipping file compatibility
LDMS shipping files are compatible with certain version of LDMS for Windows.

The format of the shipping files used by LDMS is an encrypted XML data
file. LDMS for Windows support will vary based on the version of LDMS for
Windows.

LDMS for
Windows
version 10.0 or
higher

Can ship and receive shipping files with laboratories
using LDMS without restriction

LDMS for
Windows
version 9.x

Can ship specimens to but not receive specimens from
LDMS

LDMS for
Windows
version 8.x or
earlier

No shipping compatibility with LDMS

Shipments are data transfer
Shipping in LDMS is the process of transferring specimen information from
one laboratory to another.

This is a parallel process to physically packaging and shipping specimens to
another laboratory. As specimens are packaged, you will specify in LDMS that
they are to be shipped. You will then generate a data file with the information
for those specimens called a shipping file. Once created, you provide that
file to the laboratory that will receive the specimens. In this sense, it is
more accurate to think of “shipping” in LDMS as “data transfer” between two
laboratories.

LDMS does not assist with the physical shipment of specimens. LDMS does
not create postal labels for shipping boxes, track the progress of shipments of
couriers, and other logistical tasks. Laboratories need to implement their own
solutions for the actual shipping process.

Frontier Science Foundation 87



LS.0006 | LDMS for the Web - User Manual

Figure 39: Shipping vs data transfer

To: Dr Doe

From: Dr Smith

This figure illustrates how creating a shipping data file in LDMS and transferring it to a laboratory is a separate process

from physically boxing and shipping the specimens to the recipient.

There are two ways to ship specimens using LDMS:

1. You can select individual specimens to be shipped, and then tell LDMS how
you are going to put them in a shipping container.

2. You can assign the specimens to a container on the Storage page, then
ship the container.

Both of these methods can be used together within the same shipment.
Sending a container from LDMS storage is generally preferred over creating
ad hoc shipping containers. By using a container that has already been
organized and checked, you will save time and reduce the possibility of
sending the wrong specimens.

Shipment numbers
Shipment numbers are assigned to sent and received shipments as a way to
identify it at your laboratory.

When a new shipment is created or received, it is assigned the next available
shipment number by LDMS. For example, if the last shipment that you
received had the shipment number 152, the next shipment (whether you
receive it from another laboratory or create it to send) will be assigned the
shipment number of 153.

Shipment numbers are not unique between laboratories, nor will they be
the same at the laboratory that sent and shipment and the laboratory that
received it. For example, if you create a shipping file, it may be assigned the
number 153 at your laboratory. When the receiving laboratory receives the
shipping data file, it will be assigned the next available shipment number at
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their laboratory, which will probably be different from the shipment number at
your laboratory.

For this reason, shipment numbers cannot be directly matched to shipments
between laboratories. Instead, you would need to use the shipment setup
date and other information to match a shipment that you sent to the same
shipment received at another laboratory.

New shipments
New shipments are created on the Pending Shipments page

The Pending Shipments page shows all data shipments that have been
created but not yet sent. This page serves the following purposes:

1. Create new shipments
2. View or modify shipments that have been created but not yet sent.
3. “Ship” a shipment.

Figure 40: The Pending Shipments page

The term “ship” in LDMS means that all of the specimens you want added
to a shipment have been added and it is ready to be sent. When you ship
a shipment, you will be prompted to save a shipping data file—this file is
the shipment. In addition to sending a physical package of specimens to the
receiving laboratory, you will need to provide the laboratory with the shipping
data file. This is most commonly done using email, but you could also put
the file on a disc or re-writable USB drive and include it with the physical
shipment.

Creating new shipments
Creating a shipment means defining which specimens will be sent and where
they are going to be sent.

Prerequisites

• The specimens must have already been entered into LDMS
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• If you want to ship a storage container with specimens, you must have
already assigned the specimens to the container in LDMS.

Background

Note:  You can save an incomplete shipment (such as leaving the
destination blank), however you will need to complete the shipment
before it can be sent.

Steps

1. Click Shipping > Pending Shipments from the LDMS menu bar.
The Pending Shipments page will open.

2. From the LDMS action menu, click Create Shipment.
The Pending Shipment Preview window will open.

3. Complete the information on the General tab.

All information on this tab is required.

shipment date This is the date that the physical shipment was (if
it was already shipped) or will be shipped. If you do
not know when you will be shipping the specimens,
select an approximate date—it can be changed
before the shipping file is generated.

format This is the type of shipping file you are creating.
Unless the destination does not use LDMS, select
LDMS.

temperature This will be the method of temperature control for
the specimens during transport.

4. Complete the information on the Shipping Destination tab.
Existing laboratories that are using LDMS and LDMS are already
available for selection. The contact information for these laboratories
is maintained by Frontier Science.
4.1. Select either Contact, Lab Number, or Lab Name.

This is how you will select the laboratory. Contact is the
shipping contact person on file for the laboratory. Lab Number
is the laboratory’s LDMS ID. Lab Name will show each
laboratory in alphabetical order.

4.2. Select a laboratory from the drop-down box below.
If you selected Contact or Lab Name, the number in
parenthesis next to each laboratory’s name is the laboratory’s
LDMS ID number.

4.3. Select or enter the person to receive the shipment at the
receiving laboratory from the Contact Person box.

Laboratories can be added to LDMS. These will only appear as
available for selection by your laboratory. Since all laboratories that
use LDMS and LDMS are already listed, the new laboratory is assumed
to be using some other laboratory management system.
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4.1. Select New lab.
4.2. Complete all the boxes in the Shipping Destination and

Contact Information sections.
4.3. Optional: If you want to save this laboratory for future use,

select the Save address box.
5. Complete the information on the Contact at sending lab tab.

This is where you enter the information for the person at your
laboratory who should be contacted if there is an issue with the
shipment.

6. Optional: Complete the information on the Shipment notes tab.

The Comment and Disclaimer will appear on the shipping manifest
and will be shown to the receiving laboratory when they load the
shipping file. These comments are in addition to comments that were
entered for individual specimens. Use the Comment box for general
information about the shipment. The Disclaimer box can be used to
provide information about the restrictions placed on the specimens’
usage.

The Shipment Carrier and Tracking Number will not appear on the
shipping manifest and are not included in the shipping file.

7. Add specimens to the shipment on the Shipment Contents tab.

• Add a container already setup on the Storage page to the
shipment from the Storage Containers list.

• Add specimens to a single use shipping container in the Shipping
Containers section.

8. Add storage containers to the shipment.
8.1. Click the Add New button to the right of the Storage

Containers list.
The Storage Containers window will open.

8.2. For each storage item to be shipped, select the check box next
to it.

8.3. Click Add Selected to Shipment.
9. Add individual specimens to the shipment.

9.1. Click the Add New button to the right of Shipping Containers.
The Create Shipping Container window will open.

9.2. Enter the number of rows and columns for the container into the
Number of rows and Number of columns boxes.
This represents the size and capacity of the container. For
example, a container with 8 columns and 5 rows could hold up to
40 specimens. The container as it is currently defined will appear
in the Preview section.

9.3. Select or deselect the Positions only option as desired.
If the positions only option is selected, each specimen in the
shipping container will be identified by a number. If it is not
selected, each specimen will be identified by its coordinates.
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9.4. (If Positions only is not selected) Define how specimens in the
container should be organized.

coordinate
order

This is how the specimens position will be
identified, such as (8,5) or (5,8).

column
labeling and
row labeling

This is how rows and columns will be named
in the container. Alphabetic uses letters while
numeric uses numbers. The second option
specifies where labeling should start.

9.5. Select the fill order for the shipping container from the Fill
order box.
The fill order is the logic that is used to determine where
specimens will be placed in the container.

9.6. Select the sort order for the container from the Primary Sort
Order box.
This is how specimens will be sorted before they are put into the
container.

9.7. (If Prot/ID2 was selected for primary sort order) Select a
Secondary Sort Order.

9.8. Click the Add Specimens button.
9.9. Do one of the following:

• In the list of specimens, select the check box next to each
specimen to be shipped. Use the available filters to find the
specimens you need.

Or:

• Click the Upload File: Unique specimen IDs button to
upload a file of samples to be included in the shipment.

9.10.In the list of specimens, select the check box next to each
specimen to be shipped.
Use the available filters to find the specimens you need.

9.11.At the bottom of the Select Specimens to Ship window, click
Continue.
The Preview section for the shipping contain will indicate the
positions that now hold specimens. If you added more specimens
than could fit in the container, multiple containers will have been
created. You can switch between these containers using the
arrow buttons in the Preview section.

9.12.Click the Add button.
The shipping container will appear in the Shipping boxes list.

10. Do one of the following:

• To save the shipment so that it can be modified again before the
shipping file is generated, click the Save button.

• To generate the shipping file now and change the shipment status
to shipped, click the Ship button.
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Result
If the shipment was saved, a new shipment will be added to the Pending
Shipments page. It will appear at the top of the list and will have been
assigned the next available shipment number.

After you are finished
You should perform QA/QC on the shipment after it has been created before
sending it.

Sending a pending shipment
Sending a shipment is the process of generating a shipping data file on the
Pending Shipments page.

Background

The shipping file can either be in LDMS format or CSV format. The file that is
created will need to be transferred to the laboratory to add the specimens to
their database.

Steps

1. Click Shipping > Pending Shipments from the LDMS menu bar.
2. Locate the pending shipment to be sent.
3. Click the Edit/Ship button to the right of the shipment.

The Pending Shipment Preview window will open.
4. Click the Ship button.

LDMS will warn you that this is your last chance to generate the
Shipment Storage Report. If you want to view this report, click the
Cancel button. On the Shipment Contents tab, click the Shipment
Storage Report button to generate the report.

LDMS will check that the information for the shipment has been fully
completed. If there are any issues, it will be highlighted in red and you
will be prompted to correct it before continuing.

5. When asked to confirm if you want to send the shipment, click the OK
button.

The shipping file will be generated. When it is ready, you will be
prompted to save it to your computer.

! Warning:  Do not close the window until the shipping file has
been saved.

Note:  If there is an error in the shipment information, it can be
corrected directly from the Validation Error page.

6. Click the Close button to go back to the Pending Shipments page.
7. Optional: Generate a shipping manifest.

7.1. Click Shipping > Shipment History from the LDMS menu bar.
7.2. Locate the shipment that you sent.
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7.3. Click the arrow next to the View button, and then click
Generate Manifest.
Figure 41: Generate Manifest

Result
The shipping file is now saved at the location you specified on your computer.

After you are finished
This is the file you will need to transfer to the laboratory that will be receiving
the specimens. You can either email this file to the receiving laboratory
or provide it on removable media (such as a USB drive) with the physical
shipment of specimens.

Generating a shipping manifest
Shipping manifests contain an overview of the contents of a shipment, and
are intended to be printed and included with shipments.

Background

A shipping manifest should be printed and included with all shipments. This
will help the laboratory receiving the shipment to identify its contents and
match it to the shipping file that you provided to them. You can also save the
manifest as a PDF file, and then send it to the receiving laboratory long with
the shipping file.

The shipping manifest can be generated before or after a shipment is sent.
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Figure 42: A typical shipping manifest

(1) The shipment number, (2) The date that the shipment was initially created, (3) Sending laboratory’s contact

information, (4) Shipment carrier and tracking information (5) Receiving laboratory’s contact information, (6) Name of

shipping container, (7) Specimens in the shipping container

Steps

1. Do one of the following:

• For pending shipments, click Shipping > Pending Shipments
from the menu bar.

• For sent shipments, click Shipping > Shipment History from the
menu bar.

2. Locate the shipment for which you want to generate a manifest.
3. Click the arrow next to the View button to the right of the shipment,

and then click Generate Manifest.
4. Select PDF from the File type box.

Because manifests are intended to be printed, they have been
designed with PDF output in mind only. If you select a different file
format for the manifest, you may experience formatting issues.

Result
You will be prompted to save the manifest or it may open automatically,
depending on the default behavior of your web browser.
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Shipment Tracking Information
Information about a shipping carrier and the tracking number can be entered
into LDMS at any point by both a sending a receiving laboratory.

The Shipping Carrier and Tracking Number are on the Shipment Notes
tab when viewing a shipment. This information can be updated at any time for
any shipment, including shipments that have already been sent or received by
your laboratory.

Shipment tracking information will not appear on printed shipping manifests
and will not be included in shipping files.

Supported shipping file formats
These are the file formats that are supported for sending and receiving
shipping files.

Table 14: Supported shipping file formats

Format Encrypted? Intended destination

LDMS Yes Laboratories using LDMS (both
web and windows version)

CSV No Laboratories not using LDMS

SeraCare No Specimens being sent to
the Precision Bioscience
Repository

Cross-LIMS Manifest No Laboratories not using LDMS

CSV shipping files
LDMS can generate and accept CSV (comma separated value) shipping files
that meet these requirements.

• The file must be a comma delimited text file with the .csv file extension.
• The first line in the file must be a header row.
• The file must contain, at minimum, all required columns (in any order) to

be processed by LDMS.
• When a CSV shipping file is generated by LDMS, all columns listed in the

following table will be included.

Note:  Field headers in the file are not case-sensitive.

Column
Label

Example
Value

Column
Required
in File

Must be
Defined in
File

Notes

Shipment
Number

145 No No ID number for the shipment.

Sending Lab 500 Yes Yes ID number for the laboratory sending
the shipping file.
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Column
Label

Example
Value

Column
Required
in File

Must be
Defined in
File

Notes

Receiving
Lab

143 No No ID number for the laboratory receiving
the shipping file.

Setup Date 05/
Jan/2016

No No Date shipping file was created. Must be
in the format dd/Mmm/YYYY.

Ship Date 05/
Jan/2016

No No Date specimens were shipped. Must be
in the format dd/Mmm/YYYY.

Temperature Dry Ice No No Temperature of the shipment.

Shipment
Comment

This is a
comment

No No Notes about the shipment.

Container Box #1-1 No No Name of container holding specimen.

Row 1 No No Position of specimen in container. Alpha
and numeric coordinates are allowed.

Column 1 No No Position of specimen in container. Alpha
and numeric coordinates are allowed.

QA
Performed

-- No No Whether shipping file was compared
to the actual shipment to ensure
specimens were correct and included in
the correct container locations.

project FRONTIER Yes Yes Name of project for which the specimen
was collected.

ID1 0111111C Yes Yes Participant or specimen source ID.

ID2 F5309 Yes Yes Protocol ID.

ID3 -- Yes No Sub-protocol ID.

Visit 1 Yes No Visit value.

Visit Unit WK Yes No Unit for visit. Must be a valid LDMS visit
unit code.

Clinic 701 Yes No Clinical site where specimen was
collected.

Specimen
Date

05/
Jan/2016

Yes Yes Collection date. Must be in the format
dd/Mmm/YYYY.

Specimen
Time

15:20 Yes No Collection time. Must be in 24-hour
format.

Received
Date

05/
Jan/2016

Yes Yes Date specimen was received by
laboratory. Must be in the format dd/
Mmm/YYYY.

Received
Time

15:20 No No 24-hour time specimen was received by
laboratory. Must be in 24-hour format.

Specimen
ID

500V05000012No No Specimen ID (used for specimens
entered in LDMS for Windows only).

Global Spec
ID

CEQ0000P-03No No If not specified, a global specimen ID
will be generated automatically when
the shipping file is received in LDMS.
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Column
Label

Example
Value

Column
Required
in File

Must be
Defined in
File

Notes

Other Spec
ID

-- No No Other specimen ID.

Primary BLD Yes Yes Specimen primary type. Must be a valid
LDMS primary code.

Additive EDT Yes Yes Specimen additive. Must be a valid
LDMS additive code.

Derivative PL2 Yes No Specimen derivative. Must be a valid
LDMS derivative.

Sub A/D N/A No No Specimen sub-additive/derivative. Must
be a valid LDMS sub-additive/derivative
code. If not specified, will default to N/
A.

Volume 1.5 Yes Yes Volume of specimen

Volume
Units

ML Yes Yes Units used for specimen volume.

Condition SAT No No Three letter code representing
specimen’s current condition. If not
specified, will default to SAT.

Comments This is a
comment

No No Notes about the specimen

Tests -- No No Assays assigned to the specimen

Processing
Date

05/
Jan/2016

No No

Processing
Time

15:20 No No

Frozen Date 05/
Jan/2016

No No

Frozen Time 15:20 No No

Total Cell
Count

No No

Processing
Tech

No No

Second
condition
code

No No

Freezer No No

Level 1 No No

Level 2 No No

Harvest
Date

05/
Jan/2016

No No

Additional
Time

15:20 No No
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Column
Label

Example
Value

Column
Required
in File

Must be
Defined in
File

Notes

Additional
Time Unit

No No

Thaw Count No No

Internal
comments

This is a
comment

No No Import this field if it's in the file, but do
NOT ship it out from WebLDMS

Reason not
collected

No No

Primary
Database ID

12345 No No Primary Specimen's Database ID
value. Must be sourced from a primary
specimen that already exists in the
database. Setting this value will ensure
new aliquots are organized under the
specified primary specimen provided
other dependent values are properly
matched. Value can be determined
from Custom Report Builder or from the
primary's Edit Primary Specimen popup
URL in Specimen Management.

Cross-LIMS shipping files
LDMS can generate and accept cross-LIMS shipping files that meet these
requirements.

• The file must be a tab delimited text file with the .txt file extension.
• The first line in the file must be a header row.
• The file must contain, at minimum, all required columns (in any order) to

be processed by LDMS.
• When a cross-LIMS shipping file is generated by LDMS, all columns listed in

the following table will be included.
• If additional columns are present in a cross-LIMS file, those columns will be

ignored.
• Cross-LIMS shipping import sets the clinic value for VTN records based on

the PID. This allows LDMS labs to receive cross-LIMS shipments of VTN
samples if needed.

Column Label Example Value Required Notes

SHIP_ID 0500-0999-0000000147Yes In the format
[Sending_Lab_ID]-Receiving_Lab_ID]-[Shipment_Number];
leading zeros must be
added to make the ID
the correct length (for
example 500-19-147
is not valid, but
0500-0019-0000000147
is valid)

SHIP_DATE 06-Jan-16 No Date shipped. Date
must be in the format
dd-Mmm-yy
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Column Label Example Value Required Notes

RECIPIENT 999 Yes Receiving laboratory's
ID

SHIPPED_FROM 500 Yes Sending laboratory's
ID

GLOBAL_ID GEQ00017-03 No A valid LDMS global
specimen ID

project FRONTIER Yes The project for which
the specimen was
collected.

PROTOCOL F5309 Yes The protocol (ID2) for
which the specimen
was collected

PID 0777777F Yes The participant
identifier (ID1)

VID 7 Yes The visit value

VID_UNIT Day Yes The visit unit. Must
be a valid LDMS visit
code

COLL_DT_TM 17-Jan-05 09:12 Yes Collection date and
time, in the format
dd-Mmm-yy HH:mm,
using 24-hour clock

PRIM BLD Yes Primary type. Must be
a valid LDMS primary
code.

DER PL2 Yes Derivative type. Must
be a valid LDMS
derivative code.

SUBDER N/A Yes Sub-additive/
derivative type. Must
be a valid LDMS sub-
additive/derivative
code.

ADD EDT Yes Additive type. Must be
a valid LDMS additive
code

QTY 1 Yes Volume of the
specimen collected.

QTY_UNIT ML Yes Volume unit. Must be
a valid LDMS volume
unit code.

CONDITION SAT No Condition of the
specimen. Must be a
valid LDMS condition
code.
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Column Label Example Value Required Notes

OTHERSPECID VTN No Other Specimen
ID. Must be alpha/
numeric with a max
field length of 17
characters.

TIME 0.00 No Must include the
Additional Time.
Format must be
numeric/decimal
with precision to two
decimals.

TIMEUNIT HRS, TR, or RAN No Must include
Additional Time Unit
Abbreviation. The
field must be three
characters long.

COMMENT This is a comment No A comment about the
specimen.

BOX #1-1 No Name of shipping
container

ROW 1 No Row in shipping
container (from top-
to-bottom)

COL 1 No Column in shipping
container (from left-
to-right)

SeraCare shipping files.
LDMS can generate (but not receive) “SeraCare” shipping files that meet
these requirements.

Column Label Example Value Notes

Global Spec ID 0777-001MWK00-286--

project FRONTIER The project for which the specimen was collected.

PID 0111111C Participant ID (ID1)

VID 8 Visit value.

VID Unit Vst Visit unit.

Collection Date 1-Mar-13 Collection date

Collection Time 1:00 Collection time.

Prim BLD Primary type.

Der BLD Derivative type.

Add ACD Additive type.

Other Spec ID PLORQ --

Volume 1 --

Volume Unit ML --
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Column Label Example Value Notes

Custom Local ID -- --

Box BOX 2 Name of shipping container.

Row,Col 1,1 Position in shipping container.

Condition SAT --

Comment This is a
comment

--

Protocol F5308 The protocol (ID2) for which the specimen was collected.

Sub/Der N/A Sub-additive/derivative type.

Shipping container report
This report shows a visual map of each container’s contents, along with the
details for each specimen being shipped.

The shipping container report can be generated while you are creating a
shipment or after a shipment has been sent.

The shipping container report can be found on either the Pending
Shipments or Shipment History page. To the right of the shipment, click
the down arrow next to the button and click Shipping Container Report.

There is a key in the top-right corner of the report that shows what
information is within each box. Each box on the report corresponds to one
location in the container. Locations that are marked with a large X indicate
locations in the container that are empty.

Figure 43: The Shipping Container Report
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Shipment storage report
This report lists the specimens in a shipment and their assigned storage
location.

This report is intended to be printed and be used to help locate and pull
specimens from storage. This would only be applicable if you assigned a
storage location to the specimens being shipped on the Storage page.

You can generate the Shipment Storage Report when generating a shipping
file. After a shipping file has been created, you can access the report from the
Shipment History page by clicking the drop-down next to the View button
for the shipment and selecting Shipment Storage Report.

Information displayed on report

• Shipment number
• Shipment setup date
• Specimen ID
• Global specimen ID
• Other specimen ID
• project/ID2
• ID1
• Visit
• Collection date
• Collection time
• Primary
• Additive
• Derivative
• Sub additive/derivative
• Volume
• Storage location
• Original storage location

Receiving shipments
Receiving a shipment is the process of importing specimen information from
laboratory into your laboratory.

Background

Once you have the shipping file from the laboratory sending you the
specimens, you can import the specimen information into LDMS.

Steps

1. From the menu bar, click Shipping > Receive Shipments.
2. Click Select File.
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A window will open to select the shipping file. The shipping file will
generally be named ship-[your laboratory ID number].xml for
LDMS shipping files or lab[your laboratory ID number].csv for
CSV files.

Note:  Supported ID formats include Specimen IDs, Other Spec
IDs, Global Spec IDs, and Database IDs.

3. Optional: If you want specimens to automatically be assigned storage
locations, select Import directly into storage.

4. Optional: To apply RPID to the specimens being imported, select
Import as RPID. This will anonymize the imported specimen data.
This feature is disabled by default and must be activated by LDMS
User Support, and the feature can only be applied to specimens for
the ACTG or IMPAACT projects.

5. Click Preview Shipment.
6. On the Confirm Temperature list, select the temperature of the

shipment as you received it.
7. Optional: Click the Edit Condition Codes button to update

information of specimens on the shipping file before receiving the
shipment.
7.1. After clicking the Edit Condition Codes button, the Set

Condition Codes window will open.
7.2. Select specimen(s) from the table.
7.3. Apply condition codes, set as unavailable, or add comments as

needed.
7.4. Click Update Selected Specimens.
7.5. When finished, click Save.

8. Review the shipment to ensure it is correct.
It is a good idea to check that the shipping destination is your
laboratory, and that the specimens are what you were expecting. Click
the View button next to shipment containers to see what specimens
are in the shipment. By checking the shipment at this stage, you can
avoid potential errors, such as receiving the wrong shipping file.

9. Click Receive Shipment.

Note:  If the shipping temperature you indicated differs from
the temperature indicated in the shipping file, you will be asked
if you want to override the shipping temperature. This means
the temperature you selected will be saved in your database
instead of the temperature from the sending laboratory.

Result
LDMS will assign the next available shipment number to the shipment.

After you are finished
Go to the Shipment History page to view the newly received shipment and
perform additional actions, such as QA/QC.
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Shipping and projects
During shipping import, users will be notified if the file contains a new project
that does not exist in their database. If the new project is not expected, the
import can be cancelled.

Import as is
When receiving a shipping file, it is possible to take shipping and storage
items in the shipment and automatically assign them to your laboratory’s
storage. The option to do this is provided when receiving a shipping file.

The items on the shipment will be placed in your storage based on what it is.

Item Where it will go in storage

Storage unit Added as a new storage unit

Level or container In the SHIPPING IMPORT FREEZER, on a
level with the shipment number

If the item was a storage item at the sending laboratory, it will retain its
original name in your storage. If the item was a storage contain created
for the shipment, it will be placed in the SHIPPING IMPORT FREEZER
on a level with the shipment number. These containers will generally have
names like “Auto-generated box #76-1” in your storage. The shelf name also
includes the sending lab ID.

Once the items are added to your storage, you are not restricted to how you
use them. You can retain containers, move them to different storage units,
and so forth.

Handling non-LDMS shipping files
Shipping files that did not originate from LDMS may not contain the global
specimen ID needed by LDMS. Such specimens will receive special handling
when they are received.

• All specimens without a global specimen ID will be treated like aliquot
specimens and assigned to a new primary specimen.

• All specimens without a global specimen ID will be assigned one
• Specimens with the same project, ID1, ID2, visit, collection date, collection

time, primary type, and additive time will be grouped until the same
primary specimen.

Shipment QA/QC
Shipment QA/QC is the process of comparing actual specimens in a shipping
container to the specimen that is expected in that container position by LDMS.
This should be done for shipments before they are sent and after they are
received.

You can view the current QA/QC status of a shipment on the Pending
Shipments or Shipment History page.
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QA/QC Status Action Needed

Complete None

In Progress Finish QA/QC

Complete with Errors Investigate the specimens that did not pass
QA/QC

Not Performed Start QA/QC

To perform QA/QC, you need to look at the global specimen ID on a physical
specimen, and then compare it to the global specimen ID in LDMS. If they
match, the specimen has passed, otherwise it has failed. QA/QC should be
performed by scanning the specimen’s barcode, which will read the global
specimen ID and do the comparison for you. This is the recommended
process. If you do not have a barcode scanner, you can manually compare the
two global specimen IDs instead.
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Figure 44: The QA/QC Entry page

(1) Containers in the shipment, (2) Currently selected specimen, (3) Manually pass or fail selected specimen, (4)

Currently selected specimen’s global specimen ID, (5) Modifiable boxes, (6) Indicator showing that you can scan a

barcode to complete shipment QA/QC automatically, (7) Print the current label

If the shipment contains multiple containers, you will need to change
containers during QA/QC, since each container must be reviewed separately.

While performing QA/QC, you have the option to modify each specimen’s
other specimen ID and comments. If you do so, these changes will be
reflected in the specimen information on the Specimen Management page.

Performing QA/QC
QA/QC is performed by scanning or comparing each specimen's label with the
expected specimen information, and indicating if it is correct or incorrect.
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Background

QA/QC should be performed after creating a pending shipment but before
creating the shipping file. It should also be performed on shipments from
other laboratories after they have been received.

Steps

1. Do one of the following:

• To QA/QC a pending shipment, on the navigation menu, hover over
Shipping, and then click Pending Shipments.

• To QA/QC a pending shipment, on the navigation menu, hover over
Shipping, and then click Shipment History.

2. On the Edit/Ship (for pending) or View (for received) menu in the
right column, click QA/QC.

3. Optional: Enter the initials of the person that performed QA/QC and
the date that it was completed in the Performed By and Date boxes.

4. With the first specimen select (which is the default), do one of the
following:

• Scan the specimen barcode (recommended). After scanning the
barcode, one of two sounds will play, depending on whether the
sample passes or fails.

Note:  Users can QA/QC shipments by scanning non-LDMS
generated barcodes. The value in the scanned barcode must
match to the value set in Other Specimen ID or ID1/PID field
for QA to pass.

• Manually compare the global specimen ID on the screen with the
global specimen ID on the specimen label. If they match, click Pass
Specimen, otherwise click Fail Specimen.

5. (If there are multiple shipment containers) After each specimen in the
container has been reviewed, select the next item from the Select a
Container list.

6. After all specimens in the shipment have been reviewed, click Save at
the bottom of the page.

After you are finished

Confirm that QA/QC has been completed for the shipment by looking at the
QA/QC column on the Pending Shipments or Received Shipments page.

Shipment history
A record of shipments sent and received can be found on the Shipment
History page.

In terms of LDMS, a shipment received is one for which you have uploaded
a shipping data file from another laboratory in LDMS, and a shipment sent is
when you have generated the shipping data file.
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Figure 45: The Shipment History page

Shipment
number

An internal shipment number assigned to the shipment
at your laboratory

Shipment type Indicates whether the shipment was sent to another
laboratory or received from another laboratory

Shipment
format

The type of shipping file

Destination
laboratory

The laboratory ID of the destination that is indicated
within the shipping file

Sending
laboratory

The laboratory that generated the shipping file.

Sending lab
shipment
number

Original shipment number assigned by lab that sent
shipment

Shipment
temperature

The shipment temperature that was indicated in the
shipping file

Setup date The date the shipping file was created

Shipment date The date that the shipping file was generated

Received date The date that your laboratory loaded the shipping file in
LDMS (only applicable to shipments that you received)

QA/QC This indicates whether or not QA/QC was performed on
the shipping file

Shipment
Evaluation

This Indicates whether or not a Shipment Evaluation has
been performed for the shipment

Removing a received shipment

Background

If a shipping file was received and loaded into LDMS in error, it may need to
be removed. Because multiple laboratories may be affected and the quality of
specimen data affected, the ability to unload a shipping file that was received
requires you to contact LDMS User Support.
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Steps

1. Contact LDMS User Support.
This should be done first because if your session is idle for too long
and you are logged out, a new challenge code will be generated.

2. In the menu bar, click Shipping > Shipment History.
3. On the View button to the right of the shipment, click the arrow and

select Unimport.
4. Provide LDMS User Support with the Challenge Code.
5. In the Response Code box, enter the code provided LDMS User

Support.
6. Click Unimport.

Un-sending shipments
After a shipping file has been generated and a shipment changed to sent in
LDMS, it is possible to change the shipment back to a pending state.

Background

This would be necessary if you need to modify the shipment and re-generate
the shipping file. This could happen, for example, if you discovered there were
more specimens to be shipped and the shipment hasn’t left your laboratory
yet.

! CAUTION:  A shipment should not be un-sent if the receiving
laboratory has received and loaded the shipping file. Doing so would
cause the specimens to appear at both laboratories. Contact the
receiving laboratory and ensure that have not yet loaded the shipping
file before continuing.

Steps

1. In the menu bar, click Shipping > Shipment History.
2. On the View button to the right of the shipment, click the arrow and

select Unship.
3. Click Unship.

Re-downloading the shipping file of a sent shipment
It is possible to re-download the shipping file of a previously sent shipment.

Background

When you send a pending shipment, you will be prompted to download the
shipping file that you will need to supply to the receiving laboratory. If this file
becomes lost or damaged, it is possible to download it again. This file will be
identical to the shipping file that was previously downloaded.

Steps

1. In the menu bar, click Shipping > Shipment History.
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2. On the View button to the right of the shipment, click the arrow and
select Download shipping file.

3. When prompted, save the shipping file.

Bulk Updating Condition Code and Comments of
Shipments
Users have the ability to bulk update the Condition Code and Comments for
all specimens in a shipment. This is accessed through the Shipping menu.

Background

Steps

1. From the menu bar, click Shipping, and then click Shipment
History.

2. Find the shipment that needs updating and click the arrow next to
View.

3. From the dropdown menu, click Set Condition Code. The Set
Condition Code window will appear.

4. In the new window, select the specimen condition from the dropdown
menu.

5. Add any comments or mark as unavailable as needed.
6. Click Save.
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Shipment Evaluations
Users can create new shipment evaluations for received shipments and
update existing ones.

Figure 46: Create Shipment Evaluation Screen

(1) Add or update the sending lab batch number, (2) indicate whether the shipment had any reportable problems, (3)

add any comments, (4)* select a problem code from a dropdown, (5)* add more dropdowns for additional problem

codes, (6)* remove a listed problem code, (7)* Associate comments and ID2s to individual problem codes, (8)*

indicate whether the shipment is considered resolved, (9) upload a shipment evaluation form, (10) create the shipment

evaluation

*Only available if user selects Yes for the question Did the received shipment have any reportable problems?

Creating a New Shipment Evaluation

1. From the LDMS menu, navigate to Shipping, then select Shipment
History.

2. In the dropdown menu of a received shipment, select Add New
Shipment Evaluation.

3. On the Create Shipment Evaluation screen, indicate whether the
received shipment had any reportable problems, and enter a comment and
attach an evaluation form as needed.
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4. If the user indicates that the shipment did have reportable problems,
at least one problem code must be added. The user may also indicate
whether the shipment is considered resolved.

5. Click Create to create the evaluation.

Editing an Existing Shipment Evaluation
Users may edit or delete a shipment evaluation or evaluation form as needed.

• To update an existing Shipment Evaluation form, click Edit Shipment
Evaluation in the dropdown next to a received shipment. Make changes as
needed and then click Edit.

• To delete an existing Shipment Evaluation form, click Delete Shipment
Evaluation in the dropdown next to a received shipment. In the bottom of
the Delete Shipment Evaluation window, click Delete.

Reports
The Reports page is where you can retrieve data that is stored in your
laboratory’s LDMS database.

While you can browse specimen information for individual participant visits
on the Specimen Management page, you can’t control what is displayed
and how. For example, suppose you need a list of participant identifiers for all
participants at your laboratory, and what project those participants belong to.
You can’t quickly get this information from the Specimen Management page.

This is where reports are helpful. The Reports page allows you to generate
pre-defined reports about data in your laboratory’s LDMS database. While the
content of these reports are predetermined, you can often add criteria to filter
what will be displayed. For example, you could generate a report that lets you
see all participant identifiers at your laboratory, but only for a specific project.

Custom Report Builder
The Custom Report Builder allows you to export specimen data from LDMS
into a wide variety of formats.

The custom report builder allows you to do the following:

• specify what data to use to select specimens to appear on the report
• the information to appear on the report
• how to sort information on the report
• apply complex logic to reports
• save custom reports so they can be re-used
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Figure 47: The Custom Report Builder

Creating a custom report
Custom reports are created by indicating the information that should appear
on the report, how the report should be sorted, and any special logic for
selecting specimens.

Steps

1. From the menu bar, click Reports > Custom Report Builder.
2. In the All Fields section, do the following:

• For items that you want to appear on the report, select the check
box under Display.

• For items that you want to use to sort records on the report, select
the check box under Sort.

3. Optional: Use the Add COUNT Field button to provide aggregate
counts on the report.
3.1. Click the Add COUNT Field button in the All Fields section. The

Add COUNT Field window will open.
3.2. Select the field, enter the label, and mark as distinct as needed.
3.3. Click OK.

4. In the Fields to display and Sort results by section, use the Up and
Down buttons to set the order of items.
Fields displayed on the report will be shown from left-to-right in the
order you specify. Results will be sorted in the order specified. An item
can be removed by clicking the X next to it or deselecting the check
box.
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Example
If you sort by Destination Lab ID and Ship Date, the records on the
report will first be sorted by the destination laboratory, and then by
the shipment date.

5. Optional: To remove duplicate records, under Fields to display,
select Distinct.
Any rows on the report that have the same values across all displayed
fields will only appear on the report once.

6. Optional: Apply a filter to your report in the Selection criteria
section.
If no selection criteria is specified, all data from your laboratory will be
included.
6.1. In the All Fields section, click an item to select it.
6.2. In the Selection criteria section, select an operator and value

for your filter.
6.3. Click Add.
6.4. In the box below the filters, enter logic for applying the filter

using the numbers next to each item.
If you leave this box blank, filters will be applied as 1 AND 2
AND ... (etc.).

Example
For example, if you want to apply filter #1 and either filters #2
or #3, enter 1 AND (2 OR 3).

Example
To apply a filter that excludes specimens that originated from
laboratory 500, select Source Lab ID in the All Fields section, the
<> operator, and enter 500.

Note:  LDMS accepts wildcard values (*). Wildcard values can
be used for the Like and Not Like qualifiers.

7. In the File Type list, select the format for your report output.
8. Optional: If you do not want a header row with the name of each

column to appear on your report, deselect Include Headers.
9. Do one of the follow:

• To save your report so that it can be run later, enter a name for
your report into the Saved Queries box at the top of the page,
and then click Save.

• To view the first 100 records of the report in your browser, click
Preview.

• To generate and save the report in the indicated file type, click
Generate Report.

Running a saved report
Saved custom report can be run at any time.
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Steps

1. From the menu bar, click Reports > Custom Report Builder.
2. In the Saved Queries box, select the report you want to run.
3. Optional: Make any changes needed to the report’s fields, sort order,

or selection criteria.
Changes will not be permanently saved unless you click Save at the
top of the page.

4. Do one of the following:

• To view the first 100 records of the report in your browser, click
Preview.

• To generate and save the report in the indicated file type, click
Generate Report.

Modifying or deleting a saved report
A saved custom report can be modified and re-saved or deleted.

Steps

1. From the menu bar, click Reports > Custom Report Builder.
2. In the Saved Queries box, select the report you want to run.
3. Do one of the following:

• To remove the saved report, click the Delete button.
• To modify the report, make changes to its fields, sort order, or

selection criteria, and then click Save.
• To modify the report and save it as a new report, enter a new name

into the Saved Queries box, and then click Save.

Example custom report
This is an example of a custom report for tracking specimens on shipments
that have not been sent.

This report will find all specimens in your laboratory’s database that are part
of a shipment and are still available. It filters by specimens that are available
and have a shipment setup date (all specimens with a shipment setup date
will meet the “before 30/Sep/2099” criteria, since that date is in the future).
This report would be useful for identifying specimens that you are expected to
ship but still have in your possession.

Fields to display • Global specimen ID
• Batch number
• QA/QC status
• Shipment setup date
• Destination laboratory ID

Sort results by • Destination laboratory ID
• Batch number
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Selection
criteria

• Available = Yes
• Destination laboratory ID <> Your_Laboratory_ID
• Shipment setup date < 30/Sep/2099

Generating a report
All reports are generated by following this procedures

Background

By default, any report is generated using all available data in laboratory’s
database. If you want to narrow down the records that will appear on a
report, you must apply filters. If more than one filter is applied, only records
that met all of the filters will appear on the report.

Figure 48: The Reports page

In this example, the report that will be generated will contain all BLD or ART specimens that also have a volume

greater than 10 mL. (1) Report categories, (2) Add criteria to table below, (3) Logic for generating report, (4) File

format for the report

Steps

1. On the LDMS menu bar, click Reports > Standard Reports.
2. In the Report categories box, select a broad category for the report

you want to generate.
3. In the Report box select a report.
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4. Optional: Add one or more filter to narrow down the information
displayed on the report.
4.1. Select a data item to filter by from the box below Filter

Criteria.
Additional boxes will appear to specify the details for the filter.

4.2. Select an operator from the middle box.

Note:  The <> operator means “not equal to”.

4.3. Select a value for the filter from the third box.
The values available will be dependent on the filter. For example,
if you are filtering by Additive, only valid additives in LDMS will
be displayed.

4.4. Click the Add button.
Your criteria will be added to the list of filters. If you want to
remove it after it has been added, click the Delete button to its
right.

5. Optional: Specify logic for the report in the box below the filter
criteria.
The logic is formed by using the numbers in the # column in the filter
criteria, along with the words AND, OR, or parenthesis.

6. Select a format for the report from the File Type box.
7. Click the Generate button.

Note:  If no filter criteria is entered, LDMS will alert the user
that the report may take a long time to generate.

Result
The report will be generated in the format that you specified. You may be
asked to open or download the report, depending on your web browser’s
default behavior.

Filter Reports Using a List of Specimens
You can use a list of identifiers to select a set of specimens.

The Specimen List feature is an available filter criteria on select reports. The
filter criteria allows users to select specific specimens for display using a list
of IDs. The file of identifiers must be a text file and must include one Global
Specimen ID per line.

Figure 49: Global ID List File Example
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Available report formats
This section describes the file formats in which LDMS can generate reports.

• If you are generating a report from the Exportable reports category, the
Microsoft Excel Workbook Data-only file type should be used.

• Reports in any category other than Exportable are designed for PDF.
• Use other file types for reports may result an unexpected formatting,

depending on the report. There may also be variations in the file type’s
format, depending on the specific report.

Table 15: File types for LDMS reports

File type ExtensionDescription Opened by...

Crystal Reports .rpt Do not use N/A

PDF .pdf A formatted report intended to be printed
on letter size paper (preferred)

A PDF viewer, such
as Adobe Reader

Character
separated values

.csv A text file with all information separated
by comma characters

A text editor, such
as Notepad

Microsoft Excel
(97-2003)

.xls A workbook for versions of Excel prior
to Excel 2007; this version contains a
header row for each column

Microsoft Excel or
LibreOffice Calc

Microsoft Excel
(97-2003) Data-
only

.xls Same as above, but usually without a
header row

Microsoft Excel or
LibreOffice Calc

Microsoft Excel
Workbook Data-
only

.xlsx A workbook that will work in Excel 2007
or later (preferred for exportable reports)

Microsoft Excel
2007 or later, or
LibreOffice Calc

Microsoft Word
(97-2003)

.doc A Word document with formatting, such
as tables and headers; can be difficult to
modify, depending on the report

Microsoft Word or
LibreOffice Writer

Microsoft Word
(97-2003) Editable

.rtf A rich-text file that can be edited
by many word processors; uses less
formatting, which makes it easier to
modify

Microsoft Wordpad

Rich Text Format .rtf Same as Microsoft Word (97-2003)
format, but compatible with RTF word
processors

Microsoft Wordpad

XML .xml A Crystal Reports XML file. The scheme
for this format is available

An advanced text
editor, such as
Notepad++

Tab-separated Text .ttx A text file with information separated by
tab characters.

A text editor, such
as Notepad
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Administrative reports

Anonymous Patients Map
Provides a list of all anonymized specimens with their anonymized ID1s
mapped to their source ID1s.

Filter criteria Information displayed on report

• Anonymized Date
• Anonymized ID1
• Original ID1

• Source ID1
• Anon ID1
• Source Specimen ID
• Source Global Specimen ID
• Anon Global Spec ID
• Source Specimen Date
• Anon Specimen Date

Transaction Log Report

On the Reports page, select Report Categories > Admin, then from the
Report dropdown, select Transaction Log Report.

You may add start and end date filters as well as any others as desired.

Filter criteria Information displayed on report

• End Date
• Global Spec ID
• Start Date
• Transaction Type
• User

• User
• Date/Time
• Table
• Transaction Type
• Old Data
• New Data
• LDMS Transaction ID

Figure 50: The Transaction Log Report
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User Event Report
Provides a report of user events, such as adding, updating, or deleting
information in LDMS.

Filter criteria Information displayed on report

• Event Date
• Event Type
• Login ID
• Module
• Transaction ID

• Login ID
• Event Date/Time
• Module
• Event Type
• Description
• Reason
• Item Name
• Item ID
• Min Transaction ID
• Max Transaction ID

User permissions report
Shows each user account associated with your LDMS laboratory, and the
user’s access to specific pages in LDMS.

Example
Figure 51: The User Permission Report

(1) The user’s name. (2) The user’s permissions by page. (3) Only present if the user has system administrator

privileges.

Barcode Reports

1D Barcodes Report
Displays a line listing of specimens along with a series of 1D barcodes. Each
specimen row will include a 1D barcode that encodes the specimens Global
Spec ID, ID1, and Other Spec ID. This reports can be printed and used to
scan groups of specimens into applications outside of LDMS that may use 1D
barcodes to input information such as Global Spec ID, ID1, or Other Spec ID.
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Filter criteria Information displayed on report

• ACTG PID
• ACTG Protocol
• Additive
• Clinic ID
• Derivative
• Global Spec ID
• Non ACTG PID/ID1
• Non ACTG PID/ID2
• Primary
• Project
• Received Date
• Run ID
• Shipment Number
• SID/ID3
• Specimen Date
• Visit Unit
• Visit Value

• Global Spec ID
• Project
• ID2
• Id1
• Collection Date
• Vid
• Vid Unit
• Other Spec ID
• Global Spec ID Barcode
• ID1 Barcode
• Other Spec ID Barcode

2D Barcodes Report
Displays a line listing of specimens along with a series of 2D barcodes. Each
specimen row will include a 2D barcode that encodes the specimens Global
Spec ID, ID1, and Other Spec ID. This reports can be printed and used to
scan groups of specimens into applications outside of LDMS that may use 2D
barcodes to input information such as Global Spec ID, ID1, or Other Spec ID.

Filter criteria Information displayed on report

• ACTG PID
• ACTG Protocol
• Additive
• Clinic ID
• Derivative
• Global Spec ID
• Non ACTG PID/ID1
• Non ACTG PID/ID2
• Primary
• Project
• Received Date
• Run ID
• Shipment Number
• SID/ID3
• Specimen Date
• Visit Unit
• Visit Value

• Global Spec ID
• Project
• ID2
• Id1
• Collection Date
• Vid
• Vid Unit
• Other Spec ID
• Global Spec ID Barcode
• ID1 Barcode
• Other Spec ID Barcode

Exportable reports
Exportable reports are designed to be generated for spreadsheet and CSV
formats so that the data can be manipulated manually.
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Abbott SARS-COV-2 Quant Export Report
Displays specimen details and results from Abbott SARS-COV-2 Quant runs in
the Test Results module.

Sorting Available filters Information on report

- • ACTG PID
• ACTG Protocol
• ACTG Protocol Type
• Additive
• Assay Date
• Clinic ID
• Derivative
• Global Spec ID
• Non ACTG PID/ID1
• Non ACTG Prot/ID2
• Other Specimen ID
• Primary
• Project
• Run ID
• SID/ID3
• Specimen Date
• Specimen ID

• Group
• Protocol
• PID
• Secondary ID
• Qualitative Result
• Quantitative Result (Log

copies/mL
• Dilution Factor
• Final Quantitative Result

(Log copies/mL
• m2000 Error Code/

description
• Primary
• Additive
• Derivative
• Sub Add/Der
• Visit
• Clinic
• Collection Date/Time
• Other Specimen ID
• Global Specimen ID
• Run ID
• Assay Date

Abbott SARS-COV-2 Quant Export Report with Comments
Displays specimen details and results from Abbott SARS-COV-2 Quant runs in
the Test Results module. Report includes Specimen comments for each result.

Sorting Available filters Information on report

- • ACTG PID
• ACTG Protocol
• ACTG Protocol Type
• Additive
• Assay Date
• Clinic ID
• Derivative
• Global Spec ID
• Non ACTG PID/ID1
• Non ACTG Prot/ID2
• Other Specimen ID
• Primary
• Project
• Run ID
• SID/ID3
• Specimen Date
• Specimen ID

• Group
• Protocol
• PID
• Secondary ID
• Qualitative Result
• Quantitative Result (Log

copies/mL
• Dilution Factor
• Final Quantitative Result

(Log copies/mL
• m2000 Error Code/

description
• Primary
• Additive
• Derivative
• Sub Add/Der
• Visit
• Clinic
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Sorting Available filters Information on report
• Collection Date/Time
• Other Specimen ID
• Global Specimen ID
• Run ID
• Assay Date
• Condition
• Comments

Abbott SARS-COV-2 Quant Export Report with Sample
Location
Displays specimen details and results from Abbott SARS-COV-2 Quant runs
in the Test Results module. Report includes specimen location field from the
Abbott result file.

Sorting Available filters Information on report

- • ACTG PID
• ACTG Protocol
• ACTG Protocol Type
• Additive
• Assay Date
• Clinic ID
• Derivative
• Global Spec ID
• Non ACTG PID/ID1
• Non ACTG Prot/ID2
• Other Specimen ID
• Primary
• Project
• Run ID
• SID/ID3
• Specimen Date
• Specimen ID

• Group
• Protocol
• PID
• Secondary ID
• Qualitative Result
• Quantitative Result (Log

copies/mL
• Dilution Factor
• Final Quantitative Result

(Log copies/mL
• m2000 Error Code/

description
• Primary
• Additive
• Derivative
• Sub Add/Der
• Visit
• Clinic
• Collection Date/Time
• Other Specimen ID
• Global Specimen ID
• Run ID
• Assay Date
• Sample Location

Aliquot count by primary report
Shows the number of aliquots processed from each primary specimen.

Sorting Filter criteria Information displayed on
report

This report is sorted by ID1
and ID2

• Additive
• Global spec ID
• Non ACTG PID/ID1
• Non ACTG Prot/ID2
• Other specimen ID

• Additive
• Global specimen ID
• ID1
• ID2
• Other specimen ID
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Sorting Filter criteria Information displayed on
report

• Primary
• project
• Specimen date
• Visit unit
• Visit value

• Primary
• project
• Specimen date
• Visit value and unit
• Primary volume
• Aliquot volume
• Number of aliquots

Aliquot Inventory Report
Provides a specimen listing with a custom set of header values as shown
below.

Sorting Available filters Information on report

- • ACTG PID

• ACTG Protocol
• Additive
• Clinic ID
• Derivative
• Global Spec ID
• Import Date
• Non ACTG PID/ID1
• Non ACTG Prot/ID2
• Other Specimen ID
• Primary
• Project
• Received Date
• Shipment Number
• Specimen Date
• Sub Add/Der
• Visit Unit
• Visit Value

• PID
• Collection Date
• Collection Date
• Collection Date
• Col time (hrs)
• Collection time (min)
• Visit Value
• Visit Unit
• Study name
• Global Specimen ID
• Primary Type
• Additive Type
• Derivative Type
• Sub add/der type
• Volume
• Volume Unit
• Primary Volume
• Vol Unit
• Processing Time
• Processing Month
• Processing Day
• Processing Year
• Frz date
• Frz time
• Cell Count
• Condition
• Is sample Available
• Is sample stored
• Stored month
• Stored Day
• Stored Year
• Storage temp
• Is sample shipped
• Sample Comments
• Storage Freezer
• Storage Rack
• Storage container
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Sorting Available filters Information on report
• Storage Box position

CFAR export report
Shows specimens stored at the laboratory.

Sorting Filter criteria Information displayed on
report

This report is sorted by
specimen ID

• project • Specimen ID
• project
• Global specimen ID
• ID2
• OPID
• Visit value and unit
• Primary
• Additive
• Derivative
• Sub additive/derivative
• Volume
• Volume unit
• Stored date
• Specimen date
• Storage location

CFAR storage report
Provides a summary of storage items at the laboratory.

Sorting Filter criteria Information displayed on
report

This report is sorted by
storage container and
specimen ID

• Import date
• project
• Received date
• Specimen date

• Container
• Specimen ID
• project
• ID2
• ID1
• Global specimen ID
• Visit
• Primary
• Additive
• Derivative
• Sub-additive/derivative
• Volume
• Specimen date
• Position

Database dump report
A general report that provides information from all specimens in a laboratory’s
LDMS database.
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Sorting Available filters Information on report

- • ACTG PID
• ACTG Protocol
• ACTG Protocol Type
• Additive
• Clinic ID
• Derivative
• Global Spec ID
• Non ACTG PID/ID1
• Non ACTG Prot/ID2
• Other Specimen ID
• Primary
• project
• Received Date
• Ship to Lab Number
• Specimen Date
• Specimen ID
• Sub Add/Der
• Visit Unit
• Visit Value
• Volume
• Volume Unit

• project
• PID/ID1
• Protocol/ID2
• SID/ID3
• Visit
• Visit Unit
• Clinic
• Rec Date
• Rec Time
• Collection Date
• Collection Time
• Import Date
• Spec ID
• Global Spec ID
• PRI
• ADD
• DER
• SUB
• VOL
• VOL Unit
• Cond
• Time
• Time Unit
• Other Spec ID
• Test
• Comments
• Ship Date
• Ship Batch Number
• Ship to Lab

Database dump report 2
A general report that provides information from all specimens in a laboratory’s
LDMS database.

Sorting Available filters Information on report

- • ACTG PID
• ACTG Protocol
• Additive
• Clinic ID
• Derivative
• Global Spec ID
• Import Date
• Non ACTG PID/ID1
• Non ACTG Prot/ID2
• Other Specimen ID
• Primary
• project
• Received Date
• Shipment Number
• Specimen Date
• Sub Add/Der

• LDMS laboratory ID
• Primary unique ID
• Aliquot unique ID
• project
• ID1
• Collection date (month,

day, and year)
• Received date (month, day,

and year)
• Collection time
• Visit (value and unit)
• ID2
• ID3
• Global specimen ID
• Specimen ID
• Other specimen ID
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Sorting Available filters Information on report
• Visit Unit
• Visit Value

• Primary code
• Additive code
• Derivative code
• Sub-additive/derivative

code
• Enrollment
• Aliquot volume (value and

unit)
• Primary volume (value and

unit)
• Processing time
• Processing date (month,

day, and year)
• Processing tech initials
• Frozen date (month, day,

year)
• Frozen time
• Total cell count
• Specimen condition
• Availability
• Additional time (value and

unit)
• Status (not stored and

available, stored, and
unavailable)

• Storage date (month, day,
year)

• Storage temperature
• Shipping status
• Destination laboratory
• Shipment number
• Shipment temperature
• Shipment date (month,

day, year)
• Sending laboratory
• Received shipment number
• Received temperature
• Date shipment received

(month, day, year)
• Clinic
• Comments
• Whether a quick add

template was used
• Reason specimen not

collected
• Storage unit
• Storage level
• Storage sub-level
• Storage container
• Position
• System date
• Date last changed

Exportable Abbott Assay Report
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Sorting Available filters Information on report

- • ACTG PID/ID1
• ACTG Protocol
• ACTG Protocol Type
• Assay Date
• Global Spec ID
• Non ACTG PID/ID1
• Non ACTG Prot/ID2
• Primary
• Project
• Run ID
• Specimen Date
• Specimen ID

• PID
• ID2/Pro
• ID3
• Visit
• PRI
• Specimen ID
• Global Spec ID
• Spec Date
• Rec Date
• Import Date
• Assay Date
• RUN ID
• Dilution
• Result
• System Censor
• User Censor
• Run System Censor
• Run User Censor

Laboratory 081 billing report
Report request by laboratory 81 (but can be used for other purposes).

Sorting Filter criteria Information displayed on
report

This report is sorted by
project, ID2, and ID1.

• ACTG PID
• ACTG protocol
• ACTG protocol type
• Derivative
• Global specimen ID
• project
• Specimen date

• project
• ACTG protocol
• PID/ID1
• Specimen date
• Derivative
• Global specimen ID

Laboratory 81 CNICS by date report
Report requested by laboratory 81 (but can be used by any laboratory).

Sorting Filter criteria Information displayed on
report

This report is sorted by
specimen date

• Non ACTG prot/ID2
• Primary
• project
• Received date
• Specimen date
• Volume
• Volume unit

• project
• Non ACTG protocol/ID2
• Specimen date
• Received date
• Primary
• Volume
• Volume units

Laboratory 081 CNICS general report
Report requested by laboratory 81 (but can be used by any laboratory).
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Sorting Filter criteria Information displayed on
report

This report is sorted by ID1 • Additive
• Derivative
• Non ACTG PID/ID1
• Non ACTG Prot/ID2
• Received date
• Specimen date
• Specimen time
• Sub additive/derivative
• Volume
• Volume unit

• Non ACTG protocol/ID2
• PID/ID1
• Specimen date
• Specimen time
• Received date
• Additive
• Derivative
• Sub additive/derivative
• Volume
• Volume units

Laboratory 188 storage report
Provides a summary a summary of stored and not stored specimens, useful
for determining what specimens still needs to be assigned a storage location
in LDMS.

Sorting Filter criteria Information displayed on
report

This report is sorted by global
specimen ID

• ACTG PID/ID1
• ACTG Protocol
• ACTG Protocol Type
• Additive
• Condition
• Derivative
• Global Spec ID
• Non ACTG PID/ID1
• Non ACTG Prot/ID2
• OPID
• Other Specimen ID
• Primary
• project
• SID/ID3
• Specimen Date
• Specimen ID
• Specimen Time
• Time
• Time Unit
• Visit Unit
• Visit Value
• Volume
• Volume Unit

• Global specimen ID
• Other specimen ID
• Freezer
• Shelf
• Rack
• Container
• Position

Lab 40 LabKey report
Short reference description.

Sorting Filter criteria Information displayed on
report

This report is sorted by
specimen ID

• ACTG PID/ID1
• ACTG Protocol

• GlobalSpecID
• Laboratory Name
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Sorting Filter criteria Information displayed on
report

• ACTG Protocol Type
• Additive
• Clinic ID
• Derivative
• Global Spec ID
• Import Date
• Non ACTG PID/ID1
• Non ACTG Prot/ID2
• Primary
• project
• Received Date
• Specimen Date
• Specimen ID
• Sub Add/Der
• Visit Unit
• Visit Value

• Clinic
• PTID
• Specimen Date
• Receipt Date
• LDMS Spec ID
• project
• Visit
• Protocol
• Visit Unit
• Volume
• Volume Unit
• Storage Date
• Ship Date
• Ship Lab
• Sub additive/derivative
• Comments
• Primary
• Derivative
• Additive
• Condition
• Storage unit
• Level 1
• Level 2
• Container
• Position
• Frozen Time
• Processing Tech Initials
• Processing Date
• Total Cell Count
• Other Spec ID
• ID3
• OPID
• Processing time
• Frozen date
• Primary Volume
• Primary Vol Units
• Received Time
• Mark for Shipping

Laboratory 48 billing report
Report that provides specimen information.

Filter criteria Information displayed on report

• ACTG PID
• ACTG Protocol
• ACTG Protocol Type
• Additive
• Clinic ID
• Non ACTG PID/ID1
• Non ACTG Prot/ID2
• project

• Specimen ID
• project/Protocol
• PID
• Visit/Unit
• Specimen Date
• Additive
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Filter criteria Information displayed on report
• Specimen Date
• Specimen ID
• Visit Unit
• Visit Value

Lab 485 aliquot report
Similar to the Specimen Export Report, but sorts the results differently.

Sorting Filter criteria Information displayed on
report

1. project
2. Non-ACTG Protocol
3. Non-ACTG PID
4. Visit Value
5. Primary
6. Additive
7. Derivative

• ACTG PID/ID1
• ACTG Protocol
• ACTG Protocol Type
• Additive
• Derivative
• Non ACTG PID/ID1
• Non ACTG Prot/ID2
• Primary
• project
• Sub Add/Der
• Visit Unit
• Visit Value

• project
• PID/ID1
• Protocol
• SID/ID3
• Visit
• Visit [Unit]
• Clinic
• Received Date
• Collection Date
• Collection Time
• Import Date
• Specimen ID
• Global Specimen ID
• Primary
• Additive
• Derivative
• Sub Additive/Derivative
• Volume
• Volume Unit
• Condition
• Time
• Time Unit
• Other Specimen ID
• Test
• Comments
• Ship Date
• Ship Batch
• Ship to Laboratory

Lab 485 specimen count report
Provides the number of specimens with a unique primary-additive-derivative-
sub A/D combination.

Sorting Filter criteria Information displayed on
report

1. project and study
combination

2. Participant
3. Visit

• ACTG PID/ID1
• ACTG Protocol
• ACTG Protocol Type
• Additive
• Derivative

• PID
• Visit
• Visit Unit
• Primary
• Additive
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Sorting Filter criteria Information displayed on
report

• Non ACTG PID/ID1
• Non ACTG Prot/ID2
• Primary
• project
• Sub Add/Der
• Visit Unit
• Visit Value
• Volume
• Volume unit

• Derivative
• Sub Additive/Derivative
• Count

Lab 485 specimen count with volume report
Provides the number of specimens with a unique primary-additive-derivative-
sub A/D combination, along with total volume.

Sorting Filter criteria Information displayed on
report

1. project and study
combination

2. Participant
3. Visit

• ACTG PID/ID1
• ACTG Protocol
• ACTG Protocol Type
• Additive
• Derivative
• Non ACTG PID/ID1
• Non ACTG Prot/ID2
• Primary
• project
• Sub Add/Der
• Visit Unit
• Visit Value

• PID
• Visit
• Visit Unit
• Primary
• Additive
• Derivative
• Sub Additive/Derivative
• Volume
• Volume Unit
• Count

Primary specimen database dump report
Provides a list of specimen ID numbers for primaries, along with draw dates
and received dates.

Sorting Filter criteria Information displayed on
report

This report is sorted by
specimen ID

None • Specimen ID
• Other specimen ID
• Collection date
• Received date

Sample counts for specified project report
Shows how many specimens for a given derivative type are available for each
project locally.

Sorting Filter criteria Information displayed on
report

This report is organized by
project

• Derivative
• project

• Derivative type
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Sorting Filter criteria Information displayed on
report

• Received date
• Specimen date

• Description of derivative
type

• Count (number of
specimens)

Specimen export report
Designed for pulling information for local groups that have been shipped.

Sorting Filter criteria Information displayed on
report

This report is sorted by
project, then by participant
identifier (ID1), and then by
specimen ID

• Shipped batch number • Protocol
• project
• Primary type
• Derivative type
• Additive
• Sub additive/derivative

type
• Collection date
• Visit value
• Visit unit
• Global specimen ID
• Original volume
• Original volume unit
• Available volume
• Available volume unit
• Clinic
• Time
• Received date
• Participant identifier (ID1)
• Protocol identifier (ID2)
• Source laboratory
• Draw time
• Received time

Storage export report
Provides a summary of specimens and their storage location in a laboratory’s
local database.

Sorting Filter criteria Information displayed on
report

- • ACTG PID/ID1
• ACTG protocol
• ACTG protocol type
• Additive
• Derivative
• Non ACTG PID/ID1
• Non ACTG Prot/ID2
• OPID
• Other specimen ID
• Primary

• Specimen ID
• project/Prot
• PID/ID1
• OPID
• Primary
• Additive
• Derivative
• Sub additive/derivative
• Specimen Date
• Visit ID
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Sorting Filter criteria Information displayed on
report

• project
• Specimen date
• Specimen ID
• Sub add/der
• Visit unit
• Visit value
• Volume
• Volume unit

• Volume
• Time
• Shipped no.
• Other specimen ID
• Storage location + position

Westat PK Export Report
Used to transfer PK results to Westat data management team.

Filter criteria Information displayed on report

• Assay Date
• Non ACTG PID/ID1
• Non ACTG Prot/ID2
• Project
• Run ID
• Specimen ID

• Specimen ID
• PID/ID1
• Other Spec ID
• VID
• Spec Date
• Spec Time
• Time/Unit
• Assay Date
• Run ID
• Add
• Der
• Drug
• Conc
• Units
• Censors
• Reviewed

Miscellaneous reports

Clinic contact report
Provides contact information for clinics by clinic ID number.

Sorting Filter criteria Information displayed on
report

This report is sorted by clinic
ID

• Clinic ID • Clinic ID
• Clinic name
• Address
• Telephone number
• Fax number
• Contact(s) [including

name, phone number,
fax number, and email
address]
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LDMS abbreviated codes report
Provides a list of LDMS unit, visit, time, specimen condition codes used in
LDMS and their meaning.

Information displayed on report

Note:  The information on this report is identical to the hover text that
appears throughout LDMS.

• Measurement codes
• Visit unit codes
• Time unit codes
• Specimen condition codes

LDMS assay censor codes report
Provides a list of assay censor codes.

Information displayed on report

• Censor codes
• Code descriptions

LDMS primary, additive, derivative, sub additive/
derivative codes report
Provides a list of LDMS primary, additive, derivative, and sub additive/
derivative codes throughout LDMS.

Information displayed on report

Note:  The information on this report is identical to the hover text that
appears throughout LDMS.

• Primary codes
• Additive codes
• Derivative codes
• Sub additive/derivative codes

MWCCS

MWCCS Processing Report

Filter criteria Information displayed on report

• Non-ACTG PID/ID1
• Project
• Specimen Date
• Specimen ID

• Global Spec ID
• Der
• Other Spec ID
• Volume
• Number of Aliquots
• Study
• Processing Instructions
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Filter criteria Information displayed on report
• Cell count
• Amt
• Storage
• Processor’s Initials
• Date/Time Processed/Frozen
• Unused Tubes

Participant reports

Participant identifiers report
Provides a list of participants in your database by project.

Sorting Filter criteria Information displayed on
report

This report is sorted by
project, and then by ID1

• ACTG PID
• ACTG protocol
• ACTG protocol type
• Non ACTG PID/ID1
• Non ACTG Prot/ID2
• OPID
• project
• SID/ID3

• project
• ID1
• ID2
• ID3
• OPID
• Clinic

PK reports

Pharmacology Drug Count
Displays a result count by analyte per study/ protocol.

Filter Criteria

• ACTG Protocol
• ACTG Protocol Type
• Assay Date
• Clinic ID
• Project
• Specimen Date

Pharmacology Drug List
List of pharmacology drugs and their associated codes.

Pharmacology Proficiency Results
Displays results of Pharmacology proficiency testing
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Filter Criteria

• Round Number

PK Drug Limits By Run
PK drug limits sorted by run.

Filter criteria Information displayed on report

• Assay Date
• Drug
• Run ID

• Run ID
• Drug
• Drug Lower Limit
• Drug Upper Limit
• Run Lower Limit
• Run Upper Limit
• Units

PK Participant Report
An individualized report per specimen showing associated participant details
along with detailed test results including censor codes, run limits, and a final
calculated result.

Filter criteria Information displayed on report

• ACTG PID/ID1
• ACTG Protocol
• Assay Date
• Clinic ID
• Derivative
• Global Spec ID
• Non ACTG PID/ID1
• Non ACTG Prot/ID2
• Other Specimen ID
• Primary
• Project
• Received Date
• Run ID
• SID/ID3
• Specimen Date
• Specimen ID

• Participant
• Project / ID2
• ID3
• Collection Date
• Visit
• Clinic Name
• Fax
• Testing Lab
• Specimen ID
• Global Spec ID
• Other Spec ID
• Received Date
• Received Time
• Sample Condition
• Primary
• Additive
• Derivative
• Run ID
• Detection Platform
• Run Type
• Test Date
• Tech Initials
• Analyte
• Description
• Unit
• Concentration
• Lower Limit
• Upper Limit
• Censors
• Review Comment

Frontier Science Foundation 138



LS.0006 | LDMS for the Web - User Manual

Filter criteria Information displayed on report
• Sample Comment

PK Summary Report
PK Summary Report sorted by protocol

Filter criteria Information displayed on report

• ACTG PID
• ACTG Protocol
• ACTG Protocol Type
• Additive
• Assay Date
• Derivative
• Drug
• Global Spec ID
• Non ACTG PID/ID1
• Non ACTG Prot/ID2
• OPID
• Other Specimen ID
• Primary
• Project
• Received Date
• Run ID
• Specimen Date
• Specimen ID
• Specimen Time
• Time
• Time Unit
• Visit Unit
• Visit Value

• PID/ID1
• Specimen ID
• Global Specimen ID
• Other Spec ID
• Spec Date
• VID
• Spec Time
• Time/Unit
• Assay Date
• Run ID
• Pri
• Add
• Der
• Drug
• Conc
• Cens
• Rev by
• Rev Date

PK Summary with Assay Name
Same as PK Summary Report but with additional Assay Name column

Filter criteria Information displayed on report

• ACTG PID
• ACTG Protocol
• ACTG Protocol Type
• Additive
• Assay Date
• Derivative
• Drug
• Global Spec ID
• Non ACTG PID/ID1
• Non ACTG Prot/ID2
• OPID
• Other Specimen ID
• Primary
• Project
• Received Date
• Run ID

• PID/ID1
• Specimen ID
• Global Specimen ID
• Assay Name
• Spec Date
• VID
• Spec Time
• Time/Unit
• Assay Date
• Run ID
• Pri
• Add
• Der
• Drug
• Conc
• Units
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Filter criteria Information displayed on report
• Specimen Date
• Specimen ID
• Specimen Time
• Time
• Time Unit
• Visit Unit
• Visit Value

• Cens
• Reviewed

PK Summary with Assay Name (exportable)
Exportable version of PK Summary with Assay Name report

Filter criteria Information displayed on report

• ACTG PID
• ACTG Protocol
• ACTG Protocol Type
• Additive
• Assay Date
• Derivative
• Drug
• Global Spec ID
• Non ACTG PID/ID1
• Non ACTG Prot/ID2
• OPID
• Other Specimen ID
• Primary
• Project
• Received Date
• Run ID
• Specimen Date
• Specimen ID
• Specimen Time
• Time
• Time Unit
• Visit Unit
• Visit Value

• Group/Prot
• Global Spec ID
• Assay Name
• Assay Date
• Run ID
• Drug
• Conc
• Units
• Lower Limit
• Upper Limit
• Censors Reviewed

Quick Add Templates

Quick Add Template List Report
This report provides a list of Quick Add templates available to your laboratory.

Sorting Available filters Information on report

Alphabetical by template name • ID2/protocol
• project
• Quick Add Template Name
• Quick Add template Type

• Quick add template name
• Type (local or preset by

Frontier Science
• [list of enrollment and

specimen data that will be
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Sorting Available filters Information on report
populated by the template;
this will vary by template]

RPID Reports

Random PID Report
Provides a link between the original ACTG/IMPAACT PID and the RPID ID
assigned during shipment import. This report is sensitive and is only available
to the RPID importing lab.

Sorting Available filters Information on report

- • Import Date
• Original Specimen ID
• Received Shipment

Number
• Shipment Number
• Specimen ID

• PID
• RPID
• Other Specimen ID
• Spec Date
• Received Batch
• Sending Lab
• Contact
• Phone

RPID Specimen Request Report
Report displaying the RPID values assigned to various request numbers in the
RPID Requests module.

Sorting Available filters Information on report

- • Import Date
• Received Shipment

Number
• Request Number
• Shipment Number

• PID
• RPID
• Other Specimen ID
• Shipment Number
• Received Batch
• Sending Lab
• Contact
• Phone

Shipping reports

Daily imported specimen log report
Shows a list of specimens for a project-protocol combination that have been
received from another laboratory in a shipping file.

Sorting Filter criteria Information displayed on
report

This report is sorted by
project-protocol combination,
and then by specimen date

• ACTG protocol
• ACTG protocol type
• Clinic ID

• Specimen ID
• First global specimen ID
• Second global specimen ID
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Sorting Filter criteria Information displayed on
report

• Condition
• Global specimen ID
• Import date
• Non ACTG PID/ID1
• Non ACTG Prot/ID2
• project
• SID/ID3
• Sending lab ID
• Specimen date
• Specimen ID
• Visit unit
• Visit value

• Clinic
• PID/ID1
• SID/ID3
• Visit
• Specimen date
• Import date
• Sending laboratory
• Specimen condition

Detailed imported specimen report
Shows specimens received through a shipping file from another laboratory,
sorted by shipment number.

Sorting Filter criteria Information displayed on
report

This report is sorted by
shipment number, and then by
specimen ID

• ACTG PID
• ACTG protocol
• ACTG protocol type
• Additive
• Condition
• Derivative
• Import date
• Laboratory ID
• Non ACTG Prot/ID2
• Other specimen ID
• Primary
• project
• Shipment number
• Specimen date
• Specimen ID
• Specimen time
• Sub additive/derivative
• Time
• Time unit
• Visit unit
• Visit value
• Volume
• Volume unit

• Import batch no. (the
shipment number)

• Import date
• Sending laboratory
• Specimen ID
• project/Prot
• Primary
• Additive
• Derivative
• Sub additive/derivative
• PID/ID1
• VID
• Condition
• Volume
• Specimen date
• Specimen time
• Other specimen ID
• Time/Time unit

Imported specimen report - summary
Shows the number of a specific type of specimen received as part of a
shipment from another laboratory.
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Sorting Filter criteria Information displayed on
report

This report is sorted by
shipment number

• ACTG protocol
• ACTG protocol type
• Additive
• Derivative
• Import date
• Non ACTG prod/ID2
• Primary
• project
• Sending laboratory ID
• Shipment number
• Sub additive/derivative

• Sending laboratory
• Batch number (shipment

number)
• project-protocol

combination
• Import date
• Primary
• Additive
• Derivative
• Sub additive/derivative
• Count

Lab 263 Summary Detail of Shipped Specimens
Provides a summary of shipped specimens for lab 263.

Filter criteria Information displayed on report

• Additive
• Derivative
• Destination Lab
• Primary
• Project
• Received Date
• Shipment Date
• Specimen Date
• Sub Add/Der

• Project
• Destination Lab
• Primary
• Additive
• Derivative
• Sub A/D
• Tube count
• Total Volume

Shipped specimen report - detail report
Lists the specimens within a shipment, organized by shipment number.

Sorting Filter criteria Information displayed on
report

This report is sorted by
shipment number, and then by
global specimen ID

• ACTG Protocol
• ACTG Protocol Type
• Additive
• Clinic ID
• Condition
• Derivative
• Destination Lab
• NON ACTG PID/ID1
• NON ACTG PROT/ID2
• Other Spec ID
• Primary
• project
• Shipment Date
• Shipment Number
• Shipping Temp.
• Spec Date
• Spec ID
• Specimen Time

• Shipment batch number
• Shipment date
• Laboratory shipped to
• Clinic
• Specimen ID
• Other specimen ID
• project/prot
• Global specimen ID
• PID/ID1
• VID
• Specimen Date
• Specimen time
• Primary
• Additive
• Derivative
• Sub additive/derivative
• Volume
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Sorting Filter criteria Information displayed on
report

• Sub Add/Der
• Visit Unit
• Visit Value
• Volume
• Volume Unit

• Condition

Shipped specimen report - summary report
Shows the number of specimens of a specific derivative type on a shipment
that was sent.

Sorting Filter criteria Information displayed on
report

This report is sorted by
shipment number, and then
grouped by derivative

• ACTG protocol
• ACTG protocol type
• Clinic ID
• Derivative
• Destination laboratory
• Non ACTG prot/ID2
• project
• Shipment date
• Shipment number
• Shipping temperature

• Batch number
• Ship date
• Destination
• project/protocol
• Derivative
• Number of specimens

shipped

Shipping laboratory contact report
Shows contact information for a given laboratory.

Sorting Filter criteria Information displayed on
report

This report is sorted by
laboratory ID

• Laboratory ID • Laboratory ID
• Laboratory name
• Contact (with telephone

number and email
address)

• Address
• Room number
• Country
• Laboratory telephone

number
• Laboratory fax number

Specimens Marked for Shipping
Provides a list of specimens that are marked for shipping.

Filter criteria Information displayed on report

• ACTG PID
• ACTG Protocol
• ACTG Protocol Type
• Additive

• PID/ID1
• Specimen ID
• Global Specimen ID
• VID
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Filter criteria Information displayed on report
• Derivative
• Intended Ship Date
• Marked in Storage
• Non ACTG PID/ID1
• Non ACTG Prot/ID2
• Primary
• Project
• Shipment Number
• Specimen ID
• Sub Add/Der
• Visit Unit
• Visit Value

• Pri
• Add
• Der
• Sub A/D
• Spec Date
• Category
• Intended Ship Date
• Intended Destination
• Batch Number
• Overdue?

Specimen reports

Cell yield QA/QC summary report
Provides a summary cell yield for viable PBMCs, along with a graph of cell
yield by date, mean, standard deviation, and range.

Sorting Filter criteria Information displayed on
report

This report is sorted by
collection date.

• ACTG protocol
• ACTG protocol type
• Non ACTG prot/ID2
• project
• Specimen date
• Technician initials

• Patid
• Collection date
• Collection time
• Tech
• Additive
• Total cell count (×106)
• Total volume
• Comments (from Specimen

Management)
• Cell yield (×106)

Lab 263 Processing Report
Provides processing information (processing date, amount aliquoted, etc.) for
primaries and aliquots for lab 263.

Sorting Filter Criteria Information Displayed on
Report

This report is sorted by
project-protocol combination,
then by collection date, and
then grouped by primary.

• ACTG Protocol
• Additive
• Available
• Clinic ID
• Condition
• Derivative
• Import Date
• Non ACTG Prot/ID2
• Primary
• Project

• Global Spec ID
• Add
• Der
• Other Spec ID
• # of Tubes
• Volume
• # of Aliq.
• Study
• Visit
• Processing Instructions
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Sorting Filter Criteria Information Displayed on
Report

• Received Date
• Shipment Date
• SID/ID3
• Specimen Date
• Specimen Type
• Stored
• Sub Add/Der

• Cell Count
• Amt Aliq'd
• Processor's Initials
• Date/Time Processed
• # of Unused Tubes

Lab 263 Summary of Specimens

Filter criteria Information displayed on report

• ACTG PID
• ACTG Protocol
• Additive
• Available
• Clinic ID
• Condition
• Derivative
• Import Date
• Non ACTG PID/ID1
• Non-ACTG Prot/ID2
• Primary
• project
• Received Date
• Received Time
• Shipment Date
• SID/ID3
• Specimen Date
• Specimen Time
• Specimen Type
• Stored
• Sub additive/derivative

• project
• Primary
• Additive
• Derivative
• Sub additive/derivative
• Participant count
• Tube count
• Total Volume

Primary specimens received report
Provides a summary of all primary specimens within a laboratory’s database,
and the total number of primaries.

Sorting Filter criteria Information displayed on
report

This report is sorted by
project-protocol combination,
and then by specimen ID

• ACTG PID
• ACTG protocol
• ACTG protocol type
• Additive
• Clinic ID
• Condition
• Import date
• Non ACTG PID/ID1
• Non ACTG Prot/ID2
• OPID

• Specimen ID
• project/protocol
• PID/ID1
• Clinic
• Global specimen ID
• Visit
• Specimen date
• Received date
• Primary
• Additive
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Sorting Filter criteria Information displayed on
report

• Other specimen ID
• Primary
• project
• Received date
• SID/ID3
• Specimen date
• Specimen ID
• Visit unit
• Visit value
• Volume
• Volume unit

• Specimen condition
• Volume
• Other specimen ID
• Comments (from the

Specimen Management
page)

Specimen count report
Should the number of aliquots entered, stored, and shipped by your
laboratory by project-protocol combination, as well as the total across all
projects and protocols.

Sorting Filter criteria Information displayed on
report

This report is sorted by
project-protocol combination

• ACTG protocol
• ACTG protocol type
• Clinic ID
• Derivative
• project
• Specimen date

• project/protocol
combination

• Number of aliquots entered
into LDMS

• Number of currently stored
aliquots

• Number of shipped aliquots

Specimen log report
Provides detailed information about every primary and aliquot within a
laboratory’s database.

Sorting Filter criteria Information displayed on
report

This report is sorted by
project-protocol combination,
then by collection date, and
then grouped by primary.

• ACTG PID
• ACTG protocol
• ACTG protocol type
• Additive
• Clinic ID
• Condition
• Derivative
• Global specimen ID
• Import date
• Non ACTG PID/ID1
• Non ACTG Prot/ID2
• OPID
• Other specimen ID
• Primary
• project
• Received date

• PID/ID1
• project/prot
• SID/ID3
• VID
• Clinic
• OPID
• Primary specimen ID
• Global specimen ID
• Specimen time
• Specimen date
• Received date
• Primary volume
• Time/time unit
• Other specimen ID
• Comments [for primary

specimen]
• Aliquot specimen ID
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Sorting Filter criteria Information displayed on
report

• SID/ID3
• Shipped
• Specimen date
• Specimen ID
• Specimen time
• Sub add/der
• System entry date
• Test ordered
• Time
• Time unit
• Visit unit
• Visit value
• Volume
• Volume unit

• Global specimen ID
• Other specimen ID
• Primary/additive
• Derivative/Sub-additive/

derivative
• Current volume
• Condition
• project/prot
• Test(s) ordered
• Shipped
• Comments

Specimen processing report
Provides processing information (processing date, frozen date, etc.) for
primaries and aliquots in a laboratory’s database.

Sorting Filter criteria Information displayed on
report

This report is sorted by
project-protocol combination,
then by collection date, and
then grouped by primary.

• ACTG PID/ID1
• ACTG protocol
• ACTG protocol type
• Additive
• Derivative
• Global specimen ID
• Import date
• Non ACTG PID/ID1
• Non ACTG Prot/ID2
• Other specimen ID
• Primary
• project
• Received date
• SID/ID3
• Specimen date
• Specimen ID
• Visit unit
• Visit value

• PID/ID1
• project/Prot
• SID/ID3
• VID
• Clinic
• OPID
• Primary specimen ID
• Global specimen ID
• Other specimen ID
• Primary
• Additive
• Volume
• Specimen date
• Specimen time
• Received date
• Received time
• Total cell count
• Proc[essing] date
• Proc[essing] time
• Proc[essed] by
• Aliquot specimen ID
• Global specimen ID
• Other specimen ID
• Derivative
• Sub-additive/derivative
• Volume
• project/prot
• Frozen date
• Frozen time
• Proc[essing] date
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Sorting Filter criteria Information displayed on
report
• Proc[essing] time
• Proc[essing] by

Specimens for a given project report
Shows the aliquots for a given project-protocol combination.

Sorting Filter criteria Information displayed on
report

This report is grouped by
project-protocol combination,
and then sorted by ID1, and
then by specimen ID.

• ACTG PID
• ACTG protocol
• ACTG protocol type
• Additive
• Clinic ID
• Derivative
• Import date
• Non ACTG PID/ID1
• Non ACTG prot/ID2
• OPID
• Other specimen ID
• Primary
• project
• Received date
• SID/ID3
• Specimen date
• Specimen ID
• Specimen time
• Sub additive/derivative
• Visit unit
• Visit value

• Protocol (and project)
• PID/ID1
• OPID
• Specimen ID
• Global specimen ID
• Specimen date
• Specimen time
• Primary
• Additive
• Derivative
• Sub additive-derivative
• Received date
• Received time
• Import date
• VID (visit value and unit)
• Other specimen ID

Specimens for a given project 2
Shows the aliquots for a given project-protocol combination in aggregate
form, with the number of aliquots with a given specimen ID.

Sorting Filter criteria Information displayed on
report

This report is grouped by
project-protocol combination,
then grouped by Specimen ID,
and then sorted by ID1, and
then by specimen ID.

• ACTG PID
• ACTG protocol
• ACTG protocol type
• Additive
• Clinic ID
• Derivative
• Import date
• Non ACTG PID/ID1
• Non ACTG prot/ID2
• OPID
• Other specimen ID
• Primary
• project

• Protocol (and project)
• PID/ID1
• OPID
• Specimen ID
• Count
• Specimen date
• Specimen time
• SID/ID3
• Primary
• Additive
• Derivative
• Sub additive-derivative
• Received date
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Sorting Filter criteria Information displayed on
report

• Received date
• SID/ID3
• Specimen date
• Specimen ID
• Specimen time
• Sub additive/derivative
• Visit unit
• Visit value

• Received time
• Import date
• VID (visit value and unit)
• Other specimen ID

Time to freeze QA/QC summary report
Shows the time to freeze for aliquots, along with a graph and summary of
overall time to freeze.

Sorting1 Filter criteria Information displayed on
report

- • ACTG protocol
• ACTG protocol type
• Non ACTG prot/ID2
• project
• Specimen date
• Tech initials

• Patid
• Collection date
• Collection time
• Frozen date
• Frozen time
• Time to freeze (in minutes)
• Tech
• Additive
• Derivative
• Comments

Time to process QA/QC summary report
Shows the time to process for aliquots, along with a graph and summary of
overall time to process.

Sorting2 Filter criteria Information displayed on
report

- • ACTG protocol
• ACTG protocol type
• Non ACTG prot/ID2
• project
• Specimen date
• Tech initials

• Patid
• Collection date
• Collection time
• Process time
• Frozen time
• Time to process (in

minutes)
• Tech
• Additive
• Derivative
• Comments

1 You must specify a sample type to report on to generate this
report. You can generate the report for PBMCs, plasma, or both.

2 You must specify a sample type to report on to generate this
report. You can generate the report for PBMCs, plasma, or both.
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Storage reports

Specimens in storage per PID report
Shows the number for a given project-participant combination that have a
storage location assigned in a laboratory’s database.

Sorting Filter criteria Information displayed on
report

This report is sorted by
project, and then by
participant.

• ACTG PID/ID1
• ACTG protocol
• ACTG protocol type
• Non ACTG PID/ID1
• Non ACTG prot/ID2
• OPID
• Primary
• project

• project
• PID
• Count (number of aliquots)

Specimens not in storage report
Shows specimens that are available in a laboratory’s database, but have not
had a storage location assigned on the Storage page.

Sorting Filter criteria Information displayed on
report

This report is grouped by
project-protocol combination,
and then by specimen ID,
and then sorted by global
specimen ID.

• ACTG protocol
• ACTG protocol type
• Additive
• Condition
• Derivative
• Non ACTG PID/ID1
• Non ACTG prot/ID2
• Primary
• project
• Specimen ID
• Sub additive/derivative
• Visit unit
• Visit value
• Volume
• Volume unit

• project/prot
• Specimen ID
• Global specimen ID
• PID/ID1
• Specimen date
• Pri[mary]
• Add[itive]
• Der[ivative]
• Sub a[dditive]/d[erivative]
• VID (visit unit and value)
• Volume
• Condition
• Status

Specimens remaining in storage report
Shows the number of aliquots for a given participant with a storage location
assigned in a laboratory’s database.

Sorting Filter criteria Information displayed on
report

This report is grouped and
sorted by project, ID1, and
protocol.

• ACTG PID/ID1
• ACTG protocol
• ACTG protocol type
• Additive

• project
• PID
• Protocol
• Volume
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Sorting Filter criteria Information displayed on
report

• Non ACTG PID/ID1
• Non ACTG prot/ID2
• OPID
• Primary
• project
• Specimen date

• Volume unit
• Derivative
• Aliquots remaining in

storage

Storage container location report
Shows the storage location for all containers in a laboratory’s database.

Sorting Filter criteria Information displayed on
report

This report is sorted by
storage unit name, and then
by container position.

• ACTG protocol
• ACTG protocol type
• Freezer name
• Level name
• Non ACTG prot/ID2
• project
• Sublevel name

• Storage location
• Container name
• Position

Storage count report by freezer
Shows the number of specimens stored in a given storage unit for a given
project-protocol combination.

Sorting Filter criteria Information displayed on
report

This report is sorted by
storage unit, and then by
project-protocol combination,
and then by derivative.

• ACTG PID/ID1
• ACTG protocol
• ACTG protocol type
• Derivative
• Non ACTG PID/ID1
• Non ACTG prot/ID2
• project

• Freezer
• project/protocol
• Primary
• Additive
• Derivative
• Sub a[dditive]/d[erivative]
• Count

Storage detail report
Shows detailed information about the contents of containers in storage units.

Sorting Filter criteria Information displayed on
report

This report is sorted by
storage location, and then by
storage position.

• ACTG PID
• ACTG protocol
• ACTG protocol type
• Additive
• Derivative
• Import date
• Non ACTG PID/ID1
• Non ACTG Prot/ID2
• OPID

• Storage location
• Specimen ID
• Global spec[imen] ID
• project/prot
• PID/ID1
• VID/unit
• Prim[ary]
• Add[itive]
• Der[ivative]
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Sorting Filter criteria Information displayed on
report

• Other specimen ID
• Primary
• project
• Received date
• SID/ID3
• Shipment number
• Specimen date
• Specimen ID
• Specimen time
• Stored date
• Sub add[itive]/der[ivative]
• Visit unit
• Visit value
• Volume
• Volume unit

• Sub a[dditive]/d[erivative]
• Volume
• Ship
• Storage date
• Spec[cimen] date
• Time
• Clinic
• Pos[ition]
• Other specimen ID

Test Result Reports

Abbott Realtime HIV1 Assay Report
Filtering Criteria Information Displayed on Report

• ACTG PID/ID1
• ACTG/Protocol
• ACTG Protocol Type
• Assay Date
• Clinic ID
• Global Spec ID
• Non-ACTG PID/ID1
• Non-ACTG Prot/ID2
• Other Specimen ID
• Primary
• Project
• Run ID
• SID/ID3
• Specimen Date
• Specimen ID

• Group/protocol
• PID
• SID
• Visit
• PRI
• Specimen ID
• Other Spec ID
• Spec Date
• Assay Date
• RUN ID
• Dilution
• Result
• System Censor
• User Censor
• Run System Censor
• Run User Censor
• Group/Pro Total
• Grand Total

Abbott Realtime HIV1 Patient Report
An individualized report per specimen showing associated participant details
along with detailed test results including censor codes, run limits, and a final
calculated result.

Filtering Criteria Information Displayed on Report
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• ACTG PID/ID1
• ACTG/Protocol
• ACTG Protocol Type
• Assay Date
• Derivative
• Global Spec ID
• Non-ACTG PID/ID1
• Non-ACTG Prot/ID2
• Other Specimen ID
• Primary
• Received Date
• Run ID
• SID/ID3
• Specimen Date
• Specimen ID

• Patient
• SID
• Group/Protocol
• Specimen Date
• Visit
• Clinic Info
• Fax
• Testing Lab Info
• Specimen ID
• Received Date
• Primary
• Global Spec ID
• Received Time
• Additive
• Other Spec ID
• Sample Condition
• Derivative
• Type of Assay
• Assay Date
• Sample Prep Tech
• Amplification Tech
• Input Volume
• Data Transfer Tech
• Results:

• Run Comment
• Sample Comment
• Reportable Page

Abbott Repeat and Censored Run/Samples
Filtering Criteria Information Displayed on Report

• ACTG PID/ID1
• ACTG/Protocol
• ACTG Protocol Type
• Assay Date
• Global Spec ID
• Non-ACTG PID/ID1
• Non-ACTG Prot/ID2
• Other Specimen ID
• Primary
• Received Date
• Run ID
• SID/ID3
• Specimen Date
• Specimen ID

• Group/Prot
• System Censor
• Run System Censor
• User Censor
• Run User Censor
• Specimen ID
• Global Spec ID
• PID
• Spec Date
• RUN ID
• Run Valid/Invalid
• Assay Date
• Dilution
• Result

Abbott SARS-COV-2 Quant Assay Report
Displays specimen details and results from Abbott SARS-COV-2 Quant runs in
the Test Results module.
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Filter criteria Information displayed on report

• ACTG PID/ID1
• ACTG Protocol
• ACTG Protocol Type
• Assay Date
• Clinic ID
• Global Spec ID
• Non ACTG PID/ID1
• Non ACTG Prot/ID2
• Other Specimen ID
• Primary
• Project
• Run ID
• SID/ID3
• Specimen Date
• Specimen ID
• Specimen List

• Group/Prot
• PID
• SID
• Visit
• PRI
• Specimen ID
• Other Spec ID
• Global Spec ID
• Spec Date
• Assay Date
• RUN ID
• Result
• System Censor
• User Censor
• Run System Censor
• Run user Censor

Abbott SARS-COV-2 Quant Patient Report
An individualized report per specimen showing associated participant details
along with detailed test results including censor codes, run limits, and a final
calculated result.

Filter criteria Information displayed on report

• ACTG PID/ID1
• ACTG Protocol
• ACTG Protocol Type
• Assay Date
• Derivative
• Global Spec ID
• Non ACTG PID/ID1
• Non ACTG Prot/ID2
• Other Specimen ID
• Primary
• Project
• Received Date
• Run ID
• SID/ID3
• Specimen Date
• Specimen ID
• Specimen List

• Participant
• SID
• Group/Protocol
• Specimen Date
• Visit
• Clinic Info
• Fax
• Testing Lab Info
• Specimen ID
• Global Spec ID
• Other Spec ID
• Received Date
• Received Time
• Sample Condition
• Primary
• Additive
• Derivative
• Type of Assay
• Assay Date
• Input Volume
• Sample Prep Tech
• Amplification Tech
• Data Transfer Tech
• Results
• Log copies/mL
• Run Comment
• Sample Comment
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Filter criteria Information displayed on report
• Assay Reportable Range and Dilution

Information

IQA Cryopreservation Patient Report
An individualized report per specimen showing associated participant details
along with detailed test results including censor codes, run limits, and a final
calculated result.

Filter criteria Information displayed on report

• ACTG PID/ID1
• ACTG Protocol
• ACTG Protocol Type
• Assay Date
• Derivative
• Global Spec ID
• Non ACTG PID/ID1
• Non ACTG Prot/ID2
• On Cryopreservation Test Run
• Other Specimen ID
• Primary
• Project
• Received Date
• Run ID
• SID/ID3
• Specimen Date
• Specimen ID
• Specimen List

• Group/Study
• Run ID
• Assay Tech
• PID
• Spec No
• GlobalSpec ID
• Spec Date
• VID
• Primary
• Additive
• Derivative
• Sub A/D
• Data Entered By
• Data Entry Date

TaqMan HCV Repeat and Censored Run/Samples
Filtering Criteria Information Displayed on Report

• ACTG PID/ID1
• ACTG/Protocol
• ACTG Protocol Type
• Assay Date
• Global Spec ID
• Non-ACTG PID/ID1
• Non-ACTG Prot/ID2

• Project
• Run ID
• Specimen Date
• Specimen ID

• Group/Prot
• System Censor
• Run System Censor
• User Censor
• Run User Censor
• Specimen ID
• Global Spec ID
• PID/ID1
• Spec Date
• RUN ID
• Run Valid/Invalid
• Result
• Assay Date

TaqMan HIV-1 Repeat and Censored Run Samples
Filtering Criteria Information Displayed on Report
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• ACTG PID/ID1
• ACTG/Protocol
• ACTG Protocol Type
• Assay Date
• Global Spec ID
• Non-ACTG PID/ID1
• Non-ACTG Prot/ID2

• Project
• Run ID
• Specimen Date
• Specimen ID

• Group/Prot
• System Censor
• Run System Censor
• User Censor
• Run User Censor
• Specimen ID
• Global Spec ID
• PID/ID1
• Spec Date
• RUN ID
• Run Valid/Invalid
• Result
• Assay Date

TaqMan Realtime HCV Assay Report
Filtering Criteria Information Displayed on Report

• ACTG PID/ID1
• ACTG/Protocol
• ACTG Protocol Type
• Assay Date
• Clinic ID
• Global Spec ID
• Non-ACTG PID/ID1
• Non-ACTG Prot/ID2
• Other Specimen ID
• Primary
• Project
• Run ID
• SID/ID3
• Specimen Date
• Specimen ID
• Version

• Group/Prot
• SID/ID3
• VID
• PRI
• Specimen ID
• Other Spec ID
• Global Spec ID
• Spec Date
• Assay Date
• RUN ID
• Ver
• Result
• System Censor
• User Censor
• Run System Censor
• Run User Censor

TaqMan Realtime HCV Patient Report
An individualized report per specimen showing associated participant details
along with detailed test results including censor codes, run limits, and a final
calculated result.

Filtering Criteria Information Displayed on Report
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• ACTG PID/ID1
• ACTG/Protocol
• ACTG Protocol Type
• Assay Date
• Clinic ID
• Global Spec ID
• Non-ACTG PID/ID1
• Non-ACTG Prot/ID2
• Other Specimen ID
• Primary
• Project
• Run ID
• SID/ID3
• Specimen Date
• Specimen ID
• Version

• Patient
• SID
• Group/Protocol
• Specimen Date
• Visit
• Clinic Info
• Fax
• Testing Lab Info
• Specimen ID
• Global Spec ID
• Other Spec ID
• Received Date
• Received Time
• Sample Condition
• Primary
• Additive
• Derivative
• Type of Assay
• Assay Date
• Prep Method
• Sample Prep Tech
• Data Transfer Tech
• Results

TaqMan Realtime HIV-1 Assay Report
Filtering Criteria Information Displayed on Report

• ACTG PID/ID1
• ACTG/Protocol
• ACTG Protocol Type
• Assay Date
• Clinic ID
• Global Spec ID
• Non-ACTG PID/ID1
• Non-ACTG Prot/ID2
• Other Specimen ID
• Primary
• Project
• Run ID
• SID/ID3
• Specimen Date
• Specimen ID
• Version

• PID/ID1
• SID/ID3
• VID
• PRI
• Specimen ID
• Other Spec ID
• Global Sec ID
• Spec Date
• Assay Date
• RUN ID
• Ver
• Result
• System Censor
• Use Censor
• Run System Censor
• Run User Censor

TaqMan Realtime HIV-1 Patient Report
An individualized report per specimen showing associated participant details
along with detailed test results including censor codes, run limits, and a final
calculated result.

Filtering Criteria Information Displayed on Report
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• ACTG PID/ID1
• ACTG/Protocol
• ACTG Protocol Type
• Assay Date
• Derivative
• Global Spec ID
• Non-ACTG PID/ID1
• Non-ACTG Prot/ID2
• Other Specimen ID
• Primary
• Project
• Received Date
• Run ID
• SID/ID3
• Specimen Date
• Specimen ID
• Version

• Patient
• SID
• Group/Protocol
• Specimen Date
• Visit
• Clinic Info
• Fax
• Testing Lab Info
• Specimen ID
• Global Spec ID
• Other Spec ID
• Received Date
• Received Time
• Sample Condition
• Primary
• Additive
• Derivative
• Type of Assay
• Assay Date
• Prep Method
• Sample Prep Tech
• Data Transfer Tech
• Results

Taqman Realtime Qual Assay Report
Filtering Criteria Information Displayed on Report

• ACTG PID/ID1
• ACTG/Protocol
• ACTG Protocol Type
• Assay Date
• Global Spec ID
• Non-ACTG PID/ID1
• Non-ACTG Prot/ID2
• Other Specimen ID
• Primary
• Project

• Run ID
• SID/ID3
• Specimen Date
• Specimen ID
• Version

• PID/ID1
• SID/ID3
• VID
• PRI
• Specimen ID
• Other Spec ID
• Global Spec ID
• Spec Date
• Assay Date
• RUN ID
• Ver
• Result
• System Censor
• Run System Censor
• User Censor
• Run User Censor

TaqMan Realtime Qual Patient Report
An individualized report per specimen showing associated participant details
along with detailed test results including censor codes, run limits, and a final
calculated result.

Filtering Criteria Information Displayed on Report
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• ACTG PID/ID1
• ACTG/Protocol
• ACTG Protocol Type
• Assay Date
• Derivative
• Global Spec ID
• Non-ACTG PID/ID1
• Non-ACTG Prot/ID2
• Other Specimen ID
• Primary
• Project

• Run ID
• SID/ID3
• Specimen Date
• Specimen ID
• Version

• PID/ID1
• SID/ID3
• VID
• PRI
• Specimen ID
• Other Spec ID
• Global Spec ID
• Spec Date
• Assay Date
• RUN ID
• Ver
• Result
• System Censor
• Run System Censor
• User Censor
• Run User Censor

WIHS

Processing Log - Lab 263
Displays specimen processing details and instructions based on WIHS
processing codes.

Filter criteria Information displayed on report

• Non ACTG PID/ID1
• Specimen Date
• Specimen ID

• Global Spec ID
• Der
• Other Spec ID
• Volume
• Number of Aliquots
• Study
• Processing Instructions
• Cell Count
• Amt
• Storage
• Processor's Initials
• Date/Time Processed/Frozen
• Unused Tubes

Labels

Label formats
Labels are setup like grids, with items that appear on the label occupying one
cell.
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Items that can appear are most of the information that can be found on the
Specimen Management page, such as the primary type and the received
date and time. Each row on a label can hold up to four items, and a label can
have up to 8 rows.

Figure 52: Label definition and corresponding output

A label as it is set up in LDMS (left) compared to a generated label (right). The colored background shows how each

item in the label definition matches up to the item on the label.

Barcodes
LDMS supports generating 2D barcodes on labels

If a label has a barcode, it will appear as the first item on the label. The
barcodes generated by LDMS contain the specimen’s global specimen ID.

Label sizes
Labels can be generated in a variety of common sizes.

The label’s name in LDMS indicates information about its size, manufacturer,
and use.

Figure 53: Example label name

There are three types of labels available:

Laser labels For printing using a desktop printer with special 8.5-
by-11-inch paper

Barcode labels For printers specifically made for printing labels

Dot matrix
labels

For use with dot matrix printers
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Note:  If you choose a label format that has a barcode, only barcode
labels can be selected.

For laser and dot matrix labels, the size of the label refers to the label itself,
not the paper it will be printed on. These labels are generated in US letter
size paper (8.5-by-11-inches), with the assumption that the user is using
special label paper that can be pealed apart. Barcode labels, on the other
hand, require special printers and label paper that are designed exclusively
for printing labels.

How to use a barcode reader with LDMS
LDMS supports using any Windows compatible barcode reader.

Barcode readers that are compatible with Windows will extract the global
specimen ID from the 2D barcodes that are generated by LDMS. You can test
this yourself by opening Notepad and scanning a barcode. Doing so will cause
the global specimen ID from the barcode to appear in Notepad.

In any place in where you would need to type a global specimen ID, you can
use a barcode reader to input the ID instead. Select the box where you want
the global specimen ID to appear, and then scan the barcode. This can help
avoid errors when trying to type out a global specimen ID using the keyboard.

Printing labels anywhere
Specimen labels can be printed in many places in LDMS, not just the Labels
page.

Labels can be printed almost anywhere where you can interact with
specimens.

• On the Specimen Management page, click the down arrow next to any of
the Edit buttons, and then select Print Labels. This will print all labels
associated with that item. For example, if you select Edit Participant >
Print labels, you will print the labels for all specimens associated with that
participant. Likewise, if you click Edit [primary] > Print Labels, you will
print all labels associated with that primary.

• Also on the Specimen Management page, when adding a participant using
Quick Add, after a record is added a success message appears at the top of
the page. Below it, click the button that says Print labels.

• On the Storage page, click the down arrow next to Edit button next to
any storage item, and then click Print Labels. This will allow you to print
labels for all specimens stored at that location.

• On the Pending Shipments page, click the down arrow next to the Edit/
Ship button next to a shipment, and then click Print Labels.

When creating labels, specimens that are not available will not be included.
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Support for Labelscape-generated Barcodes
The Labelscape LDMS-supported barcode is a data matrix 2D barcode that
includes the ID1/PID & specimen date in the barcode.

In LDMS, there are two ways of scanning Labelscape barcodes. One method
is to scan a barcode in Specimen Management and search for primary
records. Another method is to scan a label into Quick Add which will populate
the PID and specimen date.

Generating labels
While labels can be generated from many places, the Print Labels page
allows you to generate labels from multiple sources.

Background

If you want to generate labels, you generally want to do so on either the
Specimen Management, Storage, or Shipping page. On these pages, you
can create labels for a specific participant, a particular shipping or storage
container, or an individual shipment. These are the most common scenarios
for which you will need to generate labels. You can also choose to upload a
list of unique specimen IDs, which will set a specimen criteria to locate any
sample with a unique specimen ID appearing in the list.

There may be times where you need to generate labels from a variety of
sources. For example, you may want to print labels for all specimens received
on a specific day.
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Figure 54: The label generation page

Note:

Labels can be generated for up to 500 specimens.

Steps

1. On the navigation bar, hover over Labels, and then click Print
Labels.

2. Optional: At the top of the Print Labels page, use filters to narrow
down the list of specimens displayed.

3. For each specimen you want to print a label, select the check box in
the Selected column.

4. Optional: Use dropdown next to Sort Order to specify the order in
which labels are generated. This option is also available in the Print
Labels window.

5. Click Print Labels.
6. In the Print Labels window, select the following.

Option

Project Only shown if specimens from
different projects were selected.
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Option

Use Defaults If the project has a default label
format defined, selecting this
check box will re-select that
default

Format The label format to use

Size The size of your label stock

Skip

Sort Order Order in which labels are sorted

7. Click Generate Labels.

A PDF with the labels will be generated, which may open or you may
be prompted to save it, depending on your browser's settings.

If generating labels for specimens from more than one project, a
check will appear in the Generated column for that project. Repeat
the previous steps with the next project.

Defining new label formats
You can create new label formats.

Steps

1. In the menu bar, hover over Labels, and then click Define Custom
Labels.

2. Optional: Use the Project and Format lists to select a label as the
basis for your new label.
This is not needed if you want to create a new label from scratch.

3. Click Create Format.
4. In the Name box, enter a name for your new format.

If your new label format is based on an existing format, you must also
select the check box next to Copy Fields.

5. Click Create Format.

Result
Your new label format will be created and will be available for selection.

After you are finished
You will want to customize your new label format and define the information
that will appear on it.
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Customizing label formats
You can customize that information that appears on label formats created by
your laboratory.

Background

New label formats are blank when they are created. You must customize
the format to show the information that you want displayed. New labels
and existing labels are modified the same way. Only label formats that your
laboratory created can be modified. Label formats that are pre-defined in
LDMS cannot be changed.

Figure 55: The label modification page

Steps

1. In the menu bar, hover over Labels, and then click Define Custom
Labels.

2. In the Project and Format lists, select a locally defined project and
label format.

3. Click Modify Format.
4. Modify the label format as needed.

• To change the barcode options, select from the Barcode dropdown.
There are various 1D and 2D options for the user to define.

• To add a field to a label, select a box from the Fields section where
you want the information to appear. Select an item from the list
below the Fields section, and then click Set Field.
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• To remove a field, select it from the Fields section, and then click
Clear Field.

5. Click Modify Format.

Setting the default label format for a project
The default label format and stock size can be set for individual projects.

Background

This means that when you print labels for that project, the default format and
size will automatically be selected. If you typically use the same format and
size for a specific project’s labels, then you can save time by defining these
defaults.

Steps

1. On the navigation menu, hover over Labels, and then click Default
Label Setup.

2. In the Project box, select the project to set defaults.
3. In the Format box, select the applicable default label format.
4. In the Label box, select the applicable default label stock size.
5. Click Add Default.
6. Click Save to save the changes.

Test Results

Test Results
The Test Results page is where you can manage test results from the
various available assays. The application captures the complete audit history
of test runs. The Test Results page shows all test runs for the lab, users can
access this history and view the run from each phase.

Figure 56: Test Results Page

Users can create, edit, and delete committed and uncommitted test results on
the Test Results page.
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When viewing the Test Results page, you'll notice two main features on the
page. First is the Main Window, second is the filters window. There is a third,
less noticeable yet incredibly useful feature, and that is the Add Pending
Results bar. We’ll examine these features one by one after a note on assays
themselves.

Test Supported in LDMS
Below is a list of all tests supported in LDMS:

• Abbott RealTime HIV-1 RNA
• Abbott SARS-COV-2
• COBAS TaqMan HCV
• COBAS TaqMan HIV-1
• COBAS TaqMan HIV-1 Qual
• PK Assay

Running an assay means reading data
The method of getting assay data into LDMS will vary, depending on the assay
and available equipment at your laboratory. There are two ways to get assay
data into LDMS:

1. Read an output file that was created when the assay was run
2. Enter the assay results data by hand

LDMS does not really run your assay; it is more accurate to say that LDMS
reads assay data, and then stores it. Reading assay output using LDMS is also
sometimes referred to as "resulting" an assay in LDMS, since the intent is to
get assay results into LDMS's database for long-term storage.

Test Results page
The Test Results page is where you can access all test result runs and create
new runs.
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Figure 57: Test Results Main Window

Column Description

Run ID ID number assigned automatically

Test name Name of assay selected when run was created

Run date Date that the assay was run (or is expected to
be run)

Tech Initials The assay technician who ran (or will run)
the assay; not necessarily the data entry
technician

Status Current status of the run

Locating assay runs
Additional filters are available for locating assays on the Test Results page.

In additional to the regular filters, Test Results Filters are available on the
Test Results page. These provide additional filters specifically for assays,
such as locating tests by assay name.

Note:  Deleted tests are not displayed by default. To see them, you
must apply a Status filter set to Deleted.

Censor Codes
Censor codes can be assigned to specimens, controls and assay runs to
indicate an issue or special condition.

For example, a censor code might indicate a contaminated specimen or
equipment failure. User censors are those that are added by a user. System
censors are those that are added automatically by LDMS when certain
conditions are met.

There are two types of user and system censors:
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specimen
censors

These censor a single specimen on a run; other
specimens on the run are unaffected.

run censors These censor the results of an entire assay run. They
indicate that something went wrong with the entire test.

Run Statuses
Each run has a status that indicates what state the run is at and what action
is needed next.

Status Meaning

Pending The run has been created, but is awaiting data
entry (or data entry is in progress)

Completed Data entry is complete, but the run has not
been reviewed

Reviewed Data entry is complete and the run has been
reviewed

Deleted Run was created in error and has been
removed. (Deleted runs are not displayed by
default. You must apply a Test Results Filter
for Status as Deleted to see them.)

Creating New Test Result Runs
Adding assays results involves selecting specimens that were tested,
uploading a results file, and then matching results to specimens.

Background

There are some differences between supposed assay, such as additional
assay-specific fields.

You can create an assay run and then click Save without adding specimens or
results. The run will be saved with the status of pending and can be updated
later.

Steps

1. From the LDMS menu, click Test Results.
2. From the action menu, click Add Pending Results.
3. In the Test Name box, select an assay, and then click Continue

! Warning:  The assay cannot be changed later. If the wrong
assay was selected, the run must be deleted and a new run
created.

4. On the General tab, complete the details of the run.

Field Usage

Run Date The date that the test was run in the
laboratory
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Field Usage

Tech Initials The initials of the laboratory technician
who completed the test

Data Transfer Tech The initials of the person entering this
data into LDMS

Note:  Additional fields specific to the selected assay may also
be displayed.

5. Click the Results tab.
6. (If needed) To add controls to the run, click Add Control.
7. Click Add Specimens.

Use the filters to narrow down the list of specimens. You can also
upload a list of unique specimen IDs.

Tip:  Under Specimen Filters, there is a filter for Assigned
Test. If you set the anticipate test for specimens when entering
new specimens in LDMS, you can use this filter to quickly find
and add specimens to test runs.

8. Optional: To add additional specimens to the run that have not been
entered into LDMS click the arrow next to Add Specimens, and then
click Add non-logged specimens.
You can enter any global specimen ID for non-logged specimens
for the purposes of matching assay results, however non-
logged specimens will not be available to view on the Specimen
Management page; they are only found in this assay run.

9. Optional: Set Dilution. Some tests allow you to indicate if a specimen
was diluted before being tested. The dilution will default to 1 for each
specimen. If the specimen was diluted you can change this value as
needed. For example, a dilution of 1:5 should be entered as dilution=
5. A dilution of 1:20 should be entered as dilution= 20.

Note:  LDMS will adjust the final result according to the dilution
and the adjusted final result will be reflected on any test result
reports. This does not apply to the PK test.

10. Click Upload File, and then select your assay results file.

LDMS will attempt to match results in your file to specimens added to
the run based on global specimen ID, other specimen ID, or ID1.

Note:  If any results were matched incorrectly, you can drag
and drop them to the correct specimen, or drag and drop them
into the Unmatched Results from File section to remove
them.

11. (If necessary) Match unmatched results to specimens.
Click and drag unmatched results in the Unmatched Results from
file section to appropriate specimens.

12. (If necessary) To manual change a result, select the result, and then
click Set Manual Result.

13. Do one of the following:
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• To save the run and change the status to complete, click
Complete.

• To save the run and change the status to pending, click Save.

Adding Cryopreservation Test Results
One of the test results is the Cryopreservation test. This feature allows the
IQA lab to assign confirmatory post-thaw results to cryopreserved specimens
and is only available at the IQA lab.

1. Under the Test Results dropdown, click Test Results.
2. From the action menu, select Add Pending Results The Select Test

window will open.
3. From the Test Name dropdown, select Cryopreservation and click

Continue.
4. On the General tab, define information about the test.
5. On the Results tab, add specimens that are already in LDMS by using

the Add Specimens button. The user can also add specimens from a file
using the Upload File button.

6. To save the test and complete it later, click Save.
7. To complete the test, click Complete.

Assigning Results to Blinded Controls (Pellets)
Note:  The steps below apply only to the TaqMan Qual assay.

1. On the Test Results page, select Add Pending Results from the Add
New... drop down.

2. Select the COBAS TaqMan HIV-1 Qual from the Test Name drop down.
3. Choose either the 24 or 48 radio button for the Number of Items.
4. Click Continue.
5. In the Results tab, choose pellets from the Select Pellet drop down.
6. Fill out the remaining field and click Complete.

Note:  Pellets can only be consumed once and will no longer be
available once used.

Reviewing a Run
Once a run has the status of completed, it must be reviewed for quality
control purposes.

Background

Runs should typically be reviewed by someone other than the Data Transfer
Tech who entered the results. The reviewer can check the calculated results,
pass-fail status of specimens and the run, and apply censors as needed.

Note:  The review process should vary by project and assay. It is
recommended that your laboratory have documentation or written
procedures in place for this process.
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Steps

1. From the LDMS menubar, click Test Results.
2. Locate the completed run of interest.

Use Test Results Filters to help locate the run.
3. Next to the run, click Edit.
4. Review the results.

Consult any procedures or documentation applicable to your
laboratory to complete this review.

5. (If applicable) Apply censor codes.

To apply a censor to a specimen, locate the specimen, and then in the
User Censor column, select the censor.

To apply a censor to the entire run, on the General tab, in the User
Censor box, select a censor.

For details about a censor, hover over it with the mouse pointer.

System censors are automatically applied and cannot be removed.
6. On the General tab, complete the Review Date, Reviewer Initials,

and (optionally) Reviewer Comments boxes.
7. Click Review.

Test History
Test results can be changed between completed and pending statuses. It is
possible to view a snapshot of test results at the time the status changed.

To view the test result history, on the Test Result page, locate the run. Next
to Edit for that run, click the arrow, and then click View History. Next to the
even, click View to see the run at that point in time.

Only certain events are shown in the history. For example, making changes to
a run while its status is pending will not be shown in the history.

Deleting assay runs
Assay runs that were erroneously created can be deleted.

Background

Deleted runs are not shown by default on the Test Results page. To display
them, in the Test Results Filters, set the Status filter to Deleted.

Steps

1. On the Test Results page, locate the run to be deleted.
2. Click the arrow next to the run's Edit button, and then click Delete.
3. Verify that the run you are about to delete is the correct run.
4. Complete the History Date, History Tech Initials, and History

Comments boxes.
The comments should indicate why the run is being deleted.
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5. Click Delete.

Restoring deleted runs
If an assay run is deleted in error, it can be changed back to pending without
data loss.

Steps

1. On the Test Results page, in the Test Results Filters, set the
Status filter to Deleted.

2. Locate the run to be restored.
3. Click the arrow next to the run's Edit button, and then click Reset to

Pending.
4. Complete the History Date, History Tech Initials, and History

Comments boxes.
5. Click Reset.

Test result reports
Several tests can be run for assay result runs.

All reports are run by clicking the arrow next to the Edit button next to the
run, and then clicking the desired reports.

Report Purpose

Completed Test Run Report Shows details of the specimens on a run,
including plat positions, result filename, results
for each specimen, and other result details.

Participant Report Provides detailed results broken down by
participant and specimen (one per page)

Pending Test Results Report Shows details about specimens on the run
and where they are located on testing plates
(useful for setting up equipment to match a
run already set up in LDMS).

Entering PK Test Results
Users can enter PK test results by navigating to the Test Results tab, clicking
the Test Results module, selecting a test, and then clicking Edit.
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Figure 58: Editing Test Results - General Tab

On the General Tab, the user must define some required information about the PK Test run, including (1) a Run Date,

(2) Assay Name, (3) Run Type, and (4) Analytes. (5) The user may optionally add a Control Lot to a run.

Assay Name:  The Assay Name is a free entry field that the user can define.
This name will be used to group assays together on certain reports and in the
PK Control Charting Module.

Run Type:  Certain Run Types are used for different scenarios. For example,
Routine and Routine/Proficiency are used to report network results whereas
Calibration and Stability may be used when validating a new method.

Add Analyte: When adding an analyte the user may choose to add these
individually for each run or they can select an Analyte Setup that was
previously defined in the PK Templates module.

Note:  The analyte setup can be modified for each run and for each
item on the run. For example, a PK Template may have defined the
analyte range as 10-1,000 but a special run today may need the
range to be 100-100,000. The user can modify the range for any run
as needed. Individual specimens and controls may also need range
adjustments. For example a specimen analyte range may use ng/mL
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but the controls may use a range in ng/sample. The LDMS will allow the
user to change the limits for each individual item on the Results tab.

Add Control Lot:This will allow a user to add a Control Lot to this run. The
user can either add a predefined set of controls created in the PK Control Lots
module or, if a preset lot of controls have not previously been defined in the
PK Control Lots module, the user can create it for this individual run. If the
user chooses to not add or create the entire lot of controls here, they can add
individual controls on the Results tab.

Figure 59: Editing Test Results - Results Tab

On the Results Tab the user can (1) add individual controls, (2) add specimens, (3) change the result grid to allow

editing of the limits for each individual item, (4) review, define, or edit the limits, target, or range of each control and

specimen

Add Control:  The user can click Add Control to add additional controls to
this run. Even if the user added a Control Lot on the general tab they can use
this feature to include additional controls now.

Add Specimens:  The user can choose to add specimens onto this run.

Note:  Dilution will default to 1 for all specimens added to a PK Run. If
the specimen was tested with a dilution the user can choose to change
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the value here. Any result that has a dilution modified from 1 will be
assigned a U censor.

Specify Limits Per Specimen:  If any specimen on the run needs to use a
limit range other than what was defined at the analyte level this option can be
used to change the limit for each individual specimen.

Setting Limits in the Result Grid: The user can set the Target and +/- for
each control or they can set a specific Lower and Upper limit. If the user has
checked to Specify Limits per Specimen they can also set the lower and upper
limit for each specimen.

Note:  If a specimen was diluted the LDMS will account for the dilution
when comparing the input result to the limits. The user should not
change the standard limits for a specimen to account for dilution as the
LDMS will do this automatically.

Important:  If a result was not obtained for a specific specimen, leave
the result field for that row Blank/Null. LDMS will allow the user to
apply a User Censor to this result when Reviewing the run. Leaving a
result Blank/Null may be necessary in scenarios such as a template
including an analyte that was not tested for, a sample on the run having
insufficient volume, or an issue in interpreting the final result.
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Figure 60: Editing Test Results - Results Tab (Continued)

After the run setup is complete and results are available, the user can set these results on the Results tab by (1)

uploading a file, (2) auto matching or drag and drop matching file results to the results grid, or (3) by skipping result

file upload and manually setting results.

Upload File:  An example PK assay test result file is shown below.
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Figure 61: Example PK Assay Test Result File

When uploading a result file the LDMS expects (1) a file that has a defined ID. The ID in the file will auto match to

LDMS based on (2) the Control Name, (3) Global Specimen ID, Other specimen ID, or ID1 value. The LDMS also

expects a result column named (4) as the Specific analyte being tested for.

Unmatched Results From File: Any result from the file that could not be
automatically matched to an item on the run in LDMS will be available in this
grid to drag-and-drop to match.

Manually Setting Results: If a file is not used or if the LDMS contains more
results than are found in the result file, the user can manually enter results to
LDMS by typing directly into the field.

Note:  Results from diluted specimens must be entered to LDMS pre-
calculated to account for dilution. LDMS will not change the input result
to account for dilution. LDMS will adjust the limits based on dilution for
purposes of calculating the A and B censors but LDMS expects the user
to input the final result pre-calculated to account for the dilution.

Completing PK Test Results
After all required information has been defined for a run the user may click
Complete. When clicking complete, the LDMS will calculate system censors
such as A- above upper limit, B- below lower limit, and U- specimen diluted.
The LDMS will also verify any controls on the run fall within the expected
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range and may set a pass/fail censor for the run depending on the success of
any defined controls.

Reviewing a PK Test Run
When reporting PK Test results for certain network specimens, the networks
expect the run to pass a Review. After completing the run, the application
allows for the run to be reviewed from the main test results grid and set
information such as Reviewer Initials, Reviewed Date, Review Comments, and
define user censors.

PK Control Lots
The PK Control Lot Module allows the user to pre-define the details of a
control or calibrator lot in advance of using them on a run. Once a lot is added
in the PK control lots module, it will be available in the Test Results module
to quickly and easily place on any PK Assay runs for which it is used. When
initially added to a specific run in the Test Result module, the lot will default to
the details defined here.

Figure 62: PK Control Lots

(1) QC and Calibrator radio buttons, (2) choose existing PK lot, (3) add new PK lot, (4) make copy of PK lot, (5) add

new calibrator/control, (6) list of calibrators/controls, (7) delete calibrator/control, (8) add new analyte, (9) list of

analytes, (10) delete analyte, (11) save lot, (12) delete lot

Adding a New Lot
1. Select QC or Calibrator.
2. Click Add New.
3. Enter the following information:
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3.1. Lot Number
3.2. Creation Date
3.3. Expiration Date
3.4. Storage Temperature
3.5. Derivative/Matrix Type

4. To add a control/calibrator, do the following:

Note:  If the user selected QC in the first step, they will have the
ability to add a control. If the user selected Calibrator in the first
step, they will have the ability to add a calibrator.

4.1. Click Add New in the Controls/Calibrator section.
4.2. Select a control/calibrator from the dropdown.
4.3. Enter a custom name for the control/calibrator.

Note:  When matching results from an uploaded file, the
LDMS will first try to match using this Custom Name.

4.4. Repeat step 4 as needed for additional controls/calibrators.
4.5. To delete a control/calibrator, click the Delete button next to it.

5. To add an analyte, do the following:

5.1. Click Add New in the Analytes section.
5.2. Select an analyte from the dropdown.
5.3. Enter a unit.
5.4. Enter a target.
5.5. Enter a +/-%.

Note:  LDMS will calculate the Target Min and Target Max.
If necessary, these values can be modified for clarity during
run set up when using this lot.

5.6. Repeat step 5 as needed for additional analytes.
5.7. To delete an analyte, click Delete next to the analyte.

6. Click Save Lot.

Editing or Deleting a Lot
To Edit an existing lot, do the following:

1. Select QC or Calibrator
2. Select the lot from the dropdown.
3. Optional: a lot can be copied by clicking Make Copy.
4. Edit the lot information, controls/calibrators, and analytes as needed.
5. Click Save Lot.

To Delete a lot, select it and click Delete Lot.

PK Control Charting
The PK Control Charting module allows the user to report on specific PK
Control or Calibrator lots to review their details over time. Various reports
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are made available for the user to run, including Inter-Day Average Back
Calculated Calibration Standards, Stability, Accuracy and Precision, and
more. Generation of these reports requires a user to first define PK Control or
Calibrator lots in the PK Control Charting Module and to then also make use of
these lots on PK Assay runs in the Test Results Module.

Note:  In some scenarios the LDMS may be unable to generate PK
Control Charting reports if the user chose to modify or manipulate
certain lot details that result in mathematical queries and equations
that cannot be properly executed.

Figure 63: PK Control Charting

(1) select Analyte, (2) QC and Calibrator radio buttons, (3) Lot Number, (4) Min Run Date and Max Run Date, (5)

Selected runs, (6) report type to generate, (7) report file type, (8) Generate Report

Generating a Report
1. Enter the following information:

1.1. Select an analyte from the dropdown.
1.2. Select Lot Type (QC or Calibrator).
1.3. Select Lot Number from the dropdown.
1.4. Add Min Run Date and Max Run Date.

2. Tick boxes next to runs to include them in the report.
3. Choose the type of report to generate from the Report Type dropdown.
4. Select a file type for the report.
5. Click Generate Report.
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PK Templates
PK templates are predefined, specific analyte scenarios that can be used to
help set up a Pending Test Results. Templates can be created for PK analyses
that happen frequently for a specific set of analytes. Templates can be
created and modified by users. User-created templates are only available at
the laboratory where they were created; they are not sharable with other
laboratories.

Figure 64: PK Templates

(1) Currently selected template, (2) add a new template, (3) template name, (4) add new analyte, (5) delete selected

analyte, (6) save template, (7) delete template

Adding a New Template
1. Name the template in the Name field.
2. Add analytes:

2.1. Click Add Analyte.
2.2. Select Analyte and Unit.
2.3. Optional: Add Upper Limit and Lower Limit.
2.4. To delete an analyte, click the Delete button.

3. Click Save Template.

Updating an Existing Template
PK Templates can be modified at any time, even if they have previously been
used on a live test run.

Note:  PK Templates can be selected for use on a live test run and be
further modified to meet the needs of that specific run. For example,
additional analytes can be added or removed, the limit units can be
changed, or the specified upper or lower limit can be updated as
needed for the live run.

1. Select the template from the drop down menu.
2. Update the name or analyte information as needed.
3. Click Save Template.
4. To delete the template that is currently open, click Delete Template.
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Data Submission
The Data Submission Module is used to upload data files to Frontier Science
within web LDMS without having to log into the Portal or other Frontier
Science systems. This is accessed through the Data Submission menu.

Note:  Users must contact Frontier Science if access to this module is
needed.

Figure 65: The Data Submission Page

(1) The dropdown list used to create new data submissions. (2) The View/Edit button used to edit data submissions. (3)

Filters to narrow results.

Adding Submissions
To add a data submission, follow the steps below.

Steps

1. From the menu bar, click Data Submission, and then click Data
Submission.

2. In the Actions dropdown menu on the left side of the screen, click
Upload Files. The Choose Files to Upload window will appear.
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3. Add the submission name to the Submission Name field.
4. Select the Project, ID2, and Data Type from the dropdown menus.
5. Add any comments as needed.
6. Below the Comments text box, click the Select Files button.
7. Select the necessary files.
8. To remove selected files, click Remove Files.
9. To complete the submission, click Upload Files.

Editing Submissions
To edit a data submission, follow the steps below.

Steps

1. From the menu bar, click Data Submission, and then click Data
Submission.

2. To make changes to submissions, click View/Edit next to the
submission in question. The Edit Submission Group window will
appear.

3. Make any changes to the project, ID2, Data Type, or Comments as
needed by using the appropriate dropdown menus.

4. Files in the submission can also be downloaded individually by clicking
the Download button next to the file in question at the bottom of the
window.

5. Click Save.
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Data Submission Filters
Filters can be applied to narrow results in the Data Submission menu.

Background

The following filters are available for the Data Submission module:

• Users
• Data Type
• File Name
• Project
• ID2 Upload Date

Select any filters as needed and click Add.

Printers
This section will describe how to setup various printers that are known to
work with LDMS.

Setting up the Brady IP300 printer
These instructions will help ensure that your printer is set up to work correctly
with LDMS.

Prerequisites

• Install the driver for your printer. For assistance obtaining and installing the
driver, contact your laboratory’s local IT department or the manufacturer’s
customer support.

Background

This printer is known to work with the following label and stock settings in
LDMS:

label stock THT-183-461

LDMS label Barcode label 7

Steps

1. Open the printer settings from the Windows Start menu.
These are typically found in Start > Devices and Printers.

2. Right-click the IP300 icon, and then click Printing preferences.
3. Click Advanced.
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4. Next to Paper Size, click Properties.
5. In the Paper Size box, select the appropriate paper size.
6. On the control panel in front of the printer, change the printer head to

+10mm for the X axis and -3.0mm for the Y axis
These head adjustments have been tested with the THT-183-461
label stock. Other label stocks may require different printer head
adjustments.

Setting up the Brady® MVP 300 printer
These instructions will help ensure that your printer is set up to work correctly
with LDMS.

Steps

1. Open the printer settings from the Windows Start menu.
These are typically found in Start > Devices and Printers.

2. Right click the icon for your printer, and click Printing preferences.
3. Set the stock size.

3.1. Expand the Paper/Output settings
3.2. In the Paper Size box, select User Defined.
3.3. Click Customize.
3.4. In the Width and Height boxes, entered the dimensions of your

label stock.
3.5. In the Unit of Measure box, select Inches.
3.6. Click OK.

4. In the Devices and Printers window, right click the printer icon, and
click Properties.

5. On the Printer tab, change the following settings:
5.1. In the Device Options > Head Settings > Print Darkness

section, change the Print Darkness setting to 22.
5.2. In the Speed Settings, enter the following settings:

Print speed 2.00 in/sec

Slew speed 2.00 in/sec

Back feed
speed

2.00 in/sec

6. On the Ports tab, click Configure Port and enter the following
settings:

Bits per
second

115200

Data bits 8

Parity None
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Stop bits 1

Flow control Xon/Xoff

7. Configure the printer hardware.
7.1. Open the printer and remove the protective plate that is covering

the ribbon sensor.
7.2. Slide the transmissive sensor protector to the outside of the

adjustable transmissive sensor.
7.3. Place the ribbon on the ribbon supply spindle.

Note:  The shiny side of the ribbon must be facing up.

7.4. Feed the ribbon through the ribbon sensor and around the print
head assembly.

7.5. Wrap the ribbon around the ribbon take-up spindle until it is
tight.

Tip:  Attach a piece of tape to the end of the ribbon to
help keep it tight during the loading process.

7.6. Place the labels on the media supply spindle.
The printable side of the label must be face-up.

7.7. Place the labels through the media guide and align the notch
between labels with the tear-off plate of the printer.

7.8. Adjust the ribbon sensor so that the notch of the label will cross
the ribbon sensor.
The ribbon sensor is the red light under the label.

7.9. Close the print head and ensure that the ribbon is aligned with
the left side of the label.
This adjustment may require you to slide the ribbon across the
print head assembly.

7.10.Close the printer.
8. On the control pad on front of the printer, do the following:

8.1. Press the Setup/Exit button.
8.2. Press the + button until the printer displays Manual Calibrate.
8.3. Press the Select button.
8.4. Press the + button.

The printer will re-calibrate its label settings.
8.5. Press the Setup/Exit button, and then press the + button to

save the changes.

Setting up the LabXpert printer
These instructions will help ensure that your printer is set up to work correctly
with LDMS.

Steps

1. Open the printer settings from the Windows Start menu.
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These are typically found in Start > Devices and Printers.
2. Right click the icon for your printer, and click Printing preferences.
3. Expand the Paper/Output settings, and click Properties text to

Paper Size.
4. In the Paper Size box, select the appropriate paper size.
5. In the Devices and Printers window, right click the LabXpert icon,

and click Properties.
6. On the Ports tab, enter the following settings:

Bits per
second

115200

Data bits 8

Parity None

Stop bits 1

Flow control Xon/Xoff

7. Configure the printer to accept input from your LDMS computer.

Important:  This step must be completed every time the
printer is turned on.

7.1. On the printer, press the Menu button.
7.2. Press the Next button three times.
7.3. Press the PC button.

After you are finished
After the printer is set up, you should print a set of test labels to ensure that
it is working correctly.

Setting up the Zebra® GX 430t printer
These instructions will help ensure that your printer is set up to work correctly
with LDMS.

Prerequisites

• Install the driver for your printer. For assistance obtaining and installing the
driver, contact your laboratory’s local IT department or the manufacturer’s
customer support.

• Load the printer with label stock and ribbon according to the printer’s
manual.

Steps

1. Open the printer settings from the Windows Start menu.
These are typically found in Start > Devices and Printers.

2. Right click the icon for your printer, and click Printing preferences.
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3. On the Options tab, change the Speed to 2.
4. Change the Print Darkness to about 27.

This setting should be adjusted up or down, depending on whether
labels are too light or too dark.

5. In Paper format, select inches.
6. In Paper Size, set the Width to 4.00 and the Height to 1.75.
7. On the Advanced Setup tab, click Calibrate.
8. On the Advanced Setup tab, verify that the Tracking Mode is set to

Web Sensing.

After you are finished
After the printer is set up, you should print a set of test labels to ensure that
it is working correctly.

Setting up the Brady BBP11-34L printer
These instructions will help ensure that your printer is set up to work correctly
with LDMS.

Background

This printer is known to work with the following label and stock settings in
LDMS:

label stock THT-183-461-0.5-SC

LDMS label Barcode Label 9

Steps

1. Open the printer settings from the Windows Start menu.
These are typically found in Start > Devices and Printers.

2. Right click the icon for your printer, and click Printing preferences.
3. On the Page Setup tab, under Stock click New.
4. Enter the dimensions 1.75″ × 1.00″.

These are the dimensions for the THT-183-461-0.5-SC label stock. If
you are using a different stock, enter the appropriate dimensions.

5. Click Advanced Options, and verify that the horizontal and vertical
offset options are set to 0″.

6. On the Stock tab, enter the following into the Media settings:

Method Thermal transfer

Type Labels with marks

Mark height 0.08 in

Mark offset 0.00 in
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7. On the Options tab, enter the following into the Printer options:

Print speed 2.00 in/sec

Darkness 10

8. Click OK.

After you are finished
After the printer is set up, you should print a set of test labels to ensure that
it is working correctly.

Setting up the Brady® BBP33 printer
These instructions will help ensure that your printer is set up to work correctly
with LDMS.

Prerequisites

• Install the driver for your printer. For assistance obtaining and installing the
driver, contact your laboratory’s local IT department or the manufacturer’s
customer support.

Background

This printer is known to work with the following label and stock settings in
LDMS:

label stock B33-179-482 (1″x1″)

LDMS label Barcodelabel19

Steps

1. Open the printer settings from the Windows Start menu.
These are typically found in Start > Devices and Printers.

2. Right click the icon for your printer, and click Printing preferences.
3. Click Advanced.
4. Next to Paper Size, click Properties.
5. In the Paper Size box, select the appropriate paper size.
6. In LDMS, set the printer as your label printer.

After you are finished
After the printer is set up, you should print a set of test labels to ensure that
it is working correctly.
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Setting up the Brady BMP53 printer
These instructions will help ensure that your printer is set up to work correctly
with LDMS.

Prerequisites

• Install the driver for your printer. For assistance obtaining and installing the
driver, contact your laboratory’s local IT department or the manufacturer’s
customer support.

Background

This printer is known to work with the following label and stock settings in
LDMS:

Cartridge M-156-492

LDMS label Barcode Label 16

Steps

1. Open the printer settings from the Windows Start menu.
These are typically found in Start > Devices and Printers.

2. Right click the BMP51(53) icon, and click Printing preferences.
3. Click Advanced.
4. Next to Paper Size, click Properties.

After you are finished
After the printer is set up, you should print a set of test labels to ensure that
it is working correctly.

Setting up the Brady BP-PR 300 printer
These instructions will help ensure that your printer is set up to work correctly
with LDMS.

Prerequisites

• Install the driver for your printer. For assistance obtaining and installing the
driver, contact your laboratory’s local IT department or the manufacturer’s
customer support.

Steps

1. Open the printer settings from the Windows Start menu.
These are typically found in Start > Devices and Printers.

2. Right click the Brady PR 300 PLUS icon, and click Properties.
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3. In the Size section, change the Width and Height to the size of your
label stock.

After you are finished
After the printer is set up, you should print a set of test labels to ensure that
it is working correctly.

Setting up the Zebra ZD620 Printer
These instructions will help ensure that your printer is set up to work correctly
with LDMS.

Prerequisites

• Install the driver for your printer. For assistance obtaining and installing the
driver, contact your laboratory’s local IT department or the manufacturer’s
customer support.

• Load the printer with label stock and ribbon according to the printer's
manual.

Steps

1. Open the printer settings from the Windows Start menu.
These are typically found in Start > Devices and Printers.

2. Right click the icon for your printer and click Printing Preferences.
3. On the Print Options tab, change the Speed to 4. This setting should

be adjusted accordingly.
4. Change the Print Darkness to about 20. This setting should be

adjusted up or down, depending on whether labels are too light or too
dark.

5. In the Page Setup, set the Width and Height according to labels
used. Ex.: Width: 2.75" Height: 1"

After you are finished
After the printer is set up, you should print a set of test labels to ensure that
it is working correctly.

Setting up other printers
Label printers that do not have specific instructions provided in this manual
may still work with LDMS, however they will not have been tested by LDMS
User Support.

Steps (completed in any order)

• Contact LDMS User Support for assistance.
• Consult the most current list of supported printers.
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• If you are using a printer not listed in this manual, let LDMS User Support
know so that it can be added.

Preset projects
Preset projects are projects that are built into LDMS that have special rules
and requirements.

Preset projects and their requirements cannot be modified or removed
by users. These projects and designed based on the needs of a specific
project working with Frontier Science. An example of a preset project
is ACTG/IMPAACT. Specimens created until this project have specific
requirements, which are defined by ACTG and IMPAACT. These requirements
are implemented in LDMS to accommodate the needs of the project.

The rules for preset projects fall into two categories:

• Validation rules that can be enforced by LDMS, such as requiring that ID1
be formatted a certain way

• Requirements that cannot be enforced by LDMS, such as requiring
specimens to be entered within a certain period of time after they are
received by your laboratory.

Important:  The information for individual projects provided here are
for convenience only. Always refer to guidance provided by the project
for the most up-to-date instructions.

ACTIV
The ACTIV (Accelerating COVID-19 Therapeutic Interventions and Vaccines)
preset project must meet these requirements.

Data entry requirements

Field Required? Note

ID1 (PID) Required Must be 9 numeric digits

ID2 (Study) Required "ACTIV2" in ID2 field; not editable

ID3 (ID3) Optional Warning generated if other spec ID is blank

Visit Required --

Clinic Optional --

Specimen Time Required --

Received Time Required --
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ACTG/IMPAACT
The ACTG/IMPAACT preset project has these requirements.

Data entry requirements

Field Required? Note

ID1 (PID) Required* 8 characters long, 7 numbers and one letter
between A and L; if the PID does not have 7
numbers, add leading zeros to the front of it.

*This requirement can be disabled by Frontier
Science for certain studies.

ID2 (Protocol) Required Select from the pre-defined list of protocols.

ID3 Optional LDMS will remember previously entered ID3s
and automatically populate ID3 when the same
project-PID-protocol combination is entered.

Visit Required Select from pre-defined list of visit units.

OPID Available --

Clinic Required LDMS will automatically populate the clinic
using one previously entered for the same PID,
protocol, and SID combination.

Specimen Time Depends If you do not have a specimen time recorded
on your CRF, contact the clinic that collected
the specimen from the participant. This field is
required for specimens with a specimen date
of 01 January 2004 or later; it is optional for
specimens prior to that date. This requirement
can be overridden for specimens after this
date, if necessary.

Received Time Optional --

Notes

• ACTG/IMPAACT uses the standard LDMS Shipping File format to ship
between ACTG and IMPAACT laboratories using LDMS.

• ACTG/IMPAACT requires specimens to be labeled with a 2D barcode and
label from LDMS; LDMS comes with label formats for ACTG setup and
ready to use.

• ACTG and IMPAACT are listed as a combined project throughout LDMS
(ACTG/IMPAACT).

• Preloads are permitted for the ACTG/IMPAACT project, but users are not
permitted to create their own. All ACTG preloads are created by Frontier
Science in collaboration with network leadership.

AERAS
The AERAS preset project has these requirements.
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Data entry requirements

Field Required? Note

ID1 (PID) Required 11-digits of any combination of letters and
numbers.

ID2 (Study) Required Selected from pre-populated list. Once
selected, the LDMS will check that the PID is
associated with the selected protocol.

ID3 Disabled This field is not used by Aeras

Visit Required Select from pre-defined list of visit units.

OPID Disabled This field is not used by AERAS

Clinic Required AERAS clinics are in the format ARSXX, where
XX are the 5th and 6th digits from the PID

Specimen Time Required --

Received Time Optional --

Notes

Quick Add templates can be used for Aeras.

AIEDRP
The AIEDRP preset project has these requirements.

Data entry requirements

Field Required? Note

ID1 (PID) Required Must either pass the ACTG/IMPAACT or HPTN
ID1 validation check, depending on the
protocol

ID2 (Protocol) Required Will determine what ID1 format should be used

ID3 (SID) Required Must be NOSID or pass the ID1 validation

Visit Required --

OPID Optional --

Clinic Optional --

Draw Time Optional --

Received Time Optional --

Protocol and ID1 check used

Protocol ID1 validation used

I03005 ACTG/IMPAACT

I03006 ACTG/IMPAACT

I03007 ACTG/IMPAACT
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Protocol ID1 validation used

I03008 ACTG/IMPAACT

I03010 Either

I03011 Either

CORE01 Either

AIN501 Either

AIN502 Either

AIN503 Either

AIN504 Either

AIS
The AIS (Nigeria State Level ART Impact Survey) preset project has these
requirements.

Data entry requirements

Field Required? Note

ID1 (PTID) Required Must be length 9. First 4 characters are letters
only and last 5 characters are numeric only
(e.g., ABCD12345)

ID2 (Country) Required "Nigeria" is the only available option

ID3 (HIVRT) Required Pick list of specific options

Collection Time Required --

Received Date and
Received Time

Required --

Clinic Required Must require the clinic be formatted like
NG### where the first 2 characters are the
letters NG and the next 3 characters are
numbers. (e.g., NG000 or NG031)

AMC
The AMC preset project has these requirements.

Data entry requirements

Field Required? Note

ID1 (ID1) Required --

ID2 (PROTOCOL) Optional --

ID3 (ID3) Optional --

Visit Optional --
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Field Required? Note

OPID Optional --

Clinic Optional --

Draw Time Optional --

Received Time Optional --

ATN
The ATN preset project has these requirements.

Data entry requirements

Field Required? Note

ID1 (PID) Required A 6-digit number between 10001 and 999999.
If the PID is less than 6 digits, leading zeros
will automatically be added. LDMS will check
that the PID is valid.

ID2 (Protocol) Required Must be a 3 digit number between 004 and
999

ID3 (SID) Required An 8-digit number between 40001 and
999999999. If the SID is less than 8-digits,
leading zeros will automatically be added. 7-
digit SIDs can still be imported by LDMS. If
the same PID-protocol combination has been
entered, LDMS will automatically default to the
previously used SID. NOSID is a valid entry for
ATN.

Visit Required Select from pre-defined list of visit units.

OPID Available --

Clinic Optional --

Specimen Time Required --

Received Time Optional --

Notes

Quick Add templates can be used for ATN.

BHP
The BHP preset project has these requirements.

Frontier Science Foundation 198



LS.0006 | LDMS for the Web - User Manual

Data entry requirements

Field Required? Note

ID1 (PID) Required 8 characters long, 7 numbers and one letter
between A and L; if the PID does not have 7
numbers, add leading zeros to the front of it.

ID2 (Study) Required The only available choice in the drop down
menu is 'Tatelo'.

ID3 (Step) Required Available choices in drop down menu are 0, 1,
2, or 3.

Visit Required Select from pre-defined list of visit units.

OPID Optional --

Clinic Required Any clinic may be set.

Specimen Time Required --

Received Date Required --

Received Time Required --

Notes

• User Quick Add templates are not permitted for BHP.

BM
The BM preset project has these requirements.

Data entry requirements

Field Required? Note

ID1 (studyID) Required Must be in the BM studyID format

ID2 (ID2) Optional --

ID3 (ID3) Optional --

Visit Optional --

OPID Optional --

Clinic Optional --

Draw Time Optional --

Received Time Optional --

BM ID1 format
BM-XXX-Y

BM Must be “BM”

XXX Any 3 digits

Y 0 for mother; 1 to 9 for child
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Botswana MOH
The Botswana MOH preset project has these requirements.

Data entry requirements

Field Required? Note

ID1 (PID) Required Requires 2 letters followed by 8 numbers.

ID2 (Study) Required Default option is IBBS3

ID3 (HIVRT) Required Select from a list of predefined HIV status
value

Clinics Optional --

Notes

• The application must allow FSTRF-defined preloads for this project.

Botswana MOH PID format
XXYYNNNNNN

XX District (alphabet, length 2)

YY KP type (numeric, length 2)

NNNNNN Participant (numeric, length 6)

CEMALB
The CEMALB preset project must meet these requirements.

Data entry requirements

Field Required? Note

ID1 (PID) Required Must be 5 characters

ID2 (Protocol) Required --

ID3 (Visit) Optional --

Visit Optional --

OPID Optional --

Clinic Optional --

Draw Time Optional --

Received Time Optional --
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CHAVI
The CHAVI preset project must meet these requirements.

Data entry requirements

Field Required? Note

ID1 (PID) Required Must pass HPTN ID1 validation and must be 9
characters in length

ID2 (Protocol) Required Validated using ID1, where ID2 is embedded
into ID1 as either the 4th or 4th and 5th digits,
depending on the protocol

ID3 (ID3) Optional --

Visit Required --

OPID Optional Must be empty until the protocol is 008A

Clinic Optional --

Draw Time Optional --

Received Time Required --

CIPRA-HT
The CIPRA-HT preset project has these requirements.

Data entry requirements

Field Required? Note

ID1 (PID) Required Must pass HPTN ID1 validation

ID2 (Protocol) Required --

ID3 (SID) Required Must pass the historical ACTG/IMPAACT ID3
validation

Visit Optional --

OPID Optional --

Clinic Required --

Draw Time Optional --

Received Time Optional --

CIPRA-ZA
The CIPRA-ZA project has these requirements.

Frontier Science Foundation 201



LS.0006 | LDMS for the Web - User Manual

Data entry requirements

Field Required? Note

ID1 (PID) Required --

ID2 (CP#) Optional --

ID3 (SID) Optional --

Visit Optional --

OPID Optional --

Clinic Optional --

Draw Time Optional --

Received Time Optional --

CIPRA
The CIPRA preset project must meet these requirements.

Data entry requirements

Field Required? Note

ID1 (PID) Required Must be 9 characters in the CIPRA ID1 format

ID2 (Protocol) Required In the format P[0-10]

ID3 (ID3) Optional --

Visit Required --

OPID Optional --

Clinic Optional --

Draw Time Optional --

Received Time Optional --

CIPRA ID1 format
AABBCCCCD

AA 01 to 99

BB 01 to 99

CCCC 0001 to 9999

D 0 to 9

CONTROL
The CONTROL preset project must meet these requirements.
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Data entry requirements

Field Required? Note

ID1 (CONTROLNAME) Required --

ID2 (PROTOCOL) Optional --

ID3 (ID3) Optional --

Visit Optional --

OPID Optional --

Clinic Optional --

Draw Time Optional --

Received Time Optional --

CoVPN
The CoVPN (COVID-19 Vaccine and Prevention Network) preset project must
meet these requirements.

Data entry requirements

Field Required? Note

ID1 (PATID) Required Study 3008 has a predefined ID1/PATID check.

ID2 (Study) Required --

ID3 (ID3) Optional --

Visit Required --

Clinic Required --

Specimen Time Required --

Received Time Required --

Notes

• Information for study CoVPN 5001 should be logged under VTN study
5001.

• Labels are restricted to all supported VTN formats.
• CoVPN has a checkbox for Collected Outside Protocol Requirements.

CPCRA
The CPCRA preset project has these requirements.

Data entry requirements

Field Required? Note

ID1 (PID) Required --
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Field Required? Note

ID2 (Study) Optional --

ID3 (Bth/Sex) Optional --

Visit Optional --

OPID Optional --

Clinic Optional --

Draw Time Optional --

Received Time Optional --

CPQA
The CPQA preset project has these requirements.

Data entry requirements

Field Required? Note

ID1 (PanelID) Required Must be five characters in length in the format
[Round_#][Panel_alpha_ID][2_numbers],
such as 22A00

ID2 (RoundNo) Required This is the same as the first 2 digits of the
PanelID. This field will automatically be
populated by LDMS.

ID3 (ExpDate) Optional --

Visit Optional Select from pre-defined list of visit units.

OPID Optional --

Clinic Optional --

Specimen Time Optional --

Received Time Optional --

Notes

• CPQA use the LDMS shipping file format
• There are CPQA barcode options available in LDMS.
• Quick Add templates can be used for CPQA, however users are not

expected to use this feature.
• The Pharmacology Proficiency Results report can be generated from

LDMS for Clinical Laboratory Improvement Amendments (CLIA). This is
sometimes referred to as the “CLIA Report”.

CP-CTNET
The CP-CTNET (Cancer Prevention Clinical Trials Network) preset project must
meet these requirements.

Frontier Science Foundation 204



LS.0006 | LDMS for the Web - User Manual

Data Entry Requirements

Field Required? Note

ID1 (PID) Required --

ID2 (Study) Required --

ID3 (ID3) Optional --

FACTS
The FACTS preset project has these requirements.

Data entry requirements

Field Required? Note

ID1 (PID) Required A 7-digit number. LDMS will verify that the PID
is valid.

ID2 (Study) Required Select from pre-populated list

ID3 Disabled This field is not used by FACTS

Visit Required Select from pre-defined list of visit units.

OPID Disabled This field is not used by FACTS

Clinic Disabled This field is not used by FACTS

Specimen Time Required --

Received Time Optional --

Notes

• Quick Add templates can be used for FACTS.

HN
The HN preset project must meet these requirements.

Data entry requirements

Field Required? Note

ID1 (studyID) Required --

ID2 (ID2) Optional --

ID3 (ID3) Optional --

Visit Optional --

OPID Optional --

Clinic Optional --

Draw Time Optional --
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Field Required? Note

Received Time Optional --

HPTN
The HPTN preset project has these requirements.

Data entry requirements

Field Required? Note

ID1 (PID) Required LDMS performs a checks to make sure the
PID is valid. Based on the protocol, LDMS will
determine whether a 9-digit or 10-digit PID
must be used.

ID2 (Protocol) Required Special PID checks are enforced if the protocol
is 043.0. For 043.0, the visit will also be
set to 2.0 VST, and the user will not be able
to modify it. This field allows dashes (e.g.,
084-01)

ID3 Optional Special ID3 checks are enforced if the protocol
is 043.0. For 043.0, this field allows up to 12
characters, and should be scanned from the
blood ID number.

Visit Required Defaults to the visit unit of VST. Interim,
unscheduled visits should be entered by
incrementing the visit value (e.g. 1.10 for the
first unscheduled visit, 1.20 for the second,
etc.). If the protocol is 043.0, the visit will also
be set to 2.0 VST, and the user will not be able
to modify it.

OPID Disabled --

Clinic Optional Any clinic may be set.

Specimen Time Required --

Received Time Optional --

Notes

• There are several HPTN label formats available.
• Primary and aliquot volumes with default to ML.
• Quick Add templates are not permitted for HPTN.
• Old records may have a clinic set retroactively if not set at the time of

entry

IDCRC
The IDCRC (Infectious Diseases Clinical Research Consortium) preset project
must meet these requirements.
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Data entry requirements

Field Required? Note

ID1 (PTID) Required LDMS checks that the PID is valid. Must
be 9 or 10 characters. A PID cannot be
changed without approval from VTN Laboratory
Leadership.

ID2 (Study) Required Drop down menu

ID3 (ID3) Optional --

Visit Required --

Clinic Required The clinic is automatically populated based
on the PID; the same clinical location can be
associated with multiple clinic IDs (e.g. for
Phase I/II or Phase II/III). IDCRC clinics start
with the letter V (such as V101 instead of
101). LDMS will verify that an IDCRC clinic was
selected.

Specimen Time Required --

Received Time Required --

IPREX
The IPREX preset project has these requirements.

Data entry requirements

Field Required? Note

ID1 (PID) Required Must by 5 to 7 characters long and a valid
IPREX PID; NOPID is a valid PID, unless the
SID is NOSID.

ID2 (Protocol) Required --

ID3 (SID) Required Must be 11 characters long, with the first
2 digits being the clinic and the last five
being the screening number in the range
80001-99999

Visit Required --

OPID Optional --

Clinic Required Must be 3 characters long in the format I[86 to
97] (such as I92)

Draw Time Optional --

Received Time Optional --

Notes

• IPREX using the LDMS Shipping File format.
• When entering sero-conversion visits, use the visit unit SC. The visit value

should be the same as the originally scheduled visit.

Frontier Science Foundation 207



LS.0006 | LDMS for the Web - User Manual

• When entering sero-positive visits, use the visit unit SP. The visit value
should be the number of weeks after the seroconversion visit.

IQA
The IQA preset project has these requirements.

Data entry requirements

Field Required? Note

ID1 (PID) Required --

ID2 (ID2) Optional --

ID3 (ID3) Optional --

Visit Optional --

OPID Optional --

Clinic Optional --

Draw Time Optional --

Received Time Optional --

IRC
The IRC preset project has these requirements

Data entry requirements

Field Required? Note

ID1 (PID) Required --

ID2 (Protocol) Required --

ID3 (SID) Required --

Visit Required --

OPID Optional --

Clinic Required --

Collection Time Required Only required if the collection date is after 01-
Jan-2004

Received Time Optional --

KENPHIA2
The KENPHIA2 preset project has these requirements.
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Data entry requirements

Field Required? Note

ID1 (PTID) Required Must be length 8. First 2 characters are letters
only (KE) and last 6 characters are numeric
only (e.g., KE123456)

ID2 (Country) Required "KENYA" is the only available option

ID3 (HIVRT) Required Pick list of specific options

Collection Time Required --

Received Date and
Received Time

Required --

Clinic Required Must be formatted like XX### where the first
2 characters are the letters KE and the next 3
characters are numeric (e.g., KE101)

MACS
The MACS preset project has these requirements.

Data entry requirements

Field Required? Note

ID1 (MACSID) Required MACS Identifier

ID2 (Study) Required --

ID3 Optional Previously entered ID3s will be automatically
populated by LDMS for the MACSID and study
combination

Visit Optional Select from pre-defined list of visit units.

OPID Optional --

Clinic Optional Previously entered clinics will be automatically
populated by LDMS for the MACSID and study
combination

Specimen Time Optional --

Received Time Optional --

Notes

• Quick Add templates are permitted for MACS.
• MACS shipments being sent to Precision Bioservices (formally SeraCare)

use the SeraCare shipping file format.

MATRIX
The MATRIX preset project has these requirements.
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Data entry requirements

Field Required? Note

ID1 (PTID) Required --

ID2 (Study) Required --

ID3 Optional --

Collection Time Required --

MAVRC
The MAVRC preset project must meet these requirements.

Data entry requirements

Field Required? Note

ID1 (PID) Required --

ID2 (Protocol) Optional --

ID3 (ID3) Optional --

Visit Optional --

OPID Optional --

Clinic Optional --

Draw Time Optional --

Received Time Optional --

MOSAIC
The MOSAIC preset project has these requirements.

Data entry requirements

Field Required? Note

ID1 (PTID) Required --

ID2 (Study) Required --

ID3 Optional --

Collection Time Required --

mStudy
The mStudy preset project must meet these requirements.
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Data entry requirements

Field Required? Note

ID1 (PID) Required 6 digit numeric format

ID2 (Study) Required Pre-populated with value = MSTUDY

ID3 (ID3) Optional --

Visit Required --

OPID Optional --

Clinic Required --

Draw Time Required --

Received Time Required --

MTCT
The MTCT preset project has these requirements

Data entry requirements

Field Required? Note

ID1 (PID) Required --

ID2 (Protocol) Optional --

ID3 (ID3) Optional --

Visit Optional --

OPID Optional --

Clinic Optional --

Draw Time Optional --

Received Time Optional --

MTN
The MTN preset project has these requirements.

Data entry requirements

Field Required? Note

ID1 (PID) Required 9 characters long

ID2 (Protocol) Required Select from a pre-populated list

ID3 Disabled Not used for MTN

Visit Required Visit unit defaults to VST, but this can be
overridden

OPID Disabled Not used for MTN
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Field Required? Note

Clinic Optional --

Specimen Time Optional This field is not required, but recommended

Received Time Optional This field is not required, but recommended

Notes

• Primary and aliquot volume will default to ML for MTN specimens.
• There are two label options available for MTN, one with a barcode and one

without.
• Quick Add templates are permitted for MTN.

MWCCS
The MWCCS preset project has these requirements.

Data entry requirements

Field Required? Note

ID1 (PID) Required 8 digits long

ID2 (Study) Required Select from a pre-populated list (e.g., MWCCS)

ID3 Optional --

Visit Optional --

OPID Optional --

Clinic Required Select from pre-populated list. Correct options
defined as XNNN (e.g., X206)

Specimen Time Optional This field is not required, but recommended

Received Time Optional This field is not required, but recommended

Notes

• The cross-LIMS shipping file format should be used for all shipments going
to Precision Biosciences (lab 512).

NICHD-Westat
The NICHD-Westat has the same requirements the ACTG/IMPAACT project.

PHACS
The PHACS preset project has these requirements
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Data entry requirements

Field Required? Note

ID1 (PID) Required 8 characters long, 7 numbers with a letter at
the end

ID2 (Protocol) Required Select from a pre-populated list; all protocols
are in the format PHXXX (e.g. PH200).

ID3 N/A Not used by PHACS

Visit Required Select from pre-defined list of visit units.

OPID Optional --

Clinic Required Will automatically populate using the previous
clinic for the project, PID, and protocol
combination entered; PHACS clinics range
between 1 and 24. LDMS will check that a valid
clinic was selected.

Specimen Time Required* *Required for HOPE, PH700, and all future
PHACS studies. Optional but recommended for
all previous or historical studies.

Received Time Optional This field is optional, but recommended

Notes

• PHACS uses the standard LDMS shipping file format.
• There are two label options for PHACS specimens, one with a barcode and

one without.
• Quick Add templates can be applied for PHACS, but users are not permitted

to create their own templates. All PHACS templates are created by Frontier
Science in collaboration with PHACS leadership.

PHIA
The PHIA preset project has these requirements

Data entry requirements

Field Required? Note

ID1 (PTID) Required [Country_Code][6_digits] (Example:
ZW123456)

ID2 (Country) Required Automatically populated based on country
code in PTID; SW (Swaziland) differs from the
ISO 3166 country code (SZ)

ID3 (HIVRT) Required Testing result (POS, NEG, or IND)

Visit Required --

OPID Optional --

Clinic Required A warning will appear if the country codes in
the PTID and clinic do not match
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Field Required? Note

Specimen Time Required --

Received Time Required --

Notes

• Quick Add templates cannot be created for this project.
• Quick Add templates can be used for this project.

REPRIEVE
The REPRIEVE preset project has the same requirements as the ACTG/
IMPACCT project.

SHIMS
The SHIMS preset project must meet these requirements.

Data entry requirements

Field Required? Note

ID1 (PID) Required Nine characters long that meets the SHIMS
ID1 requirements

ID2 (Study) Required --

ID3 (Rapid Test) Required --

Visit Required --

OPID Optional --

Clinic Optional --

Draw Time Required --

Received Time Required --

SHIMS ID1 format
RAAAhhcpp

R 1 to 4

AAA 001 to 599

hh 01 to 26

c Check digit

pp 01 to 99
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SNRP
The SNRP preset project has these requirements

Data entry requirements

Field Required? Note

ID1 (PID) Required --

ID2 (Study) Optional --

ID3 (SID) Optional --

Visit Optional --

OPID Optional --

Clinic Optional --

Draw Time Optional --

Received Time Optional --

TIES
The TIES preset project has these requirements.

Data entry requirements

Field Required? Note

ID1 (PID) Required 8 characters long, 7 numbers and one letter
between A and L; if the PID does not have 7
numbers, add leading zeros to the front of it.

ID2 (Protocol) Required Select from the pre-defined list of protocols.

ID3 (ID3) Available ID3 is not used by this project

Visit Required Select from pre-defined list of visit units.

OPID Available --

Clinic Required In the format T[Clinic_Number]

Specimen Date Required --

Specimen Time Required --

Received Date Required --

Received Time Optional --

VQA
The VQA preset project has these requirements.
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Data entry requirements

Field Required? Note

ID1 (PanelID) Required LDMS will determine if this field is valid.
Specimens entered or received in a shipping
file prior to 01-July-2007 will not be validated.

ID2 N/A This field is not used by VQA

ID3 N/A This field is not used by VQA

Visit N/A This field is not used by VQA

OPID N/A This field is not used by VQA

Clinic N/A This field is not used by VQA

Specimen Time N/A This field is not used by VQA

Received Time N/A This field is not used by VQA

PanelID format
[Assay_Category][Panel_Number][Panel_Subtype].[Num]Panel_Configuration

Assay_Category RNA, DNA, or CUL

Panel_Number A number between 000 and 999

Panel_Subtype
UM Ultrasensitive RNA

SM Standard RNA

RT DNA proficiency panel

PQ DNA pre-qualification panel

CC Culture panel

Num A number between 01 and 99

Panel_ConfigurationA, B, or C

VTN
The VTN preset project has these requirements.

Data entry requirements

Field Required? Note

ID1 (PID) Required LDMS checks that the PID is valid. Must
be 9 or 10 characters. A PID cannot be
changed without approval from VTN Laboratory
Leadership.

ID2 (Protocol) Required LDMS checks that the PID and protocol
combination are valid.

ID3 Disabled --
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Field Required? Note

Visit Required Use VST for routine HIV diagnostic visits,
otherwise use the appropriate visit unit. This
visit unit is used by certain laboratories for
driving testing algorithms.

OPID Disabled --

Clinic Required The clinic is automatically populated based
on the PID; the same clinical location can be
associated with multiple clinic IDs (e.g. for
Phase I/II or Phase II/III). VTN clinics start
with the letter V (such as V101 instead of
101). LDMS will verify that a VTN clinic was
selected.

Specimen Time Required --

Received Time Required --

Notes

• Throughout LDMS, HVTN is listed as VTN.
• The volume for VTN specimens will default to ML.
• Within VTN, LDMS Shipping files are sometimes called “e-manifests”.
• Barcodes must be printed on labels for VTN specimens.
• Quick Add templates are not permitted for VTN specimens.
• Information for study CoVPN 5001 should be logged under VTN study

5001.

WHIN
The WHIN preset project must meet these requirements.

Data entry requirements

Field Required? Note

ID1 (ParticipantID) Required --

ID2 (Protocol) Optional --

ID3 (ID3) Optional --

Visit Optional --

OPID Optional --

Clinic Optional --

Draw Time Optional --

Received Time Optional --

WIHS
The WIHS preset project has these requirements.
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Data entry requirements

Field Required? Note

ID1 (PID) Required Must meet WIHS PID format requirements

ID2 (Protocol) Required Select from pre-populated list

ID3 (SID) Optional --

Visit Required The visit unit will default to VST, and the visit
number will be automatically populated based
on an algorithm that uses the current date

OPID Optional --

Clinic Optional --

Specimen Time Optional --

Received Time Optional --

WIHS PID format
[Site_Number][Recruitment_Number][Participant_Number][Check_Digit]

Site_Number
1 NYC (Bronx)

2 Brooklyn

3 Washington, D.C.

4 Los Angeles

5 San Francisco

6 Chicago

Recruitment_Number
2B New recruit

0B Original recruit

1B Original recruit

Check_Digit Any character; an algorithm will determine if the
character is valid based on the read of the PID.

Notes

• WIHS shipments being sent to Precision Bioservices (formally SeraCare)
use the SeraCare shipping file format.

• Quick Add templates are permitted for WIHS, and users are expected to
create and use template for WIHS data entry.

• Collection Date and Received Date will automatically be set to your local
date.

WITS
The WITS preset project has these requirements
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Data entry requirements

Field Required? Note

ID1 (PID) Required --

ID2 (ID2) Optional --

ID3 (ID3) Optional --

Visit Optional --

OPID Optional --

Clinic Optional --

Draw Time Optional --

Received Time Optional --

WITSRepos
The WITSRepos preset project must meet these requirements.

Data entry requirements

Field Required? Note

ID1 (Subject ID) Required --

ID2 (Study ID) Optional --

ID3 Optional --

Visit Optional --

OPID Optional --

Clinic Optional --

Draw Time Optional --

Received Time Optional --

ZEBS
The ZEBS preset project has these requirements

Data entry requirements

Field Required? Note

ID1 (STUDYID) Required --

ID2 (ID2) Optional --

ID3 (ID3) Optional --

Visit Optional --

OPID Optional --
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Field Required? Note

Clinic Optional --

Draw Time Optional --

Received Time Optional --

ZIP
The ZIP preset project has these requirements.

Data entry requirements

Field Required? Note

ID1 (PID) Required Must be a 6-digit (for ID2=ZIP) or 7-digit
(for other ID2 values). Following the digits,
there must be a letter. A hard check should
run to ensure the first two digits match to a
corresponding ZIP clinic code ZXX.

ID2 (Study) Required Use allowed studies (ZIP, Z1.0, or Z2.0)

ID3 (Screening ID) Required It must be in the format SAAXXXX, where AA
is a valid clinic number (i.e., ZAA) and XXXX is
any numeric number.

Visit Value and Vist
Unit

Required --

Clinic Required The LDMS will automatically populate the
correct, corresponding clinic ID based off of
the entered PID. If a corresponding clinic ID
is not found, leave the clinic field blank and
select a value.

Specimen Date Required --

Specimen Time Required --

Received Date Required --

Received Time Required --

Notes

• The application must allow FSTRF and user defined preloads for this
project.

• The application must not restrict the user from co-enrolling specimens for
this project.

Administration
The Administration page is where you can manage various settings in LDMS
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Projects
Projects are the collaborative project, organization, or network that conduct
studies.

There are two types of projects: local projects and government projects.

Figure 66: The Projects page.

(1) Whether data is copied into Frontier Science’s central database (2) Whether the project is a government or local

project (3) Whether there are specimens currently using the projects.

Local projects
Local projects are projects that only exist at your laboratory.

A local project is one that has been defined by your laboratory. These are
general used for internal studies that only your laboratory will utilize, although
they can be sent to other laboratories through shipments.

Defining a new local project requires you to specify what you are going to call
ID1, ID2, and ID3.

Table 16: Identifiers

IdentifierDescription Example

ID1 Uniquely identifies a participant or
specimen source

Participant ID

ID2 Identifies the study in which the
participant is enrolled

Study number

ID3 Used to further identify a branch or sub-
unit in a study

Sub-study number

While there are no rules for what you can name each identifier, they must be
used for these purposes. For some projects, it may be more appropriate to
think of ID1 as identifying the source from which specimens were collected,
such as a testing solution that you received, rather than a participant.

Creating a new project
New projects can be created on the Project Administration page.
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Steps

1. Click Administration > Projects from the LDMS menu bar.
2. From the LDMS action menu, select Create Project.

The Create Project window will open.

Figure 67: The Create Project Window

3. Enter the name of the project as you would like it to appear in menus
throughout LDMS into the Name box.

4. Enter a brief description of the project into the Description box.
The description is generally used to provide the full name of the
project, especially when the project is an acronym.

5. Enter the name that you want to use for ID1 for the project into the
ID1 Name box, and a brief description into the ID1 Description box.
The format and acceptable values for ID1 may also be set.
ID1 is typically used as an identifier for a participant. For other types
of work, such as quality control testing, ID1 could also be something
else, like a testing panel number.
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Figure 68: Enrollment Configuration

6. Enter the name that you want to use for ID2 into the ID2 Name box,
and a brief description into the ID2 Description box. The format and
acceptable values for ID2 may also be set.
ID2 is typically used for a study or protocol identifying number.

Figure 69: Visit Configuration

7. Enter the name that you want to use for ID3 into the ID3 Name box,
and a brief description into the ID3 Description box. The format and
acceptable values for ID3 may also be set.
ID3 is typically used as a sub-study or sub-protocol identifying
number.

8. Click the Save button.

Result
The new project will be added to the list of groups that you specified.
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Modifying and removing a project
Local project can be modified or removed after they are created

Prerequisites
A local project can only be removed if it is not currently in use. Government
projects cannot be modified or removed.

Background

This might be needed if there was a mistake with the way the project
was initially entered or if you need to update the descriptions for the
participant fields. Changes made to a project will automatically update
existing participant records in LDMS.

Steps

1. Click Administration > Projects from the LDMS menu bar.
2. Locate the project to be modified or removed from the list of projects.
3. Do one of the following:

• To modify the project, click the Edit button to the right of the
project. The Edit Project window will open, where you can make
your changes. When you are done, click the Save button.

• To remove the project, select Delete from the Edit menu to the
right of the project.

Government projects
Government projects are those that are defined by Frontier Science.

Frontier Science works with government-funded projects to define the rules
and specifications for their project. These projects cannot be modified or
removed by users. Even though they cannot be modified, they will still be
visible on the Projects page.

Adding a Reagent
The Reagent Logging feature is used to track reagents used at a laboratory
and uses a defined set of reagent codes.

You can use this feature to record information about reagents, such as the lot
number and whether the reagent is still in use.

Once entered, the lot number for the reagent will be available on the
Specimen Management page to assign to specimens that contain the
reagent.
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Figure 70: The reagent logging module

Adding Reagent Information
Reagents can be added through the Administration menu.

Steps

1. From the menu bar, click Administration and then click Reagent
Logging

2. Click Add Reagent
A new blank row will be added to the bottom of the name. You may
need to scroll down to see it.

3. Complete the information for the new reagent.

Field Usage

Reagent Name This field contains the three letter code for
the reagent that is being tracked.

Lot Number This is a free text field. Enter the lot
number from the container

Expiration Date Manufacturer set date of expiration

Manufacturer This is a free text field. Enter the
manufacturer name from the container.

Start/End Date These fields record the date the reagent
was first used and the date use was
discontinued.

Active New entries default to active.

4. At the bottom of the page, click Save.
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Linking Reagent to Sample in Specimen Management
Users can assign reagent lots to primary and aliquot samples in Specimen
Management or via Quick Add. Options are limited to the lots that have been
defined in the reagent logging module.

Background
After the lot is entered in the Reagent Logging module, the lot number is
available in the Edit Aliquot menu to be applied to any sample using the sub-
additive.

Steps

Figure 71: Linking Reagent to Sample via the Specimen Management
Menu

1. In Specimen Management, use the filters to navigate to the specimen's
page.

2. In the Aliquot grid, locate the specimens utilizing the logged reagent
3. Click the Edit button, the Edit Aliquot menu will open in a pop up

window
4. Select the appropriate lot number in the Sub Add/Der Reagent menu
5. Click Save
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Linking Reagent to Sample in Quick Add

Background
If known, the reagent lot number can be applied in Quick Add at the time of
accessing.

Steps

1. In the Aliquot grid, locate entry with the Sub Additive/Derivative.
2. Click the Edit button
3. Select the lot number in the Sub Add/Der Reagent menu.

Linking Additive to Reagent Lot

Steps

Figure 72: Linking Additive to Reagent Lot

1. In Specimen Management, click the Edit button for the Primary
containing the logged Additive

2. In the Edit Primary Specimen window, select the lot number in the
Additive Reagent menu

Reagent Lot Sample Details Report
The Reagent Lot Sample Details Report provides a list of which specimens
contain a reagent.

This report include information about the reagent at the top, and then lists all
specimens and details about the specimens (such as specimen type, collection
date and time, and specimen identifiers).

To generate this report, click Administration and then click Reagent
Logging. Next to the reagent of interest, click Report.

Specimen Anonymization
The specimen anonymization module is used to anonymize specimens. This
module is disabled by default and must be enabled by LDMS User Support in
order to be used.
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Figure 73: Specimen Anonymization Screen

(1) Various filters that can be applied to the list of specimens, (2) remove all specimens filters, (3) upload a unique

specimen IDs file, (4) manually select specimens from filtered list, (5) select all specimens in filtered list, (6) clear

selected specimens in filtered list, (7) filter list of specimens by selected only, (8) mark specimen(s) as available or

non-available, set condition and derivative type, and add comments, (9) anonymize selected specimens

1. To access the specimen anonymization module after it has been activated
by LDMS User Support, navigate to the Administration dropdown and
select Specimen Anonymization.

2. Use the various filters to locate the specimens that need to be
anonymized. The list of filtered specimens will appear below.

3. If not all specimens in the filtered list are intended to be anonymized,
select the specimens that are to be anonymized and click the Selected
radio button.

4. A global specimen IDs file can also be added to the list of filtered
specimens by clicking Upload File: Unique specimen IDs.

5. Check the Is Available checkbox to have the selected specimens remain
available.

6. Change the Specimen Condition of the selected specimens from the
dropdown.
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Note:  Certain specimen conditions automatically change the
specimen availability checkbox.

7. Change the Derivative Type and add Comments and Internal Only
Comments to the selected specimens as necessary.

8. Click Anonymize Specimens.

After specimens have been anonymized, the original specimen records
will become unavailable to store, ship, or test. LDMS will create new
anonymized records for these specimens with scrambled/anonymized IDs.
New barcode labels can be generated to apply to the specimen vials that
display the anonymized IDs. Reports can be generated to review the link
between the original IDs and newly assigned anonymized IDs.

Lab Settings
Some laboratory-specific settings can be controlled by users by clicking
Administration and then clicking Lab Settings.

Setting Usage

Number of samples shown by default in
sample picker

Set the default number of samples shown in
sample picker

Processing Tech Initials defaults to current user Currently signed-in user will automatically be
set as the Processing Technician when creating
aliquots.

Require a comment when modifying primaries
and aliquots

If activated, the user must enter or modify the
comment in order to be able to save the Edit
Primary and Edit Aliquot popups.

Auto-set frozen date/time to the current date/
time when storing specimens

When storing a specimen, its frozen date and
time will automatically be set.

Include unavailable primary samples by default
when printing labels

Unavailable primary samples will be included
by default when printing labels.

Auto-assign next available fill-order position
when adding and moving specimens,
containers, and levels in storage

The next available fill-order will automatically
be assigned when specimens are added to
storage containers

Import shipments into storage by default Shipments will be imported into storage by
default

Mark to Ship reminds users when overdue by
default

Users will be notified on login if they have
overdue shipments

Override shipping container configurations
when importing into storage?

Override various attributes for shipping
container configurations when importing into
storage, such as alphabetic columns, fill order,
etc.

User Settings
Users are able to change a limited number of settings for how their account
works by clicking Administration and then clicking User Settings.
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Setting Usage

Default Module Select the initial page that will be loaded when
you sign into LDMS.

Default Lab ID Select the lab ID that will be selected when
you sign into LDMS.

Show ID1/PID and Specimen Number in
Storage Tree

Select to display ID1/PID and Specimen
Number in the Storage Tree

User management
User accounts are managed by Frontier Science.

Accounts for individual users are created and maintained by LDMS User
Support. To perform the following tasks, you would need to contact LDMS
User Support for assistance:

• Create a new user
• Reset a user’s password
• Manage what features in LDMS a user can access

Users can modify their own passwords from within LDMS.

Changing your password
While the creation and management of user accounts is handled by LDMS
User Support, users can change their own passwords.

Steps

1. From the logout menu in the upper-right corner of the page, click
Change Password
Figure 74: The Logout menu

The Change password window will open.
2. Enter your current password into the Password box.
3. Enter your new password into the New Password box.
4. Re-enter your new password into the Confirm Password box.
5. Click the Change Password button.

Password requirements
This section explains the requirements for user passwords.

• Passwords must contain at least one upper case letter, one lower case
letter, one number, and one special character
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• A password must not be the same as one of the your previous passwords
• A password must be between 10 and 50 characters
• Must not be similar to your current password, user ID, or display name

Temporary passwords expire within 24 hours. If you do not sign into LDMS
using the temporary password before it expires, you must have a new
temporary password generated.

Dropdown Customization
The Dropdown Customization tab allows users to hide items from
dropdown lists. This is accessed through the Administration menu.

Steps

1. From the menu bar, click Administration and then click Dropdown
Customization.

2. Select a value from Dropdown List.
3. Select a project from the Project dropdown list.
4. A table with items to hide will appear. Uncheck the boxes in the

Active column to hide items.
5. At the bottom of the page, click Save.

To unhide any items previously hidden, return to this page and re-
check the applicable boxes, then click Save. The items will then return
as options in dropdown lists.

RPID Requests
In the RPID Requests module, users can create new RPID requests, edit/
delete existing requests, and download a list of ID1s associated with the
request.
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Figure 75: RPID Requests - Main Screen

(1) Add a new RPID request, (2) View, edit, delete existing RPID requests

Adding a New RPID Request

Figure 76: Create New RPID Request Window

(1) RPID Request Number, (2) title of the request, (3) comments about the request, (4) upload ID1 file, (5) create the

RPID request

1. Navigate to RPID Requests from the Administration dropdown.
2. Click Add RPID Request from the Actions dropdown.
3. In the Create New RPID Request window, add the request number, title,

comments, and ID1 file as needed, and click Create RPID Request.
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Editing an RPID Request
1. Navigate to RPID Requests from the Administration dropdown.
2. Click View/Edit next an existing RPID request.
3. Update the request information as needed.
4. Click Save.
5. To delete an RPID request, return to the main RPID Request screen, click

the dropdown next to the View/Edit button of an existing request and
click Delete. On the confirmation screen, click Delete.

A list of ID1s associated with an RPID request can be downloaded. To
do this, click the dropdown next to an existing RPID request and click
Download ID1s.

Clear Filters

The Clear Filters page is used to clear filters across all modules.

Figure 77: Clear Filters Screen

To access the Clear Filters module, navigate to the Administration dropdown
and select Clear Filters.

To clear filters, do one of the following:

• To clear specific filters, check the boxes next to each applicable filter and
then click Clear.

• To clear filters in all categories, click Clear All.

Online Resources
The Online Resources menu option contains links to relevant web resources.
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• LDMS Validation Resources - A link to a page on the LDMS website
where users can request validation documentation.

• Frontier Science Website - A link to the main Frontier Science website.
• Frontier Science Portal - A link to the Frontier Science Portal.
• Specimen Repository Website - A link to the specimen repository

website, a site that can be used to search for specimens located at a
number of repositories.

Codes, units, and abbreviations
This section lists the codes, units and abbreviations that are used in LDMS for
various entry fields, such as visits and specimen types. These codes are used
by both LDMS and LDMS for Windows.

Specimen type codes
These are the codes use for primary, additive, and derivative types.

Primary codes
This section lists all of the available primary codes in LDMS

Code Description

ADG Adrenal Glands

ADP Adipose

AHR Non-Occipital scalp hair

AMN Amniotic Fluid

ANL Anal

AOR Aorta

APP Air Pollution Particles

ARB Rectal Biopsy by Anoscopy

ARL Breast Areola

ART Arterial Blood Draw

ASC Ascending Colon

BAL Bronchoalveolar Lavage

BHR Hair, Body

BLA Bladder

BLC Blood Clots

BLD Blood (Whole - Venous)

BMA Bone Marrow Aspirate

BMC Bone Marrow Core Biopsy

Frontier Science Foundation 234



LS.0006 | LDMS for the Web - User Manual

Code Description

BMK Human Milk

BML Human Milk - Left

BMR Human Milk - Right

BNE Bone

BNM Bone Marrow

BRB Bronchoscopy Brush

BRN Brain Tissue

BRS Breast Tissue

BSG Basal Ganglia

BUC Buccal

BUG bulbourethral glands

CAT Coronary Artery

CCD Common Carotid

CDE Caudate

CER Cervix

CLL Colon (left)

CLR Colon (right)

CLS Sigmoid Colon

CRB Cerebellum

CRD Cord Blood

CRN Colorectal Neoplasm

CSC Cervical Secretion

CSF Cerebro-Spinal Fluid

CVB Cervical Biopsy/Aspirate

CVF Cervicovaginal Fluid

CVL Cervical Vaginal Lavage

CVM Cervical Mucous

CXC Cervical Culturette

CXS Cervical Swab

DDM Duodenum

DIA Dialysate

DMM DMEM

DPL Dried Plasma

DRG Dorsal Root Ganglia

DSC Descending Colon
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Code Description

DTC Distal Colon

DWB Dried Whole Blood

DWM Deep White Matter

EBC Exhaled Breath Condensate

END Endometrium

ENV Environmental

EPI Epididymus

EPS Expressed Prostatic Secretions

ESO Esophagus

EVX Endocervix

EYE Corneal Tissue

FAT Femoral Artery

FCM Frontal Cortex (motor)

FCP Frontal Cortex (pre-motor)

FGN Finger Nails

FHR Hair, Facial

FLT Fallopian Tubes

FSC Sigmoid Colon Biopsy by Flexible Sigmoidoscopy

FSI Penis Foreskin, Inner Tissue

FSK Penis Foreskin, Whole Tissue

FSO Penis Foreskin, Outer Tissue

FSR Rectal Biopsy by Flexible Sigmoidoscopy

FST Blood from Fingerstick (capillary)

GAS Gastric Secretions

GCF Gingival Crevicular Fluid

GLN Glans

GLS Glycerol Stock

GLU Genital Lesion/Ulcer

GMI Gastro Intestinal Mucosa

HAR Hair

HPC Hippocampus

HRT Heart

HST Blood from Heelstick (capillary)

ICD Internal Carotid

ILM Ileum
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Code Description

INT Intestinal Biopsy/Aspirate

INW Induction Waste

IVR Intra-vaginal Ring

IVS Intraventricular Septum

JJM Jejunum

KDY Kidney

KID Kidney Biopsy

LAL Lymph Node Axillary-left

LAR Lymph Node Axillary-right

LAT Left Atrium

LBL Large Bowel

LBT Lateral Border of the Tongue

LIL Lymph Node Inguinal-left

LIR Lymph Node Inguinal-right

LIV Liver Tissue

LNA Lymph Node (aortic)

LNC Lymph Node (cervical)

LNE Pre-auricular Lymph Node

LNF Infraclavicular Lymph Node

LNG Lung

LNI Inguinal Lymph Node

LNK Popliteal Lymph Node

LNM Lymph Node (mediastinal)

LNO Lymph Node (other)

LNP Lymph Node (per-hilar)

LNR Para-aortic Lymph Node

LNS Supraclavicular Lymph Node

LNT Mesenteric Lymph Node

LNX Lymph Node (axillary)

LPK Leukopak

LSG Labial Salivary Gland

LUE Lung, Excised

LUF Lung, Filter Paper

LVE Left Ventricle

LYM Lymph Node Biopsy/Aspirate
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Code Description

MBR Midbrain Consists of Cerebral Penduncles and Tectum

MCP Prefrontal Medial Cortex

MEC Meconium

MED Medulla

MEN Dura Mater – Meninges

MES Mesentery

MFP Placenta Membranes

MSB Main Stem Bronchus Wash

MTC Motor Cortex

NAS Nasal

NPH Nasopharyngeal

NPW Nasopharyngeal Wash

NRH Naso-oropharyngeal

NSB Nasal brush

OCC Occip Cortex

OCL Ocular

OHR Occipital scalp hair

OPW Oropharyngeal Wash

ORH Oropharyngeal

ORL Oral

OTH Other

OVR Ovaries

PAD Adipose (pericardial)

PAN Perianal

PCF Pericardial Fluid

PCT Perietal Cortex

PEN Penis

PFL Pleural Fluid

PFR Parotid Flow

PHR Hair, Pubic

PHX Pharynx

PLC Placental Tissue

PLM Placenta - Membrane Slice

PLN Peritrach Lymph Nodes

PLP Polyp
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Code Description

PLQ Plaque

PMD Plasmids

PNC Pancreas

PON Pons

PPK Plasmapak

PRC Premotor Cortex

PRO Prostate

PRT Prostate Tissue Biopsy

PTF Peritoneal Fluid

PTY Parathyroid

RAT Right Atrium

RCT Rectum

REC Rectal

RSC Rectosigmoid Colon

RVE Right Ventricle

SAD Subcutaneous Adipose

SAL Saliva

SCC Spinal Cord Cervical

SCL Spinal Cord Lumbosacral

SCR Scrotum

SCT Spinal Cord Thoracic

SEM Semen

SHR Hair, Scalp

SIN Sputum, Induced Non-Select

SIS Sputum, Induced Select

SKN Skin

SLU Skin Lesion

SMD Skeletal Muscle (distal)

SMP Skeletal Muscle (proximal)

SMV Seminal Vesicle

SPI Sputum, Induced

SPL Spleen

SPS Sputum, Spontaneous

SPT Sputum

SSN Sputum, Spontaneous Non-Select
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Code Description

SSS Sputum, Spontaneous Select

STL Stool

STM Stomach

SVG Salivary Glands

TBD Specimen type to be defined

TCA Tracheal Aspirate

TCX Temporal Cortex

TER Tears

THD Thoracic Duct

THL Thalamus

THR Throat Swab

THW Throat Wash

THY Thymus

TIL Terminal Ileum

TNA Toe Nails

TNG Tongue

TON Tonsillar Biopsy/Aspirate

TRN Transverse

TST Testes

TTH Tooth

TUM Tumor

TVC Transverse colon

TYD Thyroid

UMB Placenta - Cord Slice

UNK Unknown Primary

URN Urine

UTH Urethra

UTS Uterus

VAG Vaginal Swab

VCS Cervicovaginal Secretions

VGL Vaginal

VGN Vagina

VSC Vaginal Secretions

VUL Vulva

WAR Warts
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Additive codes
This section lists all of the additive codes available in LDMS.

Code Description

ACD Acid Citrate Dextrose

AG1 ESAT 6-free cocktail 1

AG2 ESAT 6-free Cherry pick

AHP Ammonium Heparin

APT Allprotect

ATM Abbott Transport Medium

BBL CultureSwab Kit

BFM Bacterial Freezing Media

BOR Boric Acid

BSA Bovine Serum Albumin

BTM Biopsy Transport Media

CPD Citrate Phosphate Dextrose

CPH Cell Preparation Tube Heparin

CPS Cell Preparation Tube SCI

CTK Culture Transport Kit

DFA Desferoxamine

DHP Double dosage of Heparin

DPE Spray Dried EDTA

DSE Spray Dried Sodium EDTA

EDT EDTA

ELB elution buffer

END Endometrial Tissue

ETH Ethanol

FFN Fetal Fibronectin Buffer

FFP Formalin-Fixed, Paraffin Embedded

FMD Formaldehyde

FOR Formalin

GEN GenAptima Media

GIT Guanidine Isothiocyanate (GITC)

GLT Glutaraldehyde

GRB Guanidine Reduction Buffer

H2O Water

HEP Heparin
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Code Description

HPV Human Papilloma Virus

HVS High Virginial Swab

ISO Isohelix kit

IST Internal Standard

LHG Lithium Heparin and Gel for Plasma

LHP Lithium Heparin

LIN LoBind tube lined with 5% BSA

LOB LoBind Tube

LPE Liquid Potassium EDTA

LSE Liquid Sodium EDTA

LYB Lysis Buffer

MBK Microbank tube

MPA Metaphosphoric Acid

MSA Mannitol Salt Agar

NOH Sodium Hydroxide

NON None

NOR Normasol

NSL Normal Saline

NUC NUNC Tube

OCT Optimum Cutting Temperature Medium

OMN Omnigen Collection Tube

ORA OraSure Collection Container

ORG Oragene Collection Container

OTH Other

PAC Port-a-cul Transport Tube

PAX PAXgene Blood RNA tube

PBS Phosphate Buffered Saline

PCT PreservCyt: ThinPrep collection media

PED Potassium EDTA

PFM Paraformaldahyde

PI1 S8820 Sigma SIGMAFAST? Protease Inhibitor Tablets

PIA Pseudomonas Isolation Agar

PLP PLP Fixative

PPT Plasma Preparation Tube

PRO ProbeTec Media
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Code Description

PXD Paxgene tube DNA Extraction

QAG QFT-TB Ag Red Cap

QMT QFT-Mitogen Purple Cap

QNL QFT-Nil Grey Cap

QTF QuantiFERON-TB Gold Assay

QTG QFT-TB1 Ag Green Cap

QTY QFT-TB2 Ag Yellow Cap

RBE Royal blue - EDTA

RBN Royal blue - no anticoagulant

RLS Ringer's Lactate Solution

RNL RNALater

RNP RNAprotect

ROC Roche Media

RPM RPMI 1640 Medium

RPS RNA Preservation Solution

SBC Sodium Bicarbonate

SCC Steck Cyto-Chex tubes - stabilized

SCI Sodium Citrate

SED Sodium EDTA

SFE Sodium Fluoride/Na2EDTA

SFL Sodium Fluoride

SIA Sulfite Iron Agar

SKM Skim Milk

SNP Snap/Flash Freeze

SPH Sucrose Phosphate

SPO Sodium Fluoride/Potassium Oxalate

SPS Sodium Polyanetholesulfonate

SST Serum Separator

STG Skim milk-Tryptone-Glucose-Glycerin Medium (STGG)

TAL Blood Bag Tail

TBD Specimen type to be defined

TBS Tris-Buffered Saline

TCD tween chlorhexidine digluconate

TEM Tempus Tube

TFM Tissue Freezing Medium
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Code Description

TFX Tissue Fix

THM Thrombin

TMS Transport Medium-Stuarts

TRC TruCulture Tube

TVT TransFix Vacuum Blood Collection Tube

UNK Unknown Additive

URM Urine Transport Media

UTM Universal Transport Media

VTM Viral Transport Media

ZRD Zymo RNA/DNA shield

Derivative codes
This section lists the derivative codes available in LDMS.

Code Description

A4N Activated CD4+ without Tregs

AD4 Activated CD4

AD8 Activated CD8 Derivative

ADG Adrenal Glands

ADL Adipose Tissue Layer

ADP Adipose (abdominal)

AHR Non-Occipital scalp hair

AMN Amniotic Fluid

AOR Aorta

APL Applicator Tip

ASP Aspirate

BAC Bacterial Isolate

BAL Bronchoalveolar Lavage

BCL B-cell Lymphoblastoid Cell Line

BHR Hair, Body

BLA Bladder

BLC Blood Clots

BLD Blood (Whole - Venous)

BLK Tissue Block

BMA Bone Marrow Aspirate

BMC Bone Marrow Core Biopsy

BMK Human Milk
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Code Description

BML Human Milk - Left

BMR Human Milk - Right

BMS Human Milk - Spun

BMW Human Milk - Whole

BNM Bone Marrow

BPS Biopsy

BRN Brain Tissue

BRS Breast Tissue

BSG Basal Ganglia

BUC Buccal

BUF Unficolled Cryopreserved Buffy Coat, Viable

BUG Bulbourethral Glands

CAN Candida

CCC Cryopreserved Cells from a Culture, Viable

CD4 CD4 Positive T-Cells

CD8 CD8 cells

CDE Caudate

CDN Copy DNA

CDP Dry Pellet from a Culture, Non Viable

CEL PBMC Cells, Viable

CEN Fresh Cells from a Non-Blood Spec. Type

CER Cervix

CGN Cells in GITC

CIO Cells in Other (Solution), Non-Viable

CLI Cell Lines

CLL Colon (left)

CLN Cryopreserved primary cells from Non-Blood Spec Type, Viable

CLR Colon (right)

CLS Sigmoid Colon

CMV CytoMegaloVirus Isolate

CRB Cerebellum

CRY Generic Cryptococcus

CSF Cerebro-Spinal Fluid

CSR Serum - Chilled

CTB Cytobrush
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Code Description

CTC Cells from a CTL Assay

CTS Supernatant generated from a CTL Assay

CUP Cup

CVL Cervical Vaginal Lavage

CVS CVL Supernatant

CXS Cervical Swab

DBE Dried Blood Extract

DBS Dried Blood Spot

DDM Duodenum

DPE Plasma, Dried Extract

DPL Plasma, Dried

DPS Dried Plasma Spot

DSP Digested Sputum

DUR Dried Urine

DWB Dried Whole Blood

ED4 Effector Memory CD4 T-cells

END Endometrial Tissue

EPI Epididymus

EPP Endodontic Paper Point

ESO Esophagus

EYE Eye

FCM Frontal Cortex (motor)

FCP Frontal Cortex (pre-motor)

FGN Finger Nails

FHR Hair, Facial

FLD Fluid Portion from a Non-Blood Specimen Type

FLS Flocked Swab

FLT Fallopian Tubes

FPL Plasma, Filtered

FSI Penis Foreskin, Inner Tissue

FSO Penis Foreskin, Outer Tissue

FSR Rectal Biopsy by Flexible Sigmoidoscopy

FTP Filter Paper

GLS Glycerol Stock

GMI Gastro Intestinal Mucosa
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Code Description

GRN Granulocytes

HAR Hair

HPC Hippocampus

HRT Heart

ICK Supernatant generated from Inducible Cytokines

ILM Ileum

IPK Methanol Extract Supernatant

IPT Immunophenotyping

IVR Intra vaginal Ring

IVS Intraventricular Septum

JJM Jejunum

KDY Kidney

LAT Left Atrium

LAV Lavage

LDB Leukodepleted blood

LIV Liver Tissue

LNA Lymph Node (aortic)

LNC Lymph Node (cervical)

LNE Pre-auricular Lymph Node

LNF Infraclavicular Lymph Node

LNG Lung

LNI Inguinal Lymph Node

LNK Popliteal Lymph Node

LNM Lymph Node (mediastinal)

LNO Lymph Node (other)

LNP Lymph Node (per-hilar)

LNR Para-aortic Lymph Node

LNS Supraclavicular Lymph Node

LNT Mesenteric Lymph Node

LNX Lymph Node (axillary)

LPD Lipid Layer

LPK Leukopak

LVE Left Ventricle

LYM Lymph Node Biopsy/Aspirate

LYS Lysed whole blood

Frontier Science Foundation 247



LS.0006 | LDMS for the Web - User Manual

Code Description

MBR Midbrain Consists of Cerebral Penduncles and Tectum

MCL Macrophage Cells - Viable

MCS Microbiology Culture Slant

MD4 Central Memory CD4 T-cells

MDC Myeloid Dendritic Cells

MEC Meconium

MED Medulla

MNO Monocytes

MPE Macrophage Dried Cell Pellet, Non Viable

MTB MTB Isolates

MUC Mucins

MUS Mucous

N/A Not Applicable - Same as Primary Specimen Type

NA4 Non-activated CD4

NA8 Non-activated CD8

NCL Neutrophil (PMN) - Viable cells

ND4 Naive CD4 T-cells

NKC Natural Killer Cells

NON None

NPE Neutrophil (PMN) Dried Cell Pellet, Non Viable

NPW Nasopharyngeal Wash

NTM Nontuberculous mycobacteria

NXD Non-extracted DNA

OCC Occipital Cortex

OHR Occipital scalp hair

OPC Ova & Parasite Concentrate

OTH Other

OVR Ovaries

PAD Adipose (pericardial)

PCC Culture Supernatant and Cells

PCF Pericardial Fluid

PCT Parietal Cortex

PDC Plasmacytoid Dendritic Cells

PED Dried Pellet - Digene

PEL Non-viable PBMC s
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Code Description

PEN Non-viable cells from non-blood specimen type

PEO Wet Pellet Prep - Organon Teknika

PER Dried Pellet - Roche

PFR Parotid Flow

PHR Hair, Pubic

PL* Plasma, All

PL1 Plasma, Single-Spun

PL2 Plasma, Double-Spun

PLA Plasma, Unspecified/Other

PLC Placental Tissue

PLH Plasma High Spin

PLM Placenta - Membrane Slice

PLP Supernatant & Cells from a Quantitative Culture

PLQ Plaque

PLT Placenta - Placenta Slice

PMD Plasmids

PMN polymorphnuclear leukocytes

PON Pons

PNC Pancreas

PPK Plasmapak

PPS Periopaper Strip

PRO Prostate

PTF Peritoneal Fluid

PTY Parathyroid

RAT Right Atrium

RBC Red Blood Cells

RCT Rectum

RD4 Resting CD4 T-cells

REC Rectal

RVE Right Ventricle

SAL Saliva

SCC Spinal Cord Cervical

SCL Spinal Cord Lumbosacral

SCP Scraping

SCT Spinal Cord Thoracic
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Code Description

SDI Supernatant Dermis, Inner

SDO Supernatant Dermis, Outer

SEC Secretions

SEI Supernatant Epidermis, Inner

SEM Semen

SEO Supernatant Epidermis, Outer

SER Serum

SHR Hair, Scalp

SKN Skin

SLD Slide from a primary sample

SMD Skeletal Muscle (distal)

SMP Skeletal Muscle (proximal)

SMR Smear

SMV Seminal Vesicle

SNO SNO - Strip

SPG Sponge

SPI Unfractioned Sputum, Induced

SPL Spleen

SPQ Supernatant from a Quantitative Culture

SPT Unfractioned Sputum

SRH Serum - High Speed Spun

STK Quantitative Culture Held beyond 14 Days

STL Stool

STM Stomach

STP Sterile Tooth Pick

SUP Culture Supernatant

SVG salivary glands

SWB Swab

SWS Stimulated Whole Saliva

TBD Specimen type to be defined

TCX Temporal Cortex

TD4 Transitional Memory CD4 T-cells

TFS Tear-Flo Strips

THL Thalamus

THW Throat Wash
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Code Description

THY Thymus

TIS Tissue

TNA Toe Nails

TON Tonsillar Biopsy/Aspirate

TR4 T regs CD4+

TRC Trucount

TRN Transverse

TST Testes

TTH Tooth

TUM Tumor

TYD Thyroid

UMB Placenta - Cord Slice

UNK Unknown Derivative

URN Urine

UTS Uterus

UWS Unstimulated Whole Saliva

VAG Vaginal

VCP Vaginal Cup

VGN Vagina

VTM Viral Transport Media

W/D Wet/Dry

WBP Whole Blood Pellet, Specify Methodology

WEK Wick/Wek Cell Sponge

WFC Unstimulated whole blood cell, lysed , fixed, frozen (with DMSO) for flow

WFS Stimulated whole blood cells, lysed, fixed, frozen (with DMSO) for flow

WPK Whole Blood Packed

XDA Extracted DNA

XFL Extracted Fluid from RNA RT PCR for Sequencing

XPA Extracted RNA

XPD Extracted Pellet from DNA PCR for Sequencing

XPR Extracted Pellet from RNA RT PCR for Sequencing

XTN Extracted total nucleic acid

Sub additive/derivative codes
This section lists the sub additive/derivative codes available in LDMS.
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Code Description

01C 1 o'clock biopsy position

02C 2 o'clock biopsy position

03C 3 o'clock biopsy position

04C 4 o'clock biopsy position

05C 5 o'clock biopsy position

06C 6 o'clock biopsy position

07C 7 o'clock biopsy position

08C 8 o'clock biopsy position

09C 9 o'clock biopsy position

10C 10 o'clock biopsy position

11C 11 o'clock biopsy position

12C 12 o'clock biopsy position

14D Tooth #14 Distal Buccal

14M Tooth #14 Mesial Buccal

19D Tooth #19 Distal Buccal

19M Tooth #19 Mesial Buccal

24M Tooth #24 Mesial Buccal

25D Tooth #25 Distal Buccal

30D Tooth #30 Distal Buccal

30M Tooth #30Mesial Buccal

3DB Tooth #3 Distal Buccal

3MB Tooth #3 Mesial Buccal

562 K562 Cell Line

8MB Tooth #8 Mesial Buccal

9DB Tooth #9 Distal Buccal

ACD Acid Citrate Dextrose

ADA Adenosine Deaminase

ADJ Adjuvant

AEB Qiagen AE Buffer

AFS Alsever's Freezing Solution

AG1 ESAT 6-free cocktail 1

AG2 ESAT 6-free Cherry pick

AMB Amber Vial

ANT Antigen

APR Aprotinin
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Code Description

ASC Ascorbate (Vit C)

ATC Animal Tumor Cell Line

ATG TB Antigen

AUO Auramine O

AVE Qiagen Buffer AVE

BCG Bacille Calmette-Guï¿½rin

BCL B-cell Lymphoblastoid Cell Line

BFM Bacterial Freezing Media

BHT Butylated hydroxytoluene

BLK Tissue Block

BML Breast - Left

BMR Breast - Right

BSA Bovine Serum Albumin

BSS Blood Stabilizing Solution

BTM Biopsy Transfer Media

CAN Candida (CASTA)

CBS Cellbanker Solution

CCM CareHPV Collection Medium

CD4 CD4 cells

CD8 CD8 cells

CDN cDNA

CFM Cell Freezing Media

CME Culture Media

CMV CytoMegaloVirus

CON Control

CSC Cervical secretions

CSP Cytospin Slides

CVA Complete Vaccine

CYT Cytokines

DCF 2 - deoxycoformycin.

DEA DEACTIVATED

DMS DMSO used in cryopreservation solution (CPS)

DOD Day of Donation

DOT Day of Tail

DPH Wyeth Ayerst Diphtheria Antigen
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Code Description

DPL Depleted Cell Populations

DTM Digene/Qiagen Specimen Transport Medium

DTT Dithiothreitol

EDT EDTA

ETH Ethanol

FBS Fetal Bovine Serum

FMA Formic Acid

FMD Formaldehyde

FOR Formalin

FPR Filter Paper

FRS First Spin

FRZ Frozen

FUN Fungal Broth

GAG HIV GAG envelope peptide

GIT Guanidine Isothiocyanate (GITC)

GLM Glycerol Media

GLT Glutaraldehyde

GLY 20% Glycerol

GMS Giemsa Staining

GRS Gram Stain

H&E Hematoxylin and Eosin stain

H2O Water

HBS Hank's Balanced Salt Solution

HCl Hydrochloric Acid

HPA Hep A

HPS Human Pappilloma Virus Serology

HPV Human Pappilloma Virus

HTC Human Tumor Cell Line

I18 IL-18

I1b IL-1b

IAP Iodoacetic Acid/Phenanthrolene

IgG Immunoglobulin G

IL2 IL-2, Interleukin 2

IL6 Interleukin6

ILA IL-12/IL-15, Interleukin-12/Interleukin-15

Frontier Science Foundation 254



LS.0006 | LDMS for the Web - User Manual

Code Description

INK India Ink

IPD PBMCs for Intact Proviral DNA testing

LAA L-ascorbic Acid

LES Lesion

LFT Left

LPS Lipopolysaccaride

LSM Lymphocyte Separation Media

LVT L-var Target

LYB Lysis Buffer

M2V M2VP

MA1 MAC 101

MAC MAC Antigen

MAF MAC LR114F Culture Filtrate

MAS M. Avium Sensitin

MCH Mechanical Homogenization

MDB Middlebrook broth

MET Methanol

MFS Malaria Freezing Solution

MIF Merthoilate Formalin/Merthiolate-Iodine Formalin (MF/MIF)

MIT Quantiferon Gold and/or Quantiferon Gold Plus Mitogen tube

MPP For a mega peptide pool

MRN Messenger RNA

MT2 MT2 Cell Line

MTV For an MTB vaccine

MUC Mucins

N/A Not Applicable

NAS Nucleic Acid Stabilization Solution

NAT Sodium thioglycolate

NCL N-acetyl-L-cysteine

NDN NDVNS1, Newcastle disease virus with NS1 influenza protein

NDV NDVB1, Newcastle disease virus wild type

NDW Newcastle disease virus with W influenza protein

NIL Quantiferon Gold and/or Quantiferon Gold Plus Nil tube

NKC Natural Killer cells

NOH Sodium Hydroxide
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Code Description

NON None

NPI Neuropepsidase Inhibitor

NSK New Skin Lesion

NSL Normal Saline

NUC Nucleotides

OCT Optimum Cutting Temperature Medium

OKT OKT3 Treated

ORI Oricol

OTH Other

P24 P24

PAE Pseudomonas aeruginosa

PAR Parrafin

PBS Phosphate Buffered Saline

PCS PreserveCytSolution

PEI Pre-Infusion

PFM Paraformaldahyde

PHA PHA-Treated

PI1 S8820 Sigma SIGMAFAST Protease Inhibitor Tablets

PIC Protease Inhibitor Cocktail

PLC Placenta Tissue

PLD Plasma, Depleted

PLM Placenta Membrance

PMI Phorbol Myristate Acetate-Ionomycin

PPA Phosphoric Acid

PRS Protamine Sulfate

PTI Post-Infusion

PTK Proteinase-K

PTY Parathyroid

PVA Polyvinyl alcohol

PWM Pokeweed Mitogen

QAG QFT-TB Ag Red Cap

QMT QFT-Mitogen Purple Cap

QNL QFT-Nil Grey Cap

QTG QFT-TB1 Ag Green Cap

QTY QFT-TB2 Ag Yellow Cap
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Code Description

RDS RNA/DNA shield

RFW RNAse free water

RGT Right

RLT Buffer RLT Plus

RNL RNAlater

RNP RNA Protect

RPM RPMI 1640 Medium

RTB Reverse Transcriptase buffer

S52 Sendai 52 virus with defective infectious particules

SAU Staph aureus

SBC Sodium Bicarbonate

SCB Sodium Carbonate

SDS Second Spin

SEB Sigma Staphylococcus Enterotoxin B

SLD Slide from a primary sample

SNP Snap/Flash Freeze

SPG Sponge

SPN Streptococcus pneumoniae

SPS SMART TUBE INC Proteomic Stabilizer

STG Skim milk-Tryptone-Glucose-Glycerin Medium (STGG)

STM Stimulated by Multiple Antigens

SUB Sub Gingival Plaque

SUG Supragingival Plaque

SUP Cultural Supernatant

TB4 Quantiferon Gold and/or Quantiferon Gold Plus CD4 tube

TB8 Quantiferon Gold Plus (only) CD8 tube

TBD Specimen type to be defined

TBS Tris-Buffered Saline

TCA 1% Thimersol/ 6.6% EACA (Epsilon Amino Caproic Acid)

TCL T-cell Lymphoblastoid Cell Line

TCM Trichrome stain

TEB Tris-EDTA Buffer

TEM Tempus Tube

TFM Tissue Freezing Medium

TMD Myeloid dendritic cell non infected and treated with TSST
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Code Description

TMS Transport Medium-Stuarts

TND Myeloid dendritic cell infected with NDVW and treated with TSST

TNN TSST with NDVNS1

TNV TSST with NDVB1

TOC Tocopherol (Vit E)

TPB Trypan Blue

TRI TriReagent

TRX Triton X

TRZ Trizol

TSC Myeloid dendritic cell infect w/ Sendai Cantell & treat w/ TSST

TSS TSST, Toxic-Shock Syndrome Toxin

TTX Tetanus Toxoid treated

UCT Urine cartridge

ULQ Upper Left Quadrant

UMB Placenta cord slice

UNK Unknown Sub A/D

UNT Untreated / Unstimulated

URE Urea

URQ Upper Right Quadrant

VCS Cervicovaginal Secretions

VIB Veal Infusion Broth

VIR Virus

VPS VP Stimulator

VPT VP Target

VTM Viral Transport Media

ZLN Ziehl Neelsen

Condition codes
This section lists the specimen condition codes available in LDMS.

Code Description

ANM Sample Anonymized

ANP Aliquot not prepared

BKV Broken or cracked vial

BLD Bloody

CDT Consumed During Testing
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Code Description

CLT Clotted

CMB Combined Aliquots

COC Combination of Conditions (Explain)

CTM Contaminated

DCF Data Clarification Form

DCG Discharge present

DFB Difficult Bleed

DIM Dry Ice Melted

DMG Damaged container

DSH Delayed Shipment

DSR Destroyed

EQF Equipment Failure

EXP Expired

FRO Frozen

HEM Hemolyzed

HUM Exposed to high humidity

ICT Icteric (Excess Bilirubin)

INT Incorrect Tube

INV Invalid Specimen

LBE Lab Error

LIP Lipemic

LKD Leaked

LLT Local Lab Testing

LSH Lost Shipment

LYS Lysed

NOT No Test Performed

NQA RT QA for viability and recovery NOT done due to low volume

NST Did Not Consent to Storage

OPR Sample drawn outside protocol requirements

OSW Specimen drawn outside of protocol-defined visit window

OTH Other (Explain)

PST Processed after Specified Time

QNS Quantity Not Sufficient

REF Refrigerated

RLB Re-labeled
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SAT Satisfactory

SHV Short volume

SNC Sample not collected

SNP Specimen not processed

SNR Sample Not Received,CRF Received

TNO Shipping/storage temperature not optimal/warmed

TRM Testing Remnant

TWD Thawed

UNK Unknown condition

VPL Viability percent may be less than the expected parameter

VRU Viable recovery may be outside expected parameters (higher or lower)

YST Did Consent to Storage

Unit codes
Unit codes, such as visits, measurements, and time units.

Measurement codes
This section lists the measurement codes available for specimen units
available in LDMS.

Code Description

CEL CEL Cells

CM CM Centimeters

CRD Cards

CTN CTN Container

EA EA Each

GR GR Grams

MG MG Milligrams

ML ML Milliliters

MM MM Millimeter

N/A N/A Not Applicable

PG PG Picograms

pg/10^6
cells

picogram per 10^6 cells

UG UG Micrograms

UL UL Microliters

UNK UNK Unknown Units
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Time unit codes
This section lists the time unit codes available in LDMS.

Code Description

Day Day

Fst Fasting

Hrs Hours

Min Minutes

Mo Months

MRN Morning

Nft Non-Fasting

Pol Pooled

Prd Predialyzer

PRI Pre-Infusion

Pre Pre-Dose

Psd Postdialyzer

Pst Post-Fasting

PTC Post-Challenge

PTI Post-Infusion

PTV Post-Vaccination

Ran Random

RPD Random Post-Dose

Sec Seconds

SRL Serial

Tr Trough

UNK Unknown time unit

Visit codes
This section lists the visit unit codes available in LDMS.

Code Description

-2 -2

A A

Aut Autopsy

B B

B/L Baseline

Bth Birth

Cb Cord Blood

CFM Post Study Confirmation Test
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Code Description

CFU Core Follow Up

Ch Challenge

CRW Crosswalk

DAV Dose Adjustment Visit

Day Days

DEL Delivery

DVL DBS Viral Load

EDV Event Driven Visit

EID Early Infant Diagnosis

EIT End of Intensive Treatment

Ent Entry/Baseline

EOR End of Study & redraw

Eos End-Of-Study

EOT End of Treatment

EOX Evaluation of Seroreactivity and Recent Exposure

EPH Extension Phase

EWD Early Withdrawal

Exp Recent Exposure

Ext Exit/Discontinuation

FCF Failure Confirmation

FUP Follow-up Test

Gel On study without gel

Inf Infected Participant Testing

IOT Initiation of Treatment

LSF Long-term Safety and Followup

L&D Labor & Delivery

Mo Months

NDL New Delivery

NON Not Pregnant

NPG New Pregnancy

OFP Off PrEP

OMB Oral MB

ONP On PrEP

PDT Product Discontinuation

PE Pre-entry
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Code Description

PFT PFT

PK PK

POR Post study & redraw

Pos Post-Study

POX Post study & possible recent exposure

PPt Post Partum

Prf Proficiency

PRG Pregnancy

Pri Pre-Infusion

Pst Post-Infusion

PTD Premature Treatment Discontinuation

PVL Plasma Viral Load

Qul Qualification

Rdw Redraw

RRV Retrospective

RWK R+ Week

SC Seroconversion

SCK Sick

Scr Screening

SD Study Day

SHR Short

SP Sero Positive

Sps Special Studies

SRV Post Study Service Test

TRI Trimester

UnK Unknown

Uns Unscheduled

V V

Vst Visit

Wk Weeks

Yr Years

Assay Codes
Codes used for assays, such as system and user censors.
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Reasons for not running an assay censor codes
This section lists the censor codes that can be used on an assigned test when
the test will not be performed.

Code Description Numeric Value

COR COR Controls Out of Range 10431

CTM Contaminated 10430

EQF Equipment Failure 10432

LBA Laboratory Accident 10434

LBE Lab Error 10433

MSW Missing Well 10435

NPA Sample Drawn Without Participant Adherence to
Regimen

10440

OUT Resulted outside LDMS 10439

PSW Sample not Drawn Within Protocol Specified Window 10441

QNS Quantity Not Sufficient 10436

STO Specimen too old to run on test 10442

WCT Wrong Controls 10437

Immunology assay codes
Codes for immunology assays.

Reasons why results were not obtained for immunology assays
This section lists the censor codes that can be applied to immunology assays
tests when a result was not obtained.

Code Description Numeric Value

A Wrong Anticoagulant 65804

C Contamination 65800

E Tech Error/Lab Error 65801

K Kit/Reagent Problem 65806

P Results Reported Under A Different Protocol 65807

S Quantity Not Sufficient 65802

U Unsatisfactory Sample 65803

V Poor Viability 65805

Virology assay codes
Codes for virology assays.

Virology user censor codes
This section lists the virology assay user censor codes available in LDMS.
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Code Description Validity Numeric Value

B1 BOOM extraction used Valid 100

C Control re-run and valid - assay is valid Valid 1,000

D Contamination Invalid 10,000

E Poor viability Invalid 1,000,000

K Kit/Reagent Problem Invalid 1

O Lab error/Lab accident Invalid 100,000,000

P Equipment failure Invalid 0.1

Q Kit QC out of range - repeat Invalid 10

R Re-detected Valid 1,000,000,000,000

V Over amplified Invalid 10,000,000

W Inhibitory/Material didn’t amplify Invalid 100,000

Z Per lab - Do not use Invalid 0.001

Roche COBAS Ampliprep/COBAS TaqMan HIV-1 assay censor codes
This section lists the Roche COBAS Ampliprep/COBAS TaqMan HIV-1 assay
censor codes available in LDMS.

Code Description Validity Numeric Value

F Invalid control Invalid 1000000.000000

G Result less than lower limit of
quantification

Valid 0.000100

H No Result Invalid 10000000.000000

I No QS wells in range Invalid 100000.000000

J Undetectable Valid 1.000000

X4 Results greater than upper limit of
quantification

Valid, but needs
repeat

10000.000000

COBAS TaqMan HCV assay censor codes
This section lists the COBAS TaqMan HCV assay system censor codes available
in LDMS

Code Description Validity Numeric Value

F Invalid Control Invalid 1000000

G Result less than lower limit of
quantification

Valid 0.0001

H No Result Invalid 10000000

I QS Invalid Invalid 100000

J Undetectable Valid 1

X4 Results greater than upper limit of
quantification

Valid 10000
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COBAS TaqMan HIV-1 Qual assay censor codes
This section lists the COBAS TaqMan HIV-1 Qual assay system censor codes
available in LDMS.

Code Description Validity Numeric Value

A 0 control not negative Invalid 1

B 10 control not positive Invalid 10

C 20 control not positive Invalid 100

E VQA blinded control fails validation Invalid 10000

F Assay locked Na 100000

H No result Invalid 10000000000

K Invalid control Invalid 1000000

L Low positive control out of range or invalid Invalid 1E+14

N Negative control out of range or invalid Invalid 10000000

O Run based validity override Valid 1E+12

P Insufficient VQA blinded controls assigned
to rack

Invalid 1000000000

Q Insufficient VQA controls assigned to rack Invalid 1E+13

R Re-read Valid 100000000

S 5 control invalid Invalid 1E+11

Abbott Realtime HIV-1 and Abbott SARS-COV-2 Quant assay censor
codes
This section lists the Abbott Realtime HIV-1 and Abbott SARS-COV-2 assay
censor codes available in LDMS.

Code Description Validity Numeric Value

F Invalid Control Invalid 1000000.000000

G Detected - Result less than lower limit of
quantification

Valid 0.000100

H No Result Invalid 10000000.000000

J Undetectable Valid 1.000000

X4 Results greater than upper limit of
quantification

Valid, but needs
repeat

10000.000000

Pharmacology assay codes
Codes for pharmacology assays.

Pharmacology analyte codes
This section lists the codes for pharmacology (PK) drug analyte codes
available in LDMS.

Code Description

3TC Lamivudine
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Code Description

3TCDP 3TC diphosphate

3TCDP-PC 3TC diphosphate choline

3TCDP-PE 3TC diphosphate ethanolamine

3TCMP 3TC monophosphate

3TCTP 3TC triphosphate

4B-OHC 4β-hydroxycholesterol

6BHC 6 Beta Hydroxycortsol

7-COOH-CBD 7-Carbxoy Cannabidiol

7-OH-CBD 7-Hydroxy-Cannabidiol

10-1074LS 10-1074LS

AAG Alpha-1 Acid Glycoprotein

ABC Abacavir

ABC-CARB Abacavir carboxylate

ABC-GLU Abacavir glucronide

ABC-MP Abacavir Monophosphate

ACL Acetyl-Isoniazid

ADF Adefovir

AL Artemether-lumefantrine

ALB Albumin

AML Amlodipine

AMP/DXAMP Amphetamine/Dextroamphetamine

APV Amprenavir

ARM Artemether

ASV Asunaprevir

Atorvast Atorvastatin

Atorvast-2OH 2-hydroxy Atorvastatin

Atorvast-4OH 4-hydroxy Atorvastatin

Atorvast-LAC2OH 2-hydroxy Atorvastatin Lactone

Atorvast-LAC4OH 4-hydroxy Atorvastatin Lactone

ATV Atazanavir

AZM Azithromycin

BCV Becllabuvir

BDCQ Bisdesethylchloroquine

BDQ Bedaquiline

BDQ-M2 N-monodesmethyl metabolite of Bedaquiline
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Code Description

BICUF Bictegravir Unbound

BLM Bleomycin Sulfate

BMS-936559 BMS-936559

Boc3004 SCH783004

Boc3005 SCH783005

Boc3006 SCH783006

Boc3007 SCH783007

Boc4128 SCH534128

Boc4129 SCH534129

Bocepvr Boceprevir

BZD Benznidazole

CAB Cabotegravir

CBD Cannabidiol

CBV-MP Carbovir Monophosphate

CBVTP carbovir triphosphate

CEM-ADA Cemiplimab ADA

CIT Citalopram

CLF Clofazimine

CLQ Chloroquine

CMS Colistin Methane Sulfonate

CMS - ColA ColA metabolite of Colistin Methane Sulfonate

CMS - ColB ColB metabolite of Colistin Methane Sulfonate

COBI Cobicistat

COP1 Coproporphyrin 1

CORT Cortisol

CPM Capreomycin

CPM1A Capreomycin Compound 1A

CPM1B Capreomycin Compound 1B

CS Cycloserine

CTH Cethromycin

CVC Cenicriviroc

D4T Stavudine

d4TTP d4T triphosphate

DCB Daclatasvir

DCV Daclatasvir
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Code Description

ddATP dideoxyadenosine triphosphate

DDC Zalcitabine

ddI Didanosine

DES Desogestrel

des RBT des rifabutin

des RFP des rifapentine

des RMP des rifampicin

DEX Dexamethasone

DHA Dihydroartemisinin

DHCQ Desethylhydroxychloroquine

DHPG Ganciclovir

DLM Delamanid

DLM-DM6705 DM6705

DLT Diltiazem

DLT- AL Desacetyldiltiazem metabolite of DLT

DLT- MT Desmethyldiltiazem metabolite of DLT

DLV Delavirdine

DMPA Medroxyprogesterone Acetate

DOR Doravirine

DOX Doxorubicin (liposomal-encapsulated and free)

DOXOL Doxorubicinol

DPV Dapivirine

DRV Darunavir

DSI Desipramine

DSV Dasabuvir (previously ABT-333)

DSV-m1 Dasabuvir m1

DTG Dolutegravir

DXAMPS Dextroamphetamine sulfate

DXM Dextromethorphan

DXM-3HM 3-Hydroxy Morphinan

DXM - DXO Dextrorphan metabolite of Dextromethorphan

DXMPH Dexmethylphenidate

E7OH 7-Hydroxy Efavirenz

E8OH 8-hydroxy efavirenz

EBR> Elbasvir
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Code Description

EE Ethinyl Estradiol

EFV Efavirenz

EMB Ethambutol HCL

ENF Enfuvirtide

ENG Etonogestrel

ESCIT Escitalopram

ET Etoposide

ETR Etravirine

EVG Elvitegravir

FCZ Fluconazole

FLX Fluoxetine

FOS Foscarnet

FTC Emtricitabine

FTC-TP Emtricitabine Tri-phosphate

GES Gestodene

GS-441524 Remdesivir Metabolite

HCQ Hydroxychloroquine

HDP-THV Hexadecyloxypropyl Tenofovir

HU Hydroxyurea

HYC Hydrocodone

Ibalzb Ibalizumab

IDV Indinavir

INH Isoniazid

IQP-0528 IQP-0528

ISO Isotretinoin

ISO-4OXO 4-OXO-Isotretinoin Metabolite

ISO-ATRA All-Trans Retinoic Acid

ITX 5061 ITX 5061

KAN Kanamycin

KYN Kynurenine

LDV Lepipasvir

LEN Lenacapavir

LF Lumefantrine

LF-DBL Desbutyl Lumefantrine

LPV Lopinavir
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LPVF Free or unbound lopinavir concentrations

LVF Levofloxacin

LY-CoV555 LY3819253

LZD Linezolid

M3 N-didesmethyl metabolite of bedaquiline (TMC207)

M8 NFV Metabolite

METF Metformin

Minocyclene/Placebo Minocyclene/Placebo

MK-3475 MK-3475

MOR Morphine

MPA Mycophenolic Acid

MPAF Free Mycophenolic Acid

MPAG Mycophenolic Acid Metabolite

MPH Methylphenidate

MTD Methadone HCl

MTX Methotrexate

MVC Maraviroc

MXF Moxifloxacin

N-803 N-803 IL-15 Superagonist

N-DLV Delavirdine’s Metabolite

NET Norethisteron

NFV Nelfinavir

NFX Nifurtimox

NGM Norgestimate

NHC β-D-N4-hydroxycytidine

NIM Nimodipine

NVP Nevirapine

OBV Ombitasvir (previously ABT-267)

OFX Ofloxacin

OXT Oxytocin

OXY Oxycodone

P4 Progesterone

PA Pretomanid

PAS aminosalicylic acid

PEG-IFN Pegylated-Interferon alfa 2b
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Code Description

PF-332 PF-07321332

PGT121-414-LS PGT121-414-LS

PLD Pegylated Liposomal Doxorubicin

PMPA (9 - [2 - (R) - (phosphonomethoxy)propyl] adenine)

PNU -101603 PNU -101603 metabolite of Sutezolid

PPX Pramipexole

PTV Paritaprevir (previously ABT-450)

PTX Paclitaxel

PXT Paroxetine

PZA Pyrazinamide

PZQ Praziquantel

PZQ-4OH 4-Hydroxy metabolite of Praziquante

R-AMPH Dextro-amphetamine

RBT rifabutin

RDV-GS704277 Remdesivir alanine metabolite

RDV-GS441524 Remdesivir

RFP rifapentine

RGV Raltegravir

RIS Risperidone

RMD Romidepsin

RMP Rifampicin

RPV Rilpivirine

RTV Ritonavir

RUX Ruxolitinib

RV Ribavirin

RV-TP Ribavirin Triphosphate

S-AMPH Levo-amphetamine

SERT Sertraline

SERT – DMS Desmethylsertraline

SLGN Selgantolimod

SOF Sofosbuvir

SOF-GS-331007 GS-331007 metabolite of SOF

SOF-GS-566500 GS-566500 metabolite of SOF

SQ109 SQ109

SQV Saquinavir
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Code Description

STZ Sutezolid

TAF Tenofovir Alafenamide Fumarate

TEC Tecovirimat

TFV Tenofovir

TFVDP Tenofovir Diphosphate

THA Thalidomide

THC Delta9-tetrahydrocannabinol

TPV Tipranavir

TRP Tryptophan

VCR Vincristine Sulfate

VCV Vicriviroc

VEL Velpatasvir

VRC01 VRC-HIVMAB060-00-AB

VRC01LS VRC-HIVMAB080-00-AB

ZDV Zidovudine

ZDVDP Zidovudine diphosphate

ZDVMP Zidovudine monophosphate

ZDVTP Zidovudine triphosphate

Pharmacology system censor codes
This section lists the pharmacology (PK) system censor codes available in
LDMS.

Code Description Validity Numeric Value

A Invalid. Greater than the upper limit,
dilute and repeat

Invalid 16

B Below quantifiable limit Valid 8

F Failed Invalid 32

H Unacceptable HQC Invalid 64

I Unacceptable HOQ Invalid 512

L3 Lower limit adjusted up for this run Valid 1

M Unacceptable MQC Invalid 128

Q Unacceptable LQC/ LQC1/LQC2 Invalid 256

R4 Repeat (with L system censor only) Invalid 4

U Sample Diluted Valid 1,000,000,000,000

3 No longer available, Windows LDMS specific
4 No longer available, Windows LDMS specific
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Pharmacology assay user censor codes
This section lists the pharmacology assay user censor codes available in
LDMS.

Code Description Validity Numeric Value

A5 Greater than the upper limit, dilute and
repeat

Invalid

B Below Quantifiable Limit or No Peak Valid 2048

D Drug not required to be assayed Valid6 512

F7 Failed Invalid

N Not Detected Valid 8

O QC out of range, dilute and repeat Invalid 4

P Not Able to Interpret Result Invalid 8192

S8 Quantity not sufficient Invalid

X Per lab, sample must be repeated Invalid 1024

Z No Result, Lab Issue Invalid 4096

Pharmacology concentration units
These unit codes are used for PK specimen concentration values.

Code Description

% percentage

FMOL/10^6 CELLS femtomol per 10^6 cells

FMOL/ML femtomol per milliliter

FMOLE femtomol

FMOLE/MG FMOLE/MG

FMOLE/SAMPLE FMOLE/SAMPLE

NG/MG NG/MG

NG/ML nanogram per milliliter

NG/SAMPLE nanogram per sample

NMOL nanomol

pg/injection picograms per injection

pg/mL picogram per milliliter

PMOL/10^6 CELLS picomol per 10^6 cells

PMOLE picomol

UG/ML microgram per milliliter

5 No longer available, Windows LDMS specific
6 Results removed from final views
7 No longer available, Windows LDMS specific
8 No longer available, Windows LDMS specific
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Code Description

UMOL micromol
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